Legal Notices

Autodesk® River and Flood Analysis Module 2014

© 2013 Autodesk, Inc. All Rights Reserved. Except as otherwise permitted by Autodesk, Inc., this publication, or parts thereof, may not be reproduced in any form, by any method, for any purpose.

Certain materials included in this publication are reprinted with the permission of the copyright holder.

Trademarks
The following are registered trademarks or trademarks of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and other countries: 123D, 3ds Max, Algor, Alias, AliasStudio, ATC, AutoCAD, AutoCAD Learning Assistance, AutoCAD LT, AutoCAD Simulator, AutoCAD SQL Extension, AutoCAD SQL Interface, Autodesk, Autodesk 123D, Autodesk Homestyler, Autodesk Intent, Autodesk Inventor, Autodesk MapGuide, Autodesk Streamline, AutoLISP, AutoSketch, AutoSnap, AutoTrack, Backburner, Backdraft, Beast, Beast (design/logo), BIM 360, Built with ObjectARX (design/logo), Burn, Buzzsaw, CADmep, CAiCE, CAMduct, CFdesign, Civil 3D, Cleaner, Cleaner Central, ClearScale, Colour Warper, Combustion, Communication Specification, Constructware, Content Explorer, Creative Bridge, Dancing Baby (image), DesignCenter, Design Doctor, Designer's Toolkit, DesignKids, DesignProf, Design Server, DesignStudio, Design Web Format, Discreet, DWF, DWG, DWG (design/logo), DWG Extreme, DWG TrueConvert, DWG TrueView, DWGX, DXF, Ecotect, ESTmep, Evolver, Exposure, Extending the Design Team, FABmep, Face Robot, FBX, Fempro, Fire, Flame, Flare, Flint, FMDesktop, ForceEffect, Freewheel, GDX Driver, Glue, Green Building Studio, Heads-up Design, Heidi, Homestyler, HumanIK, i-drop, ImageModeler, iMOUT, Incenerate, Inferno, Instructables, Instructables (stylized robot design/logo), Inventor, Inventor LT, Kynapse, Kynogon, LandXplorer, Lustre, Map It, Build It, Use It, MatchMover, Maya, Mechanical Desktop, MIMI, Moldflow, Moldflow Plastics Advisers, Moldflow Plastics Insight, Moondust, MotionBuilder, Movimento, MPA, MPA (design/logo), MPI (design/logo), MPX, MPX (design/logo), Mudbox, Multi-Master Editing, Navisworks, ObjectARX, ObjectDBX, Opticore, Pipeplus, Pixlr, Pixlr-o-matic, PolarSnap, Powered with Autodesk Technology, Productstream, ProMaterials, RasterDWG, RealDWG, Real-time Roto, Recognize, Render Queue, Retimer, Reveal, Revit, Revit LT, RiverCAD, Robot, Scaleform, Scaleform GFx, Showcase, Show Me, ShowMotion, SketchBook, Smoke, Softimage, Socialcam, Sparks, SteeringWheels, Stitcher, Stone, StormNET, TinkerBox, ToolClip, Topobase, Toxik, TrustedDWG, T-Splines, U-Vis, ViewCube, Visual, Visual LISP, Vtour, WaterNetworks, Wire, Wiretap, WiretapCentral, XSI.

All other brand names, product names or trademarks belong to their respective holders.

Disclaimer
THIS PUBLICATION AND THE INFORMATION CONTAINED HEREIN IS MADE AVAILABLE BY AUTODESK, INC. "AS IS." AUTODESK, INC. DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE REGARDING THESE MATERIALS.
Contents

Chapter 1 Overview ......................................................... 1-1
Capabilities ........................................................................ 1-1
   Easy Model Development ............................................. 1-1
   Automated Terrain Data Processing ............................... 1-2
   Automated Floodplain Mapping ..................................... 1-2
   Automated Floodplain Encroachment Modeling ............... 1-2
   FHWA DOT Bridge Scour Analysis and Reporting .......... 1-3
   HEC-RAS Compatibility .............................................. 1-3
   AutoCAD Integration .................................................. 1-3
   River Scenario Analyzer ............................................. 1-3
   Model Checker .......................................................... 1-4

Chapter 2 Using the Program ............................................ 2-1
Program Overview .......................................................... 2-1
   Background Information ............................................. 2-1
   Accessing Commands ................................................ 2-2
   Model Information ..................................................... 2-2
   Application Basics ..................................................... 2-2
   Moving, Modifying, and Deleting Entities ...................... 2-2
   Drawing Layers ......................................................... 2-2
   Application Tools ....................................................... 2-3
   Selecting and Viewing Cross Sections ......................... 2-3
   Viewing the Extents of a River Reach ......................... 2-3
   Viewing a Profile View .............................................. 2-3
   Hydraulic Calculator ................................................. 2-4
   River Networks ......................................................... 2-6
   River Junctions ........................................................ 2-8
   Adding a New River Reach ......................................... 2-11
   Reassigning Cross Sections ........................................ 2-12
   Deleting a River Reach .............................................. 2-13
   Editing a River Reach ............................................... 2-13
   Moving the River Reach ID Marker ................................. 2-13
   Selecting a River Reach ............................................. 2-13
   Zooming to a River Reach ........................................... 2-13
Cross Section Views .................................................. 2-14
Creating a Cross Section View ................................. 2-14
Copying a Cross Section View ............................... 2-16
Deleting a Cross Section View ............................... 2-16
Editing a Cross Section View .................................. 2-16
Renumbering Cross Sections ................................. 2-17
Selecting and Viewing Cross Sections .........................
  Selecting a Cross Section ....................................... 2-17
  Zooming to a Cross Section .................................. 2-18
  Viewing a Cross Section on a Surface ....................... 2-18
  Viewing Cross Section Analysis Results ...................... 2-18
  Viewing Previous and Next Cross Section Views .......... 2-18
Resizing a Cross Section View .................................. 2-18
Defining Cross Section Geometry .................. 2-19
Cutting Sections from a 3D Surface .................... 2-19
Cutting Sections from a 2D Surface .................... 2-20
Cutting a Section from a Polyline ................... 2-21
Creating Sections from Imported Data .................. 2-22
Editing Cross Section Geometry .......................... 2-24
Adjusting Cross Section Geometry ........................ 2-26
Reducing Cross Section Points ............................ 2-27
Tracing a Cross Section Cut Line on a Surface ............... 2-29
Moving a Cross Section Cut Line ....................... 2-29
Rotating a Cross Section Cut Line ....................... 2-30
Recutting a Cross Section ...................................... 2-30
Graphical Adjustment of Ground Geometry ............... 2-31
Automated Data Extraction Methods .................. 2-32
Cutting Cross Sections Automatically ................ 2-32
Assigning Bank Stations and Reach Lengths ............. 2-35
Assigning Manning’s Roughness .......................... 2-37
Assigning Ineffective Flow Areas ......................... 2-38
Assigning Levees .................................................. 2-39
Assigning Conveyance Obstructions ....................... 2-40
Entering Data ...................................................... 2-41
Entering Data Interactively .................................. 2-41
Graphical Editing using Grips ......................... 2-41
Importing Existing HEC-RAS Files .................. 2-41
Importing an Existing HEC-2 Data File .................. 2-42
Importing Survey Cross Section Data ................. 2-43
Data Entry Checking ............................................ 2-46
Model Analysis ..................................................... 2-46
Defining Analysis Options ................................ 2-46
Performing a HEC-RAS Analysis .......................... 2-47
Model Checking .................................................. 2-47
Exporting a HEC-RAS Project ............................. 2-47
Cross Section Data .................................................. 3-6
Cross Section Description ......................................... 3-6
Ineffective Flow Area Description .............................. 3-11
Conveyance Obstruction Description ........................... 3-13
Levee Description .................................................. 3-14
Profile Adjustments Description ............................... 3-16
Rating Curve Description ......................................... 3-17
Horizontal Roughness Description ............................. 3-18
Defining Bridge and Culvert Openings ......................... 3-19
Defining the Bridge Low Chord Geometry ....................... 3-21
Direct Editing Input Method ..................................... 3-21
Screen Cross Section Input Method .............................. 3-22
Graphical Adjustment of Low Chord Geometry .................. 3-22
Defining Culverts .................................................. 3-23
Other Bridge Data .................................................. 3-37
Bridge Computation Methodology ................................ 3-37
WSPRO Bridge Parameters ....................................... 3-38
Global Bridge Parameters ....................................... 3-40
Bridge Pier Description ......................................... 3-41
Bridge Abutment Description ................................... 3-42
Defining the Roadway Geometry .................................. 3-43
Inputting Roadway Geometry Directly .......................... 3-43
Inputting Roadway Geometry Graphically ...................... 3-44
Graphical Adjustment of Roadway Geometry ................. 3-44
Roadway Overflow Parameters .................................. 3-44
Calculating Bridge Scour ......................................... 3-46
Scour Modeling Guidelines ...................................... 3-46
Defining Scour Data .............................................. 3-47
Defining Contraction Scour Data ................................ 3-48
Defining Pier Scour Data ......................................... 3-49
Defining Abutment Scour Data ................................... 3-52
Inline Weirs and Gated Spillways ............................... 3-54
Defining the Spillway Structure ................................ 3-55
Defining an Inline Weir Structure .............................. 3-55
Drawing the Inline Weir Geometry .............................. 3-57
Defining a Gated Spillway ....................................... 3-57
Defining a Gated Spillway Gate Opening ....................... 3-59
Floodplain Encroachments ...................................... 3-60
Encroachment Method 1 ......................................... 3-62
Encroachment Method 2 ......................................... 3-63
Encroachment Method 3 ......................................... 3-64
Encroachment Method 4 ......................................... 3-64
Encroachment Method 5 ......................................... 3-65
Autodesk® River and Flood Analysis Module is an advanced river modeling software that supports HEC-RAS within Autodesk® AutoCAD® Civil 3D®. The software makes it easy to compute water surface profiles for modeling bridges, culverts, spillways, levees, bridge scour, floodway delineation, flood plain reclamation, stream diversions, stream restorations, stream realignments, and split flows.

Autodesk River and Flood Analysis Module performs the following:

- Automates HEC-RAS cross section cutting, analysis, flood plain mapping, and all related modeling tasks
- Seamlessly runs HEC-RAS in Autodesk AutoCAD Civil 3D
- Numerous automation mapping tools for extracting cross sections from various digital terrain data, contours, TINs, DTMs, DEMs, LiDAR, survey files, surveyed cross sections, etc.
- Automatic mapping of bank station locations, flow lengths, levee locations, ineffective flow areas, Manning’s roughness data from topographic map data
- Automatic generation of flood plain and floodway maps, ready for FEMA submittal
- Sophisticated bridge and culvert analysis, automating the process of designing and analyzing roadway crossings
- Automated bridge scour computations for FHWA and state DOT roadway studies
- Imports and exports standard HEC-RAS model files, ready for agency submittal
- Imports standard HEC-2 model files.

1.1 Capabilities

Autodesk River and Flood Analysis Module completely automates HEC-RAS within Autodesk AutoCAD Civil 3D. Both US and metric (SI) units are supported.

1.1.1 Easy Model Development

Autodesk River and Flood Analysis Module is easy to learn and use. Even without any previous Autodesk® AutoCAD® experience, you can become productive quickly. Customized dialog boxes and command prompts make data input simple and intuitive. Pop-up menus bring commands immediately to your fingertips and context-sensitive help is always available—even midway through a command.

You can use Autodesk River and Flood Analysis Module with your existing AutoCAD drawings. After a surface has been created in Autodesk AutoCAD Civil 3D, river modeling data such as bank station locations, flow distances, ineffective flow areas, levee stations, Manning’s roughness sub-areas can be quickly extracted from the
drawing. The HEC-RAS model runs directly within the AutoCAD environment, and the computed analysis results are displayed directly in the AutoCAD drawing. Floodplain and floodway mapping, base flood water surface elevation (BFE) contours, flow depth contours, cross section plots, and profile plots can be displayed in the AutoCAD drawing, quickly plotting the model results for you. The completed HEC-RAS model can then be exported for agency submittal.

1.1.2 **Automated Terrain Data Processing**

Autodesk River and Flood Analysis Module takes complete advantage of digital terrain mapping automation to instantly extract cross sections, land use data, Manning’s roughness, channel and overbank flow lengths, bank stations, ineffective flow areas, levee locations, and other terrain data into HEC-RAS. Using the software’s terrain processing capability, a river model can be developed from any type of digital data, including 3D digital contour maps, TINs, DTMs, DEMs (digital elevation models), LiDAR, 2D digital contour maps, hard copy contour maps, hard copy cross-section plots, on-screen digitizing, manual data entry, and importation of complete or partial HEC-RAS or HEC-2 input files, station-elevation, Northing-Eastings, or XYZ coordinate data. This allows you to construct, analyze, and display the analysis results for a HEC-RAS model for several miles of river in just minutes. Several orders of magnitude increase in productivity is achievable using Autodesk River and Flood Analysis Module.

1.1.3 **Automated Floodplain Mapping**

Once the HEC-RAS analysis has been performed, Autodesk River and Flood Analysis Module can generate a detailed floodplain map of the computational results—showing the extent of the flooding on the AutoCAD drawing. Very precise edge of water mapping is created—greatly speeding up the process of creating final map submittals for agency review. The software automatically generates approximate (FEMA Zone A) and detailed (FEMA Zone AE, AH) flood maps. Water surface elevation contours, commonly called BFE’s (base flood elevation) contours, are automatically constructed and labeled. Flood depth contours can be generated in order to create flood hazard mapping. You have total control over line style, line color, line weight, hatching, and other drawing configuration parameters in order to meet any specific corporate CAD drafting standards.

1.1.4 **Automated Floodplain Encroachment Modeling**

Autodesk River and Flood Analysis Module reduces the time for computing floodplain encroachment stations—typically an extensive time-consuming process—to just minutes. You can quickly iterate encroachment station locations—while simultaneously reviewing the incremental water surface rise, floodway top width, and flow velocities at each river cross section and on the topographical map—to provide the best land development solution. The software allows you to maximize recovery of land for development—gaining significant acreage for your clients in just minutes of work. Once the final floodway locations have been determined, the required HEC-RAS model files can be instantly exported for FEMA submittal along with the completed AutoCAD drawing.
1.1.5 FHWA DOT Bridge Scour Analysis and Reporting

Our software development team worked with several major engineering companies involved in FHWA and DOT bridge replacement contracts to completely automate the analysis, design, and reporting necessary for bridge replacement and scour projects. Autodesk River and Flood Analysis Module can analyze a bridge for scour and create a "ready-to-submit" FHWA-accepted bridge scour engineering report in just minutes. The scour report includes all input data, equations, variables, intermediate results, final analysis results, and analysis narrative—along with placing the computed scour results directly on the bridge within the AutoCAD drawing.

The scour analysis can account for the following factors:

- Bridge skew
- Pier skew
- Pier shape
- Sloping and skewed abutments
- Soil bed material
- Armoring of bridge abutments
- Armoring of bridge piers
- Contraction, pier, and abutment scour effects
- US, metric, or mixed unit-based input data

1.1.6 HEC-RAS Compatibility

Autodesk River and Flood Analysis Module fully supports the latest version of HEC-RAS, which enables you to import and export HEC-RAS model information without any loss of data. And, with a single mouse click your completed model can be exported ready for agency submittal.

1.1.7 AutoCAD Integration

Autodesk River and Flood Analysis Module operates directly within Autodesk AutoCAD Civil 3D. This provides you with a high level of precision by leveraging Autodesk AutoCAD Civil 3D automation capabilities in constructing, analyzing, and displaying HEC-RAS models.

1.1.8 River Scenario Analyzer

The River Scenario Analyzer allows you to quickly compare HEC-RAS analysis results—examining the output at any level of detail required. Multiple graphical plots and output tables can be stacked on top of each other, showing whatever variables you select.

Customization of graphical plots and output tables is supported, allowing you unlimited flexibility. Once a customized output layout has been defined, it can be saved as a template for later use. With the River Scenario Analyzer you can generate report quality charts and plots that are customized specific to your needs.
1.1.9 Model Checker

Autodesk River and Flood Analysis Module includes a built-in Model Checker. The Model Checker analyzes the input data for any modeling errors. If it encounters an error, it explains what is wrong and suggests possible corrections.
Using the Program

Autodesk® River and Flood Analysis Module is an advanced river modeling software that completely supports HEC-RAS within Autodesk® AutoCAD® Civil 3D®. The software makes it easy to compute water surface profiles for modeling bridges, culverts, spillways, levees, bridge scour, floodway delineation, flood plain reclamation, stream diversions, stream restorations, stream realignments, and split flows. The software reads and writes data from the latest versions of HEC-RAS.

This section gives an overview of this application, providing you with a fundamental understanding of the operation of the software.

2.1 Program Overview

This section provides an overview of the major elements of the Autodesk River and Flood Analysis Module user interface.

2.1.1 Background Information

Autodesk River and Flood Analysis Module operates directly within Autodesk AutoCAD Civil 3D. All modeling data is stored directly in the drawing file as custom entity data; there are no external files to maintain.

A river model is developed by:

- Defining cross section locations and the corresponding ground geometry using any combination of 3D digital contour maps, 2D digital contour maps, 3D digital terrain models, 3D TINs, XYZ coordinate data, USGS DEM (Digital Elevation Map) data, hard-copy contour maps, hard-copy cross section plots, on-screen digitizing, manual data entry, importation of complete or partial HEC-2 input card files, and importation of complete or partial HEC-RAS data sets.
- Defining the starting water surface profile conditions (i.e., discharge, starting elevation, etc.), and other necessary parameters.
- Defining any floodplain encroachments, bridge and culvert structures, split flow conditions, and other items that the model is to include in its analysis.

After the model has been properly defined, the water surface profile analysis can be performed. After the analysis is complete, the software can overlay the water surface profile on top of the contour map, showing the extent of the water surface with regard to the ground topography. It can display the computed water surface, critical water surface, and energy grade line elevations on the cross section grids. In addition, profile grids can be created. Since these various grids are contained within the Autodesk® AutoCAD® drawing file, they can be quickly annotated with descriptive notes and drawing details.
The software uses AutoCAD drawing layers extensively, storing various entities on their own layers. Organizing the drawing by using layers allows various elements and components of a drawing (for example, cross section reach lengths) to be turned On and Off, letting you view and plot them separately or in combination.

2.1.2 Accessing Commands

To access the Autodesk River and Flood Analysis Module tools in Autodesk AutoCAD Civil 3D, select the Civil 3D workspace. When the Civil 3D workspace is active, select the River tab.

2.1.3 Model Information

Information about the current analysis model is available in the Information dialog box. To display this dialog box, click River tab > Create Reach Data panel > Create Reach Data drop-down > Reach Information.

The Information dialog box displays information detailing the HEC-RAS model assigned to the current river reach. It reports the number of cross sections defined, the starting and ending cross sections, and other information related to the model.

2.2 Application Basics

The following sections discuss the application basics of Autodesk River and Flood Analysis Module.

2.2.1 Moving, Modifying, and Deleting Entities

Autodesk River and Flood Analysis Module uses custom entities, object dictionaries, and reactors to store and manage HEC-RAS and HEC-2 data within the drawing. Therefore, entities can be modified as other AutoCAD entities.

The River tab provides tools for moving, rescaling, copying, and deleting entity data.

NOTE: Related Autodesk River and Flood Analysis Module entities are dynamically updated only when they are edited within the Autodesk River and Flood Analysis Module commands. When AutoCAD commands (such as MOVE) are used, Autodesk River and Flood Analysis Module entities are not dynamically updated.

2.2.2 Drawing Layers

Autodesk River and Flood Analysis Module uses AutoCAD drawing layers extensively, storing various entities on their own layers. Autodesk River and Flood Analysis Module drawing layers are labeled starting with C_RIVR. By default, entities created by Autodesk River and Flood Analysis Module are drawn on these layers.

Do not modify the layer names. If the layer names are changed from the default, the entity data and drawing file might become corrupted.
2.3 Application Tools

Autodesk River and Flood Analysis Module includes many useful computation, display, drawing, and editing tools.

2.3.1 Selecting and Viewing Cross Sections

All cross section data editing occurs on a single cross section basis. Therefore, it is necessary to first select a cross section before editing its corresponding data.

Selecting a Section
To make a cross section current, enter RMS_XSSelect on the command line. From the Select Cross Section Grid dialog box, select the cross section to make current.

This command is similar to the Zoom to Section View command—except that the display is not altered. If you are currently looking at a different cross section or a topographical map view, then this display will be maintained.

Zooming to Section View
To zoom to a section view, click River tab > Navigate panel > Zoom to Section View. In the Zoom to Section View dialog box, select a cross section to make current and display on the screen. The selected section ID is displayed in the list on the Input panel.

Alternatively, select the section from the cross section list on the River tab > Input panel.

Zooming to a Section Location on a Surface
To zoom to the current cross section’s location on the surface, click River tab > Navigate panel > Zoom to Section Surface.

Navigating Among Cross Section Grids

To view cross section grids for the current river reach in ascending or descending order, enter either RMS_XSPrev or RMS_XSNext on the command line.

2.3.2 Viewing the Extents of a River Reach

To view the extents of a river reach, click River tab > Navigate panel > Zoom to Reach Extents. On the View Reach Extents dialog box, select the appropriate river reach.

2.3.3 Viewing a Profile View

To view a profile view, click River tab > Navigate panel > Zoom to Profile View. On the Zoom to Profile View dialog box, select the appropriate profile view.
2.3.4 Hydraulic Calculator

It is often useful to compute the normal depth at a cross section for a given discharge. The Hydraulic Calculator computes the following hydraulic properties for the currently selected cross section:

- Normal depth and corresponding elevation for a specified discharge
- Flow discharge for a specified normal depth or elevation
- Critical depth and corresponding elevation for a specified discharge
- Flow discharge for a specified critical depth or elevation

To open the Hydraulic Calculator, click River tab > Analysis panel > Hydraulic Calculator.

The following paragraphs explain the options that are available in the Hydraulic Calculator dialog box.

**Calculate Property**
Select the property to be calculated:

- Normal Depth
- Normal Discharge
- Critical Depth
- Critical Discharge

**Depth or Elevation**
Either the Depth or Elevation fields can be used to specify the water surface when computing normal discharge or critical discharge for the currently selected cross section grid. Click Pick to select a water surface elevation from the cross section grid.

**Gradient (optional)**
This entry specifies the energy gradient to use in the conveyance calculations. When the Hydraulic Calculator dialog box is first displayed, the software automatically determines the bed slope of the upstream reach and will present this value as the default energy gradient. Specifying a value in this entry allows you to override the previously determined energy gradient value.

**Discharge**
This entry specifies the flow discharge when computing normal depth or critical depth for the currently selected cross section grid.

**Accuracy (optional)**
This entry specifies the accuracy desired when computing normal or critical depth. This entry specifies the accuracy in feet (or meters), and the default accuracy is 0.01 ft (or 0.01 meters). This entry is not required and will be ignored when computing normal or critical discharge.

**Reset**
Resets the Known Values to their default values.
**Compute**

Performs the hydraulic calculation, based on the specified parameters.

Click Erase to clear any previous analysis results from the current cross section grid.

**Calculation Results**

The Hydraulic Calculator reports the following additional hydraulic properties after performing its calculations:

- Energy gradient used
- Froude number
- Flow regime (i.e., subcritical, critical, or supercritical)
- Flow area
- Wetted top width
- Average velocity
- Maximum velocity
- Composite roughness
- Critical slope (for normal depth and normal discharge calculations only)
- Hydraulic radius
- Wetted perimeter

The Hydraulic Calculator displays the analysis results in the Calculation Results area. From this area, the analysis results can be placed into the drawing adjacent to the cross section or printed out.

Click Place to position and place the results adjacent to the cross section grid and automatically superimpose the computed water surface upon the cross section geometry. Or, click Print to print the results. Use the boxes in the Report? column to select which results are to be included.

You can repeatedly use the Hydraulic Calculator to place multiple analysis results on a cross section grid.

**Numerical Basis**

The Hydraulic Calculator uses Manning's formula to compute the conveyance of each roughness subarea for the current cross section. It then sums together all roughness subarea conveyances to determine the total conveyance for the cross section.

**Flow Depth**

In computing the normal or critical flow depth for a specified discharge, an iterative process is used to compute the flow depth to the specified accuracy. However, if the computed flow depth cannot converge to the specified accuracy after 100 iterations, the Hydraulic Calculator reports that it was unable to converge to a satisfactory solution. Should this occur, try using a larger accuracy value.
Flow Velocity

In computing the average flow velocity, the Hydraulic Calculator assumes a uniform velocity distribution across the entire cross section. This value is determined by dividing the discharge by the total flow area.

The velocity of each roughness subarea is also determined. However, only the maximum velocity is reported.

Energy Gradient

The software automatically determines an energy gradient value to use when the Hydraulic Calculator dialog box is first displayed. The software uses the minimum elevation at the current and adjacent upstream cross sections and the channel flow length to compute an approximate energy gradient. However, this computed value may not be representative of the actual energy gradient and could adversely effect the conveyance calculations. Therefore, the computed energy gradient should be checked to determine whether it is a reasonable value, and if not, it should be modified.

Critical Slope

When computing normal depth or normal discharge, the reported critical slope is the channel bed slope that would cause critical depth to occur for the specified (or computed) discharge value.

Available Flow Area

The Hydraulic Calculator considers the entire cross section geometry as available for flow in its computations. It knows nothing about ineffective flow areas, floodplain encroachments, split flow reaches, or overbank areas in which divided flow has been restricted. Therefore, use caution when applying the Hydraulic Calculator to these special situations.

If either the starting or ending cross section stations are below the computed (or specified) water surface elevation, the Hydraulic Calculator will automatically extend wetted vertical walls to contain the computed flow. However, it does not adjust the wetted perimeter to account for the addition of these vertical walls.

2.4 River Networks

A river (or stream) network can be represented by a set of interconnected river reaches and connecting junctions, as shown in the following figure. Reaches start or end at locations where two or more streams join together or split apart. Reaches can also start or end at the open ends of the river system being modeled. In other words, the first and last cross section in a river to be modeled will correspond to either the start or end of a particular reach. A river reach consists of a set of related cross section grids, profile grids, and associated data which define the model. At a minimum, each river reach must contain at least two cross sections.
Each river reach must have a unique name, and is identified by the reach name and a unique ID. Each connecting junction is also represented by a unique name. The process for managing these reaches and junctions is described in the following sections.

### Multiple HEC-RAS Models

The software is capable of managing several separate HEC-RAS models within a single AutoCAD drawing file, allowing you to perform several separate water surface profile analyses within the same drawing. In order to these separate models, each model is defined as a river reach.

### River Reach ID Marker

Each river reach has its own ID marker in the drawing. A river reach ID marker is placed at the most downstream cross section used in that river reach, and it can be moved about the drawing or hidden, if desired. When multiple river reaches exist in a drawing, the current river reach is easily determined since its identifier is circled on the drawing as shown in the following figure.
River Reach Information

The Information dialog box describes the current river reach, including upstream and downstream cross section IDs, as well as ground geometry extents for all cross sections in the current river reach.

To view the Information dialog box, enter RMS_Info on the command line.

Management of River Reach Data

River reaches may be a difficult concept to understand initially, but are extremely powerful and provide great modeling flexibility. However, for small projects involving a single river reach, no user interaction is required to set up or manage the river reach. In fact, you might not know that river reaches even exist since the software automatically manages all aspects of the initial river reach. But, as your expertise grows and more complex modeling within a drawing is required, river reaches will prove to be invaluable at managing a large HEC-RAS model within a single AutoCAD drawing.

2.4.1 River Junctions

A junction is a location where river reaches join together or split apart. At least three river reaches are required to define a junction location. The Junctions dialog box is used to define the reach data that details how the river reaches join or split apart.

To display the Junctions dialog box, click River tab > Create Reach Data panel > Junctions.

To create a new junction, in the Junctions dialog box, click New. The Junction dialog box creates a blank junction entry, allowing you to define the data describing the
junction. To delete an existing junction, select the junction to be deleted from the list of junctions and then click Delete.

The dialog box entries that define a junction are described below.

**Name**
Defines the unique name of the junction being created. Up to 16 characters can be used in the junction name.

**Junction Type**
Specifies either Confluence or Split as the type of junction being modeled. Based upon the junction type selected, the dialog box will change to allow you to define the necessary data.

![Figure 2.4.1.1 Illustration of different junction types supported](image)

**Optimize Diversion Split Flow**
Informs the HEC-RAS software to determine the amount of flow that splits, at a junction where the flow splits into two separate downstream receiving reaches. This entry is only available for split flow junctions, and is unavailable (grayed out) for confluence junctions.

Flow optimizations at junctions are performed by computing the water surface profiles for all of the reaches, then comparing the computed energy grade lines for the cross sections just downstream of the junction. If the energy in all the reaches below a junction is not within a specified tolerance (0.02 foot), then the flow going to each reach is redistributed and the profiles are recalculated. This methodology continues until an energy balance is reached.

The software continues to attempt to balance the flow split until the energy grade lines of the receiving reaches are within the specified split flow tolerance.

**Computation Mode**
Specifies either Energy or Momentum as the computation method to be used at a confluence junction.
In HEC-RAS a junction can be modeled by either the energy equation or the momentum equation. The energy equation does not take into account the angle of a tributary coming in or leaving, while the momentum equation does. In most cases the amount of energy loss due to the angle of the tributary flow is not significant, and using the energy equation to model the junction is more than adequate. However, there are situations where the angle of the tributary can cause significant energy losses. In these situations it would be more appropriate to use the momentum approach. When the momentum approach is selected, an Angle column is added to the table next to the Length column. The Angle column is used to enter an angle for any river reach that is coming into or exiting the main river. For the reaches that are considered to be the main river, the angle should be left blank or set to zero. Also, you have the option to turn friction and weight forces on or off during the momentum calculations. The default is to have the weight force turned off.

**Figure 2.4.1.2** Junction flow angle

**Description**

Allows you to include a description of the junction being defined.

**Upstream Reach(es)**

When defining a confluence junction, this section becomes a table and multiple upstream reaches can be defined as combining at the junction. For each row within the table, a drop down list shows a list of available reaches.

When defining a split flow junction, this section becomes a single drop down list that allows you to select the upstream reach.

**Downstream Reach(es)**

When defining a confluence junction, this section becomes a single drop down list that allows you to select the downstream reach.
When defining a split flow junction, this section becomes a table and two downstream reaches can be defined as splitting at the junction. For each row within the table, a drop down list shows a list of available reaches.

**Length(s)**

The Junction dialog box defines the reach lengths across the junction, rather than at the next upstream cross section description. This allows for the lengths across very complicated confluences (or flow splits) to be accommodated. For the upstream reach(es), the flow distance entry defined at the next upstream cross section should be left blank or set to zero.

![Junction Flow Lengths](image)

*Figure 2.4.1.3 Junction flow lengths*

### 2.4.2 Adding a New River Reach

The software internally forces all HEC-RAS entity data to be assigned to a river reach. When starting out with a new or existing drawing, the software automatically assigns a river reach to the drawing. All modeling data entered into the drawing is then attached to this river reach. When the first cross section is defined in the model, the software will locate the river reach ID marker adjacent to the cross section. This ID marker can be moved, if required.

If only one model (or river reach) is to exist in the drawing, you do not need to define or manage the river reach since the software will automatically set up and manage this initial river reach. However, when multiple river reaches must co-exist within the same AutoCAD drawing, you should understand river reaches and be aware which river reach is currently active.

When the first Autodesk River and Flood Analysis Module command is launched, the software assigns a river reach to the drawing. All modeling data entered into the drawing is then assigned to this river reach. However, if it is necessary to define another river reach in the same drawing, then a new river reach must be assigned.
To add a new river reach to the drawing, click River tab > Create Reach Data panel > Reaches drop-down > Create Reach. The Create Reach dialog box allows you to assign a unique ID (positive integer from 1 to 100) to the river reach, along with defining a River name and Reach name. The combination of the river name and reach name must be unique.

When you click OK, the software creates a new river reach and makes it current. Any new cross section data entered is assigned to this river reach. The current reach name is shown in the reach drop-down on the River tab > Create Reach Data panel.

As soon as the first cross section is added to a new river reach, the river reach ID marker is displayed next to the cross section. If the cross section is cut from a topographical map, the river reach ID marker is positioned adjacent to the topographical map cross section. Otherwise, the river reach ID marker is positioned next to the cross section grid. If additional cross sections are added downstream of this cross section, the river reach identifier is automatically repositioned next to the most downstream cross section. However, if the river reach identifier is manually repositioned (see the section titled Moving the River Reach ID Marker on page 2-13), it is then no longer automatically repositioned.

### 2.4.3 Reassigning Cross Sections

Each cross section must belong to a single river reach; it cannot belong to multiple river reaches. Therefore, for large dendritic river models, where long river reaches have to be broken into two or more separate models, it is necessary to insert two cross sections adjacent to each other—one at the end of one reach and the other at the start of the next. This allows continued modeling of the water surface profile between the specified river reaches.

It may be necessary to reassign cross sections to a different river reach, such as when a skeletonized river model is broken down into a more detailed model as additional, smaller side reaches are added.

To reassign a river reach, click River tab > Create Reach Data panel > Reaches drop-down > Reassign Section. In the Reassign Cross Section dialog box, you can reassign cross sections from the current river reach to a different river reach.

### Reassigning Multiple Cross Sections

The Reassign Cross Section dialog box enables you to select more than one cross section in the cross section.

### Cross Sections ID Collisions

When reassigning cross sections, you cannot transfer cross sections for which an identical cross section ID already exists in the destination river reach. To reassign these cross sections, you must either delete the matching cross sections from the destination river reach, or click River tab > Input panel > Section Description to make the cross section IDs different in the current and destination river reaches.
2.4.4 Deleting a River Reach

To delete a river reach and its associated data (i.e., cross sections, etc.) from the drawing, click River tab > Create Reach Data panel > Reaches drop-down > Delete Reach. In the Delete Reach dialog box, select the appropriate river reach to delete, and click OK.

2.4.5 Editing a River Reach

To edit the ID, river name, or reach name of an existing river reach, click River tab > Create Reach Data panel > Reaches drop-down > Edit Reach.

Deleting the River Reach Identifier

If you accidentally delete the river reach identifier, the software will later re-create it—if required.

2.4.6 Moving the River Reach ID Marker

When a cross section is first added to a river reach, the software positions the river reach ID marker next to the cross section. If the cross section was cut from a topographical map, the river reach ID marker is positioned adjacent to the topographical map cross section. Otherwise, it is positioned next to the cross section grid. If additional cross sections are added downstream of this cross section, the river reach identifier is automatically repositioned next to the most downstream cross section. However, if desired, the river reach identifier can be manually moved about the drawing. Once the river reach identifier is manually moved, the river reach identifier's position is no longer automatically updated.

To move the river reach ID marker, select it and use the grip to move it.

Recommendation

It is recommended that the river reach identifier be located adjacent to the most downstream cross section, although it can be located anywhere on the drawing. Since most water surface profile models are subcritical, it makes sense to locate the river reach identifier near the downstream cross section, where the water surface boundary conditions (i.e., starting water surface elevation, discharge, etc.) are defined.

2.4.7 Selecting a River Reach

Select a river reach from the list on the River tab > Create Reach Data panel.

2.4.8 Zooming to a River Reach

To zoom to the extents of a river reach, click River tab > Navigate panel > Zoom to Reach Extents.

The View Reach Extents dialog box enables you to specify which reach to view on the drawing. If cross sections have been cut from a topographical map, the software will display the extents of the cross section data associated with the selected river reach on
the topographical map. Otherwise, if there is no topographical map data associated with the selected river reach, the software will display the most downstream cross section.

2.5 Cross Section Views

When creating cross sections, the software will automatically manage the creation and editing of cross section views. However, this section provides additional information for management of the cross section views.

![Typical cross section view](image)

*Figure 2.5.1 Typical cross section view*

A cross section view displays all of the cross section related entity information, such as the cross section geometry, bank stations, roughness values, ineffective flow areas, etc. Deleting a cross section view deletes the cross section entity from the drawing. Cross section views can be moved about the drawing at any time without affecting the cross section entity information.

2.5.1 Creating a Cross Section View

Before you can describe a cross section's location, geometry, and related information, you need to assign a cross section ID using the Create Section dialog box. This dialog box is reached by entering RMS_XSAdd on the command line.

Note that all of the methods provided within the software for extracting ground geometry from a topographical map and the provided methods for importing ground
geometry automatically display the Create Section dialog box. Therefore, this command is not often used.

In the Create Section dialog box, specify the following parameters.

**Unique ID**
Specifies a unique number to identify the cross section. No two cross sections within the same river reach may have the same cross section ID. This entry is the only information required for this dialog box to add a new cross section grid; all other data entries will default to the values of the currently active cross section grid. This entry must be positive and be no more than six characters long.

The Create Section dialog box initially presents a unique ID number for the new cross section view. You can accept this number or change it.

Unique IDs must be ascending in value, from downstream to upstream. This is how the software is able to maintain the numerical placement of the current cross section relative to all the other specified cross sections.

**Description (optional)**
This entry is used for entering an option description of the cross section.

**Station Axis: Leftmost Station**
Defines the starting station (in feet or meters) of the cross section view horizontal station axis. This entry must be positive. The cross section view horizontal axis begins at this station value.

**Station Axis: Axis Length**
Defines the length (in feet or meters) of the cross section view horizontal station axis. This entry must be positive. This length is added to the starting (leftmost) station to determine the ending (rightmost) station of the cross section view horizontal axis.

**Elevation Axis: Starting Elevation**
Defines the starting (lowest) elevation (in feet or meters) of the cross section view vertical elevation axis. This entry can be positive or negative. The cross section view vertical axis begins at this elevation value.

**Elevation Axis: Axis Height**
Defines the length (in feet or meters) of the cross section view vertical elevation axis. This entry must be positive. This length is added to the starting elevation to determine the ending (highest) elevation of the cross section view vertical axis.

**Cross Section View Scaling Factors**

All of the cross section views generated by the software use the same scaling factors for the elevation and stationing axes. However, you can, revise these scaling factors. The software will then regenerate the cross section views at the revised scaling factors. For more information on how to adjust the scaling factors, see the section titled *Configure Cross Section Views* on page 2-81.
2.5.2 Copying a Cross Section View

Many times it is useful to simply copy an existing cross section view and its related cross sectional geometry to another cross section location. For example, when defining a bridge, the downstream and upstream face cross sections of the bridge structure are very similar. Rather than defining each of these cross sections separately, one can simply define the cross section at the downstream face of the bridge and then copy this cross section to the upstream face of the bridge.

To copy the current cross section view and all of its associated data to a new cross section location, click River tab > Input panel > Section Geometry drop-down > Copy Section. In the Copy Section dialog box, specify the ID of the new cross section view for the current cross section view and related data to be copied.

Caution When Copying a Cross Section View

When copying an existing cross section view to a new cross section location, the cross section view's associated data will also be copied. Associated data includes bank stationing, flow lengths, bridge and culvert descriptions, floodplain encroachments, profile adjustments, split flow descriptions, etc. However, some of this associated data must be altered after copying. For example, the overbank and channel flow lengths must be re-specified for both the initial cross section grid and the copied cross section view(s) to account for their actual flow lengths.

Ground Geometry Elevation Adjustment

Many times, when a cross section view is copied to an adjacent location, the cross section's ground geometry must be raised or lowered by a fixed amount. Using the AutoCAD MOVE command, it is easy to select the cross section ground geometry and bank stations and then displace the selected entities up or down by the required amount.

2.5.3 Deleting a Cross Section View

To delete a cross section view and all of its associated data, click River tab > Input panel > Section Geometry drop-down > Delete Section. In the Delete Section dialog box, select the appropriate cross section view(s) to delete. The currently active cross section view is automatically selected. Multiple cross sections can be deleted.

Caution When Deleting a Cross Section View

The cross section view entity stores the cross section associated entity information. Therefore, caution must be exercised when deleting a cross section view since all of its associated entity data will also be deleted. You should first consider whether it would be more advantageous to simply edit the cross section view (see the next section, titled Editing a Cross Section Grid).

2.5.4 Editing a Cross Section View

The Edit Section dialog box allows you to edit the currently active cross section's grid attributes.
To edit the current cross section view’s attributes, enter RMS_XSEdit on the command line.

The Edit Section dialog box can be used to manually resize the cross section view to fit the extents of cross section related data (such as ground geometry, roadway geometry, and ineffective flow areas).

The data entries for the Edit Section dialog box are identical to those described in the section titled Creating a Cross Section View on page 2-14.

### 2.5.5 Renumbering Cross Sections

If it becomes necessary to renumber all the cross sections in the current river reach, click River tab > Input panel > Section Geometry drop-down > Renumber Section.

In the Renumber Section dialog box, specify the following parameters:

**Starting Cross Section ID**
Specify a new starting ID for the most downstream cross section.

**Cross Section ID Increment**
Specify how cross section IDs are to be incremented.

- **Fixed**: Define a fixed increment to be used in the cross section ID renumbering. For example, entering a value of 100 causes the IDs to be renumbered in 100 increments, beginning at the starting cross section ID.
- **Channel Reach Length**: Causes the cross section ID renumbering to be based upon the distance defined for the Channel Reach Length entry, as defined in the Cross Section Description dialog box.
- **Average Reach Length**: Causes the cross section ID renumbering to be based upon the average reach length distance defined for the left, channel, and right reach length data entries, as defined in the Cross Section Description dialog box.

**Increment Unit**
Defines the unit of measure to be used in the cross section renumbering when using the reach length options. For example, if the model is defined in US units, then the cross section ID increment can be based upon either feet or miles, or meters or kilometers.

### 2.5.6 Selecting and Viewing Cross Sections

There are several ways to select and view cross sections.

#### 2.5.6.1 Selecting a Cross Section

To define specific information about a cross section, such as the cross section expansion and contraction values, the cross section must be currently active. Only one cross section can be active at any given time. The currently active cross section is identified in the cross section list on the River tab > Input panel.

To select a cross section, on the command line, enter RMS_XSSelect. In the Select Cross Section Grid dialog box, select the cross section to make current.
If you are currently looking at a different cross section or a topographical map view, then this display will be maintained.

When a cross section has been made current, its ID is displayed in the cross section list on the River tab > Input panel.

### 2.5.6.2 Zooming to a Cross Section

To zoom to a cross section view, click River tab > Navigate panel > Zoom to Section View. In the Zoom to Section View dialog box, select the section view and click OK.

Selecting a cross section grid from the Zoom to Section View dialog box displays the selected cross section grid in the current viewport and makes the selected cross section grid currently active. When a cross section has been made current, its ID is displayed in the cross section list on the River tab > Input panel.

### 2.5.6.3 Viewing a Cross Section on a Surface

To view the current cross section on the surface it is sampling, click River tab > Navigate panel > Zoom to Section Surface.

### 2.5.6.4 Viewing Cross Section Analysis Results

The cross section grid can display the computed water surface, critical water surface, and energy grade line. See the section titled Displaying Cross Section Results on page 2-50 for information on how to specify what analysis results are to be displayed on the specified cross section grids.

### 2.5.6.5 Viewing Previous and Next Cross Section Views

To view the previous cross section grid, on the command line, enter RMS_XSPrev.

To view the next cross section grid, on the command line, enter RMS_XSNext.

### 2.5.7 Resizing a Cross Section View

After adding, editing, or deleting a cross section's ground geometry, roadway geometry, or ineffective flow area data, it may be desirable to resize the cross section view to fit the extents of this data.

Instead of manually resizing the currently active cross section grid using the Edit Cross Section Grid dialog box, the software can automatically resize the view to the extents of the cross section related data.

To automatically resize the current cross section view, on the command line, enter RMS_XSResize.

To automatically resize the all cross section views, click River tab > Input panel > Section Geometry drop-down > Resize Section views.
The Configure Section Views dialog box provides settings that control how views will be resized. Refer to the section titled Configure Cross Section Views on page 2-81 for more information.

2.6 Defining Cross Section Geometry

Autodesk River and Flood Analysis Module provides a variety of tools for automatically and manually inputting cross section ground geometry.

2.6.1 Cutting Sections from a 3D Surface

The 3D map cross section geometry input method is the fastest and most powerful method of digitizing a cross section. This method allows you to cut a cross section directly from an on-screen 3D topographical contour map or 3D TIN (triangulated irregular network). A 3D topographical map differs from a 2D topographical map, in that it has elevation data associated with the displayed contour lines or points.

To cut sections from a 3D surface:

1. Click River tab > Input panel > Create Section drop-down > 3D Section Cut.
2. In the 3D Section Cut dialog box, enter a Unique Cross Section Grid ID.
3. Under Initial Values, specify the Leftmost (starting) ground station. The starting station can be any arbitrary value.
4. Cut a cross section from the surface by picking cross section ground station points, which correspond to contours, in sequence (leftmost station to rightmost station). Choose a representative cross section that best describes the flow characteristics of the reach being modeled.

Because the software reads elevations from any contours crossed by the cutting line; it is not necessary to pick every contour in a cross section. This allows you to select only the contours where the cross section cutting line direction changes. You may not want elevation data to be read from particular AutoCAD layers—the Configure Elevation Layers dialog box is provided for this purpose. See the section titled Configure Elevation Sources on page 2-84 for more information.

You can also explicitly specify each cross section ground station's X,Y coordinates on the surface. However, be aware that the elevation is always taken from the nearest 3D contour, no matter how the ground points are input. You cannot directly define the elevation of a digitized ground point, but can later redefine the elevation (or station) using the Edit Geometry input method, as discussed in the section titled Editing Cross Section Geometry on page 2-24.

Although it’s best to display the desired view of the surface before beginning this method, you can transparently pan and zoom to quickly move about the surface during the digitizing process.
Using Points at Elevation

If desired, you can use 3D points at elevations when cutting a cross section. Rather than selecting a point on a contour, simply click the 3D point.

A problem associated with using points at elevation when cutting a cross section is that the points may not lie along a path where you can cut a cross section. In this situation, you may want to connect lines between the 3D points. Using the standard AutoCAD LINE or 3DPOLY command along with the NODE OSNAP option, you can connect a 3D line between existing 3D points. This technique will help when cutting a cross section using points at elevation.

Verifying Elevation Layers

When entering cross section ground geometry using the 3D Section Cut or 2D Section Cut commands, the software will search for any elevation data on the surface that intersect the drawn cross section line. Any points, lines, polylines, or TIN polyfaces intersected will be examined for possible elevation data, but only for layers that have been configured as valid elevation layers. If an entity is found on a layer whose status has not previously been defined, you will be prompted to configure the layer's status.

2.6.2 Cutting Sections from a 2D Surface

This cross section geometry input method allows you to cut a cross section from an on-screen 2D surface, which has no elevation data associated with the displayed contour lines.

To cut sections from a 2D surface:

1. Click River tab > Input panel > Create Section drop-down > 2D Section Cut.
2. In the 2D Section Cut dialog box, enter a Unique Cross Section Grid ID.
3. Under Initial Values, specify the Leftmost (starting) ground station. The starting station can be any arbitrary value.
4. Cut a cross section from the surface by picking cross section ground station points which correspond to contours, in sequence (leftmost station to rightmost station).

It is not necessary to pick every contour in a cross section, because the software will interpolate elevations (using the surface contour interval) from any contours crossed by the cutting line. This allows you to select only the minimum and maximum contours as the cross section is being cut, or where the cross section cutting line direction changes. You may not want elevation data to be read from particular AutoCAD layers—the Configure Elevation Layers dialog box is provided for this purpose. See the section titled Configure Elevation Sources on page 2-84 for more information.
The current digitizing elevation is displayed on the Command line and may be changed while digitizing cross section ground stations by one of the following methods:

- Press the Up and Down cursor keys will increase or decrease the digitizing elevation by the current step value.
- Enter in a new elevation (a single number, such as 1650).
- Enter the new elevation as the third coordinate after the cross section ground station's X,Y coordinates have been entered (such as 7410,420,1650, with no spaces).

Although it’s best to display the desired view of the surface before beginning this method, you can transparently pan and zoom to quickly move about the surface during the digitizing process.

### Digitizing from Screen Raster Maps

This cross section geometry input method also allows you to create a cross section by drawing it from an on-screen raster topographical map. A raster topographical map has no elevation data associated with the displayed contour lines.

When cutting the cross section from the raster topographical map, pick the cross section ground station points that correspond to raster contour lines, in sequence (leftmost station to rightmost station) on the screen topographical map.

### 2.6.3 Cutting a Section from a Polyline

The Section Cut by Object command allows you to extract cross section geometry from a polyline on a surface. This enables you to adjust the polyline to the desired position before the cross section is extracted.

This method can be automated using the Automated Section Cut command.

To cut a section from a polyline:

1. Click River tab > Input panel > Create Section drop-down > Section Cut by Object.

2. In the Section Cut by Object dialog box, enter a Unique Cross Section ID. Under Trace Line Options, specify where the elevation data is sampled:
   - Trace Line as a Cutline and Use Elevation Layer Data: Select this option, and then click Configure Elevation Data, to specify the layers and surfaces from which elevation data is extracted.
   - Trace Line and Use Line’s Elevation Data: Select this option to use the elevation data that is assigned to a 3D polyline.

3. Click OK.

4. Select the left side (looking in a downstream direction) of the polyline. The software will then follow along the polyline and extract the cross section geometry.
2.6.4 Creating Sections from Imported Data

The Import Section Geometry from File command allows you to import all or only a portion of the ground geometry for a cross section from a number of file types:

- HEC-RAS geometry file
- HEC-2 input card file
- XYZ or YXZ (Northing-Easting) coordinate data file
- a station/elevation or elevation/station point file

This method provides greater accuracy in specifying the cross section ground geometry by allowing you to insert surveyed data directly into the model.

As with other ground input methods, this method allows you to insert the imported ground geometry data into the currently active cross section, create a replacement cross section, or create a completely new cross section.

To create sections from imported data:

1. Click River tab > Input panel > Create Section drop-down > Import Section Geometry from File.

2. In the New Section Grid dialog box, specify a Unique Cross Section ID. Click OK.

3. In the Import Section Geometry from File dialog box, navigate to the file to import.

4. Click OK.

After selecting the data file to import, the software automatically determines the file type. The software then displays the Import from File dialog box, which allows you to control the extent of the ground geometry to import.

If the selected data file is a HEC-RAS geometry file or HEC-2 input card file, this dialog box allows you to specify the cross section from which to import ground geometry. You can also specify restrictions to limit which ground stations are to be imported.

If the selected data file is an XYZ or YXZ coordinate data file, or a station/elevation or elevation/station point file, you can specify restrictions to limit which ground stations are to be imported.

**XYZ and YXZ Coordinate Data File Format**

In order for the software to be able to identify that the file being imported is an XYZ or YXZ coordinate data file, the file must be properly formatted. Note that an YXZ coordinate data file is more commonly referred to as a northing-easting-elevation coordinate file.
Follow these guidelines when developing a coordinate data file:

1. The first line in the coordinate data file must contain the keyword XYZ (or YXZ) by itself.

2. The second line defines the starting horizontal station value. The starting horizontal station value cannot be negative. If this line is left blank, a starting horizontal station of 0.0 is assumed.

3. The third line defines an elevation datum adjustment value. This adjustment value allows you to adjust the elevation of the coordinate data. If this line is left blank, an elevation adjustment of 0.0 is assumed.

4. Starting with the fourth line, each remaining line in the file corresponds to the X, Y, and Z coordinates (or Y, X, and Z coordinates) of a single 3D ground point. Spaces, commas, and/or tabs can be used to delimit the coordinate values of a point.

5. Negative and positive coordinate values are allowed.

The software uses the Pythagorean Theorem to determine the absolute distance between adjacent ground point stations using the specified X and Y coordinate values. This distance is accumulated, being added to the specified starting horizontal station value to determine each ground point's resultant stationing value. The following figure illustrates that the surveyed ground points do not need to reside along a straight line. However, these surveyed points should form a line perpendicular to the stream flow. Each ground point's Z coordinate value is added to the specified elevation datum adjustment value to determine the resulting elevation.

![Figure 2.6.4.1 Surveyed ground points do not need to lie along a straight line, but should form a line perpendicular to the stream flow](image)
As with the XYZ and YXZ coordinate data file, the file must be properly formatted in order for the software to be able to identify the file being imported as a station/elevation and elevation/station point file. The file format of a point file is very similar to that of an coordinate data file.

Follow these guidelines when developing a point file:

1. The first line in the station/elevation point file must contain the keyword XY (or YX) by itself.

2. The second line defines the starting horizontal station value. The starting horizontal station value cannot be negative. If this line is left blank, a starting horizontal station of 0.0 is assumed.

3. The third line defines an elevation datum adjustment value. This adjustment value allows you to adjust the elevation of the stored data. If this line is left blank, an elevation adjustment of 0.0 is assumed.

4. Starting with the fourth line, each remaining line in the file corresponds to the station and elevation (or elevation and station) of a single ground point. Spaces, commas, and/or tabs can be used to delimit the station and elevation values of a point.

5. Negative stationing values are not allowed. Each stationing value is added to the specified starting horizontal station value to determine each ground point's resultant stationing value. Each ground point's elevation value is added to the specified elevation datum adjustment value to determine the resulting elevation.

The software provides a separate import method in order to import data for multiple cross sections, which allows the cross sectional data to reside within a single file. See the section titled Creating Sections from Imported Data on page 2-22 for more information.

2.6.5 Editing Cross Section Geometry

Many times it is convenient to directly edit the cross section geometry station and elevation values once they have been input by one of the previously described input methods. The Section Geometry Editor dialog box can be used to insert, add, edit, and delete individual ground points for the current cross section grid. From this dialog box you may also import cross section ground points from an existing HEC-RAS geometry file, HEC-2 input card file, a station/elevation point file, or an XYZ coordinate data file. In addition, you can insert, edit, and delete horizontal roughness, low chord elevation, and roadway elevation values.

To edit cross section geometry:

1. Click River tab > Input panel > Section Geometry drop-down > Section Geometry Editor.
2. In the Section Geometry Editor dialog box, specify the Reach and Cross Section.

In the Cross Section Data table, the two green colored rows correspond to the left and right overbank stations.

3. In the Cross Section Data table, click cells and enter data to modify the cross section geometry:

   > Click < to graphically select a horizontal station or elevation from the cross section grid.
   > To insert a new station and elevation, click New.
   > To graphically select a station to edit, click Pick.

**Importing Ground Geometry Data**

To import ground geometry from a HEC-RAS geometry file, HEC-2 input card file, a station/elevation point file, or an XYZ coordinate data file, click Import. From the Import Section Geometry from File dialog box, you can select the file from which to import data.

After selecting the data file to import, the software automatically determines the file type.

After selecting the data file to import, the software displays the Merge Geometry Data dialog box.

In the Merge Geometry Data dialog box, if ground geometry already exists in the current cross section, you can select whether to replace the old station points with the new imported station points. Station and/or elevation offset values to adjust the position of the ground geometry can also be defined. Both values default to zero when the dialog box is first displayed.

Restrictions to limit which ground stations are to be imported can be specified. To change the Left Station and Right Station values, enter new station limits in the edit boxes or simply pick the desired starting or ending station from the Preview image. Note the radio buttons in front of the Left Station and Right Station edit boxes; this setting determines which edit box will be adjusted by picking a cross section station from the Preview image.

If the selected data file is a HEC-RAS geometry file or HEC-2 input card file, this dialog box allows you to specify the cross section from which to import ground geometry. Note that the Station Offset, Elevation Offset, Left Station, and Right Station data entries return to their default values whenever a cross section is selected from the list.

Click 0 to reset the Station Offset, Elevation Offset, Left Station, and Right Station data entries to their default values.

To select a different data file from which to import ground geometry, click New File.
Maximum Number of Ground Points

The Section Geometry Editor dialog box supports a maximum of 5,000 ground points per cross section. However, HEC-RAS as an upper limit of 500 ground points per cross section. If the cross section being defined has more than the model’s upper limit, the Reduce Section Points command can be used to weed redundant ground points from the cross section. See the section titled Reducing Cross Section Points on page 2-27 for more information.

2.6.6 Adjusting Cross Section Geometry

You can adjust the geometry of a cross section.

To adjust the current cross section geometry:

Click River tab > Input panel > Section Geometry drop-down > Adjust Section Geometry.

The Adjust Section Geometry dialog box contains the following controls:

Add Constant Station
Allows you to add a constant station amount to all of the cross section ground geometry station values. Click Pick to graphically select the station amount from the current cross section.

Add Constant Elevation
Allows you to add a constant elevation amount to all of the cross section ground geometry elevation values. Click Pick to graphically select the elevation amount from the current cross section.

Shift Stationing
Allows you to shift the stationing to the left or right by a specified amount. The Type list specifies the reference point that is to be used in determining how much to shift the stationing. The following reference point types are available:

- Custom
- Thalwag Centerline
- Centered Between Banks
- Left Bank
- Right Bank
- Leftmost Station
- Rightmost Station

If the Custom reference point type is selected, then an existing Source station and new Target station must be defined. If any other reference point type is specified, then a new Target station must be defined.
Select Create New Station to cause a new ground station to be created, if necessary. For example, if Centered Between Banks is specified as the reference point type will cause a new ground point to be created if a centerline station does not already exist. The new ground point’s elevation will be interpolated from the adjacent ground points.

**Left Overbank Factor**
Allows you to specify a factor to be multiplied to the left overbank ground geometry station spacing to either shrink or expand the left overbank area. For example, to shrink the distance between ground stations in the left overbank area by 50%, a factor of 0.5 should be specified. Similarly, to expand the distance between stations by 20%, a factor of 1.2 should be specified. Note that the leftmost starting station is used as a fixed reference point for scaling the ground geometry stationing.

**Channel Factor**
Allows you to specify a factor to be multiplied to the channel ground geometry station spacing to either shrink or expand the channel area. For example, to shrink the distance between ground stations in the channel by 50%, a factor of 0.5 should be specified. Similarly, to expand the distance between stations by 20%, a factor of 1.2 should be specified. Note that the leftmost starting station is used as a fixed reference point for scaling the ground geometry stationing.

**Right Overbank Factor**
Allows you to specify a factor to be multiplied to the right overbank ground geometry station spacing to either shrink or expand the right overbank area. For example, to shrink the distance between ground stations in the right overbank area by 50%, a factor of 0.5 should be specified. Similarly, to expand the distance between stations by 20%, a factor of 1.2 should be specified. Note that the leftmost starting station is used as a fixed reference point for scaling the ground geometry stationing.

**Reverse Ground Stationing Order**
Reverses the order of the cross section stationing. This is useful in situations where the cross section geometry was cut from a surface in the wrong direction (i.e., right to left) and the cross section stationing needs to flip, end for end.

**Automatically Resize Cross Section Grid**
Automatically resizes the cross section grid after the specified cross section geometry adjustment has been applied. By default, this option is selected.

**Adjustment Extent**
Allows you to control the extent of the specified cross section geometry adjustment. By default, only the current cross section is adjusted. However, the specified adjustment can be applied to the entire river reach or all defined river reaches.

### 2.6.7 Reducing Cross Section Points
The software allows you to specify up to 5,000 points per cross section. In addition, the HEC-RAS analysis engine that is supplied with the software can handle 500 points per cross section.
When attempting to perform a HEC-RAS simulation, the software will warn you if the number of specified cross section points are over the allowable limit. If so, it may be necessary to reduce the number of cross section points to this limit.

To reduce the number of cross section points:

1. Click River tab > Input panel > Section Geometry drop-down > Reduce Section points.

2. The Reduce Section Points dialog box displays the existing ground geometry and the total number of points defined for the current cross section. By specifying the number of points allowed, the software automatically eliminates those points which add the least resolution to the existing ground geometry.

3. After specifying which reduction rules to apply and the total number of cross section points allowed, click Preview. The software will then display the revised cross section ground geometry along with the original ground geometry, allowing you to check the software's computed ground point reduction.

4. When satisfied with the revised geometry, click OK.

The software uses a triangular area comparison algorithm to determine each point's degree of ground geometry resolution. Points that define significant breaks in the cross section geometry are allowed to remain. The software does this by looking at each point and its two adjacent points. It then computes the triangular area formed by these three points and stores this area with the point. Those points with the least area which fall within the specified reduction rules are removed to meet the specified number of points allowed. However, ground points that define starting and ending stations, flood overbank stations, horizontal roughness stations, bridge low chord geometry stations, and roadway geometry stations are not removed.

**Reduction Rules**

The software allows you to select FEMA (Federal Emergency Management Agency) rules to use in reducing the number of ground points for a cross section. These rules include the following:

- Allow a maximum of 90 ground points.
- Allow a maximum horizontal spacing of 5% of the total cross section width between floodplain ground points (i.e., points outside the bank stations).
- Allow a maximum horizontal spacing of 10% of the main channel width between channel ground points (i.e., points inside the bank stations).
- Allow a maximum vertical spacing of 20% of the total cross section height between ground points.

Click FEMA Rules to select all of the above reduction rules. Click No Rules to clear the above rules. You can also select individual reduction rules to be applied.

Note that the software only applies the maximum spacing requirement rules to reduce the total number of ground points. The software does not add ground points if the original geometry violates these rules.
2.6.8 Tracing a Cross Section Cut Line on a Surface

When using the 3D and 2D section cut commands, the software automatically links the cross section view and related information (i.e., ground geometry, bank stations, etc.) to a cross section cut line shown on the Autodesk AutoCAD Civil 3D surface. This enables you to edit the cross section related information from either the cross section view or the surface by simply clicking on the representative graphic entity. This also allows the computed water surface profile to be displayed on the surface.

However, it may be necessary to link cross section views (and related information) to the surface in situations where no linkage exists. For example, you may import a HEC-2 card file into a new drawing containing a surface of the region being studied. When the data is imported, there is no link between the imported cross section ground geometry and the surface geometry. You can manually assign linkages between the imported ground geometry (cross section views) and cross section cut lines drawn on the surface.

To link an existing cross section view to a surface:

1. Select a cross section view to link to the surface (see the section titled Selecting a Cross Section on page 2-17).
2. Click River tab > Input panel > Link Section drop-down > Trace Section Location.
3. On the surface, draw a temporary cross section cut line that represents where the ground geometry for the selected cross section grid should be placed. Start with the leftmost station, include station locations where the cross section cut changes direction, and finally end with the rightmost station.

Not every ground station point needs to be identified—only identify the starting and ending stations and where the cross section cut changes direction. After you have drawn the cut line on the surface, the software will replace this line with a new line containing all the points that describe the ground geometry for the cross section view.

This procedure can be repeated for each cross section view that needs to be linked to the surface. As the cross section views become linked to the surface, the software will automatically draw cross section labels and related data, such as bank stations, on the surface. If the linked cross section line is not laid out to your liking, this command can be repeated and the cross section cut line redrawn.

2.6.9 Moving a Cross Section Cut Line

When using the Trace Section Location command, as presented in the section titled Tracing a Cross Section Cut Line on a Surface, sometimes linking an existing cross section to a surface is a trial and error process—especially when the exact location of the original cross section is not known. After using the Trace Section Location command, you are generally able to tell if the cross section does not belong where it was drawn by looking at where the cross section bank stations lie on surface. If the bank stations do not appear to correctly align with the topographical map channel banks, then the cross section cut line will need to be moved upstream, downstream, or from side-to-side in an attempt to correctly locate it.
To move a cross section cut line:

1. Click River tab > Input panel > Link Section drop-down > Move Section Location.
2. In the Move Section Location dialog box, specify the reference point to use.
3. Click OK.
4. In the drawing, pick the new reference point location on the surface.

This command does not alter the original cross section ground geometry; the original ground geometry is maintained. If it is desired to recut the ground geometry at the new cross section location, see the section titled Recutting a Cross Section on page 2-30.

The Move Section Location command can be used as many times as necessary to precisely locate the cross section cut line.

2.6.10 Rotating a Cross Section Cut Line

After using Trace Section Location and Move Section Location commands (as presented previously in section titled Tracing a Cross Section Cut Line on a Surface on page 2-29 and the section titled Moving a Cross Section Cut Line on page 2-29), you may have to rotate the cross section on the surface in an attempt to correctly locate it.

To rotate a cross section cut line:

1. Click River tab > Input panel > Link Section drop-down > Rotate Section Location.
2. In the Rotate Section Location dialog box, specify the reference point to use.
3. Click OK.
4. In the drawing, pick the new cross section rotation angle.

This command does not alter the original cross section ground geometry. If it is desired to recut the ground geometry at the new cross section location, see the section titled Recutting a Cross Section on page 2-30.

The Rotate Section Location command can be used as many times as necessary to precisely locate the cross section cut line.

2.6.11 Recutting a Cross Section

Sometimes it is necessary to recut an existing topographical map cross section, such as when new topographical geometry data is imported into the drawing file, in order to update the cross section ground geometry. For example, perhaps both existing and proposed contour line data is in the same file, on separate layers. The software allows you to recut previously cut cross sections, generating new cross section geometry.

To recut a cross section:
1. Click River tab > Input panel > Create Section drop-down > Recut Section.

2. In the Recut Section Points dialog box, select whether to recut the current cross section, or all cross sections in the current river reach.

3. Click OK.

### Defining Elevation Layers

The software will read elevation data from the defined elevation layers that contain ground terrain information. To change which layers are to be read for elevation data, select Configure Layers from the Recut Existing Cross Sections dialog box. This will display the Configure Elevation Layers dialog box (see the section titled *Configure Elevation Sources* on page 2-84), allowing you to select what layers are to be used for reading elevation data.

### 2.6.12 Graphical Adjustment of Ground Geometry

The software allows you to perform ground geometry adjustments graphically using AutoCAD grips. For example, while at the AutoCAD command line, pick the ground line to move an individual ground point shown on either the cross section view or surface. AutoCAD automatically highlights all the ground points. Pick the ground point you want to move and drag it to its new location. To clear grips from the selected ground line, press Esc twice.

**NOTE:** Related Autodesk River and Flood Analysis Module entities are dynamically updated only when they are edited within the Autodesk River and Flood Analysis Module commands. When AutoCAD commands (such as MOVE) are used, Autodesk River and Flood Analysis Module entities are not dynamically updated.

To change the elevation of an entire ground line on a cross section view, pick the ground line, select any point on the line, and press Enter (or the right mouse button) to toggle into Move mode. Then drag the entire ground line to the desired elevation on the view. This method can also be used to adjust the position of a cross section cut line drawn on the surface.

There are a few things to be aware of when using grips to edit ground geometry:

- Changing a ground point's location on the cross section view automatically updates the corresponding ground point on the surface (or vice versa).
- Since the software uses the geometry shown on the cross section view when performing its water surface profile calculations, if this geometry data does not correspond to the underlying digital terrain map, then the topographical map water surface results could possibly be inaccurate.
- Moving a cross section cut line on the surface will automatically move the related bank stations and connecting lines.
- Editing a topographical map cross section cut line using grips automatically updates the ground geometry shown on the cross section grid.

For more information on AutoCAD grips, see the section titled *Graphical Editing using Grips* on page 2-41.
2.7 Automated Data Extraction Methods

In addition to the manual methods for constructing cross sections, the software provides automated methods for extracting cross section geometry and other related data from the digital terrain map.

2.7.1 Cutting Cross Sections Automatically

The Automated Section Cut command can automate the extraction of river cross section geometry along a river centerline alignment at a pre-defined spacing. Up to 800 cross sections can be extracted per river reach (this is a HEC-RAS limitation). After selecting the river centerline alignment (at the downstream end), specifying additional parameters regarding cross section spacing, cross section numbering, and what to do when cross sections might overlap, the software automatically extracts the river cross section geometry from topographical map.

To automatically cut cross sections, click River tab > Input panel > Create Section drop-down > Automated Section Cut.

In the Automated Section Cut dialog box, specify the following parameters:

River Centerline
This entry is used to interactively select the river centerline alignment from the surface. The alignment should be a 2D or 3D polyline that is aligned perpendicular to how the cross sections are to be extracted from the surface. The alignment should be selected from near the downstream end so that the software can determine the direction of the river in order to number the cross sections in increasing order while traversing upstream along the selected alignment. Click Pick to interactively select the downstream end of the river centerline alignment polyline.

Cross Section Cutting Method
The cross section cutting methods provide flexibility for extracting cross sections from the river topographical data. The following methods are provided:

Perpendicular
Extracts the cross sections from the river topographical data perpendicular to the previously drawn river centerline alignment. This cross section cutting method is the most commonly used method.

Template Cutline
Enables you to provide a template cutline in order to have uniformity in the extracted cross section. For example, when cutting cross section along a irrigation canal, the cross sections should be identical in geometry except for elevation. Be assigning a template cutline, the extracted cross sections will be the same.

Multiple Cutlines
Enables you to draw 2D polylines on the surface to define where to extract cross section geometry—prior to actually extracting the cross sections. This allows you to adjust the cross section extraction polylines interactively, grabbing the grips of the polylines to more precisely position where the cross sections are to
be extracted. This method will then automate the processing of these extraction polylines using the Section Cut by Object command (see section titled *Cutting a Section from a Polyline on page 2-21*).

**Cross Section Cutline(s)**
Selects the cross section cutlines when the Template Cutline and Multiple Cutline methods are selected as the Cross Section Cutting Method. Click Pick to interactively select the previously drawn cross section cutline(s).

This option is disabled (not available) when using Perpendicular as the Cross Section Cutting Method.

**Cross Section Spacing**
Specifies spacing to be used when extracting the cross sections along the specified river centerline alignment polyline. Typically, this value ranges from 500 to 1500 ft—depending upon the study requirements. More detailed models require closer cross section spacing. Click < to interactively select the cross section spacing distance.

This option is disabled (not available) when using Multiple Cutlines as the Cross Section Cutting Method.

**Cross Section Width**
Specifies the width of the cross section to be extracted from the surface. This entry represents how wide the cross section will be, where 1/2 of this width will be on each side of the previously drawn river centerline alignment. Click < to interactively select the cross section width.

This option is disabled (not available) when using Template Cutline and Multiple Cutlines as the Cross Section Cutting Method.

**Keep End Points of Cutline**
When extracting cross section data from a surface, the software only extracts geometry data where terrain data exists (i.e., contour lines). Therefore, the extracted cross section will generally be shorter than the specified cross section width or the selected cutline. This option causes the software to compute, by either interpolating or extrapolating, the corresponding elevation for the end points of the extracted cross section geometry.
**XS Overlapping**

Different cross section cutting methods provide flexibility for extracting cross sections from the river topographical data. The following methods are provided:

- Parallel to Intersecting XS
- Trim Intersecting Ends
- Allow Overlapping XS
- Delete Overlapping XS

![Different methods to handle overlapping cross sections](image)

**Reference Stationing (optional)**

This option allows you to specify a reference station and corresponding numeric value for the geometry cross section data to be extracted from the surface. The following reference station Types are provided:

- Centered
- Leftmost Station
- Rightmost Station
- Thawlag Centerline

Click Pick to interactively measure the distance to be used for the reference station numeric value.
Bank Stations (optional)
This option allows you to specify alignment polylines that represent the left and right bank stations. Ground stations will be added to the extracted cross section geometry, corresponding to where the specified alignment polylines intersect the extracted cross sections. Click Pick to interactively select the downstream end of these bank station alignment polylines.

Overbank Flow Lengths (optional)
This option allows you to specify alignment polylines that represent the left and right overbank flow lengths. Click Pick to interactively select the downstream end of these alignment polylines. Alternatively, the left and right bank alignment polylines can be used for determining these flow lengths.

The channel flow length is already determined using the specified river centerline alignment polyline.

Cross Section ID
This section allows you to specify how the cross section IDs are to be assigned.

Starting Cross Section ID
Specifies the ID of the downstream most cross section.

Cross Section ID Increment
Specifies how the cross section ID increments. The following methods are provided:

- Fixed - A fixed amount is used to increment the cross section ID
- Channel Reach Length - The channel reach distance (in ft, miles, meters, or kilometers) is to be used to determine the cross section ID
- Average Reach Length - The average of the channel, left overbank, right overbank distance (in ft, miles, meters, or kilometers) is to be used to determine the cross section ID

2.7.2 Assigning Bank Stations and Reach Lengths
The Assign Bank Stations and Reach Lengths commands can automate the extraction of this cross section data from alignments drawn on to the topographical map.

To assign bank stations and reach lengths, click River tab > Input panel > Section Assign drop-down > Assign Bank Stations & Reach Lengths.

In the Automated Bank Stations & Flow Lengths dialog box, specify the following parameters:
Bank Stations (optional)
This option allows you to specify alignment polylines that represent the left and right bank stations. Ground stations will be added (or burned in) to the existing cross section geometry, corresponding to where the specified alignment polylines intersect the cross sections. Click Pick to interactively select the downstream end of these bank station alignment polylines.

Channel Flow Length (optional)
This option is used to automatically compute the channel flow length for the selected cross sections (or current river reach). The following methods for computing this length are provided.

Use Cross Section ID Difference
If the cross sections have been numbered based upon their river stationing, then this option causes the software to compute the channel flow length by subtracting the difference between the cross section IDs (from the current cross section and the next downstream cross section).

Use River Centerline
This option is used to interactively select a river centerline alignment from the surface. The alignment should be a 2D or 3D polyline that is aligned with the centroid of the channel flow area. Using this alignment polyline, the software will determine the distance between cross sections and then enter this as the channel flow length. Click Pick to interactively select the downstream end of the river centerline alignment polyline.

Overbank Flow Length (optional)
This option is used to automatically compute the overbank flow lengths for the selected cross sections (or current river reach). The following methods for computing these lengths are provided:

Use Bank Lines
This option is used when the previously specified alignment polylines that represent the left and right bank stations represent the overbank flow lengths.

Use Channel Flow Length
This option is used when the overbank flow lengths are roughly equal to the defined channel flow length. This option can be selected when defining long, straight lengths of river.

Use Overbank Flow Length Lines
This option is used to specify alignment polylines that represent the left and right overbank flow lengths. Click Pick to interactively select the downstream end of these alignment polylines.
Using the Program

2.7.2 Example of overbank flow length mapping

Apply To
This section is used to select to apply these specified automation data extractions to the current river reach or selected cross sections along the river reach. The following selections are provided:

- All cross sections (current reach)
- Selected cross sections

2.7.3 Assigning Manning’s Roughness

The Assign Manning’s Roughness command can automate the extraction of Manning’s roughness from the topographical map, or can be used to assign default Manning’s roughness values.

To assign Manning’s roughness, click River tab > Input panel > Section Assign dropdown > Assign Manning’s Roughness.

In the Assign Manning’s Roughness dialog box, specify the following parameters:

Manning’s Roughness Polygon Mapping
This optional section allows you to select the AutoCAD drawing layer that contains digitized polygons which represent corresponding Manning’s roughness values. The polygon’s elevations need to be set equal to the desired Manning’s roughness value for the software to assign the appropriate roughness. For example, for a Manning’s roughness coefficient of 0.055 to be defined, the elevation of the polygon should be set to 0.055. The software will then intersect the polygons, or the elevation value of the polyline, defined on the specified layer with the previously defined cross sections, thereby mapping the roughness values to the cross sections where these cross section vs. polygon intersections occur.
Default Roughness Values
Defines the default Manning’s roughness for the left overbank, channel, and right overbank areas at each cross section. These values are used where there are no polygon coverages defined.

Apply To
This section is used to select to apply these specified automation data extractions to all river reaches, the current river reach, or selected cross sections. The following selections are provided:

- All cross sections (all river reaches)
- All cross sections (current river reach)
- Selected cross sections

2.7.4 Assigning Ineffective Flow Areas
The Assign Ineffective Flow Areas command can automate the extraction of ineffective flow areas the surface.

To assign ineffective flow areas, click River tab > Input panel > Section Assign drop-down > Assign Ineffective Flow Areas.

In the Assign Ineffective Flow Areas dialog box, specify the following parameters:

Ineffective Flow Area Polygon Mapping
This section allows you to select the AutoCAD drawing layer that contains digitized polygons which represent corresponding ineffective flow areas. The polygon’s elevations need to be set equal to the desired ineffective flow area elevation for the software to assign the appropriate areas. The software will then
intersect the polygons defined on the specified layer with the previously defined cross sections, thereby mapping the ineffective flow areas to the cross sections where these cross section vs. polygon intersections occur.

Figure 2.7.4.1 Example of ineffective flow area polygons

Apply To
This section is used to select to apply these specified automation data extractions to all river reaches, the current river reach, or selected cross sections. The following selections are provided:

- All cross sections (all river reaches)
- All cross sections (current river reach)
- Selected cross sections

Permanent
This check box denotes that the defined ineffective flow areas should be permanently defined in the model. Otherwise, the ineffective flow areas can begin to carry conveyance once the ineffective flow area elevations have been overtopped by the computed water surface.

2.7.5 Assigning Levees
The Assign Levees command can automate the extraction of levees the surface.

To assign levees, click River tab > Input panel > Section Assign drop-down > Assign Levees.

In the Assign Levees dialog box, specify the following parameters:

Left/Right Levee Line
This section allows you to specify alignment polylines that represent the left and right levee stations. Click Pick to interactively select the levee station alignment polylines.
Levee Elevations
This section is used to assign the levee elevation. The following methods for specifying the levee elevation are provided:

**Ground Elevation at Levee Station Location**
This option causes the software to use the existing ground elevation at the levee location.

**Maximum Ground Elevation at Cross Section**
This option causes the software to use the maximum ground elevation defined for the cross section geometry.

**Maximum Ground Elevation Along Overbank**
This option causes the software to use the maximum ground elevation defined for the overbank area geometry.

**Fixed Elevation**
This option allows you to specify the elevation for the left and right levees.

### 2.7.6 Assigning Conveyance Obstructions

The Assign Conveyance Obstructions command can automate the extraction of conveyance obstructions from the topographical map.

To assign conveyance obstructions, click River tab > Input panel > Section Assign drop-down > Assign Conveyance Obstructions.

The Assign Conveyance Obstructions dialog box data requirements are nearly identical to the Assign Ineffective Flow Areas dialog box, described on page 2-38.
2.8 Entering Data

Autodesk River and Flood Analysis Module is extremely flexible in how a water surface profile model can be developed. You can enter data into the model using a variety of input methods, including importation of partial HEC-RAS or HEC-2 data files and XYZ coordinate data files. Or, you can develop a model by first importing an existing HEC-RAS or HEC-2 data file and then modifying the data.

2.8.1 Entering Data Interactively

The software has been designed to make developing a water surface profile model easy and flexible by providing a variety of interactive input methods. For example, over seven distinct methods exist for defining a cross section's ground geometry. And any of these methods can be used with any other, allowing complete flexibility while defining the ground geometry.

Most data used to describe a HEC-RAS model is defined using interactive dialog boxes. These dialog boxes allow you to quickly comprehend what data input requirements are needed to define the model.

HEC-RAS data input requirements, methods, and associated dialog boxes are covered in Chapter 3.

2.8.2 Graphical Editing using Grips

AutoCAD allows you to edit selected objects by manipulating grips that are displayed at the defining points of objects.

When grips are enabled, a pickbox appears at the center of the cross-hair cursor, allowing you to immediately select and edit an object. For example, using grips you can perform ground geometry adjustments graphically by simply selecting ground points and dragging them to their new location. Similarly, ineffective flow area adjustments can be performed by simply selecting the polyline that describes the ineffective flow area and adjusting it.

Grips are configured in the AutoCAD Options dialog box.

2.8.3 Importing Existing HEC-RAS Files

The software stores its HEC-RAS information in the drawing file as extended entity data. An external file is not used to store this information. As you define modeling cross sections and associated data, the software stores this information directly in the drawing file.

Many times, however, you may need to use and modify a pre-existing HEC-RAS model which was developed without the software. The software can directly import these models.

Unlike HEC-2, which uses only one file for defining an analysis model, HEC-RAS uses several files for defining a model. However, only the HEC-RAS project file (*.PRJ) has to be selected for importing. The software will use the project file to determine the name of all the other associated HEC-RAS files.
To import a HEC-RAS model:

1. Click River tab > Create Reach Data panel > Import drop-down > Import HEC-RAS.

2. In the Import HEC-RAS Project dialog box, specify whether to use an imported HEC-RAS river alignment.

3. Specify whether to import the data into the current river model or a new river model:
   - If you request that the data be imported into the current river reach, the software allows the imported data to overwrite any matching data which might already be specified in the river reach. For example, if an identical cross section ID is encountered in the external data file as is specified in the current river reach, the software replaces the existing cross section ground geometry with new geometry.
   - If you request that the data be imported into a new river reach, the software will display the Add Reach dialog box, which allows you to specify the new river reach ID for this data to be imported into.

If the drawing does not contain any existing HEC-RAS data, the Import Options are not available.

4. In the Import HEC-RAS Project File dialog box, navigate to the HEC-RAS project file.

After you select a HEC-RAS project file, the software imports the project's HEC-RAS modeling data into the drawing. As the software imports the project, it will report its status at the AutoCAD command line. Data import errors and warnings will be displayed, allowing you to later correct the imported data.

### Linking to a Topographical Map

If the original HEC-RAS model was digitized in real world coordinates, then the imported model will already overlay on the corresponding topographical map. However, if the original model was not developed using real world coordinates, the software allows you to link the imported cross sections and related information to a topographical map. See the section titled Tracing a Cross Section Cut Line on a Surface on page 2-29.

### 2.8.4 Importing an Existing HEC-2 Data File

The software stores its HEC-2 information in the drawing file as extended entity data. An external file is not used to store this information. As you define cross sections and associated data, the software stores this information directly in the drawing file.

When you generate a HEC-2 input data file (see the section titled Model Checking on page 2-47), the software writes out a HEC-2 data file (also called a card file). This file describes the defined HEC-2 model. The HEC-2 analysis engine uses this file to perform the water surface profile analysis.
You may need to use and modify a pre-existing HEC-2 data file that was developed without using the software. The software can directly import these files. To import pre-existing HEC-RAS data files, please refer to the previous section beginning on page 2-41.

To import a HEC-2 data file:

1. Click River tab > Create Reach Data panel > Import drop-down > Import HEC-2.

2. If there is existing HEC-2 data in the drawing, in the Import HEC-2 Data File dialog box, specify whether to import the external data into the current river reach, assign a new river reach to the data being imported, or cancel the import request.

   If you request that the data be imported into the current river reach, the software allows the imported data to overwrite any matching data which might already be specified in the river reach. For example, if an identical cross section ID is encountered in the external data file as is specified in the current river reach, the software replaces the existing cross section ground geometry with new geometry.

   If you request that the data be imported into a new river reach, the software will display the Add Reach dialog box, as shown in the following figure. This dialog box allows you to specify the new river reach ID for this data to be imported into.

3. In the Import HEC-2 dialog box, navigate to the HEC-2 project file.

Cross Section Numbering

When importing a subcritical HEC-2 data file, the cross section identification numbers must be defined in the data file in ascending sequential order. Similarly, when importing a supercritical HEC-2 data file, cross section identification numbers must be defined in descending sequential order. If a cross section identification number is found to be out of order, the software will report this as an error.

Linking to a Surface

The software allows you to link the imported cross sections and related information to a surface, if a surface exists. See the section titled Tracing a Cross Section Cut Line on a Surface on page 2-29.

2.8.5 Importing Survey Cross Section Data

The software can import XYZ or YXZ (Northing-Easting) coordinate data for multiple cross sections. This allows you to import multiple cross sections using a single survey file. This import method allows cross sections to be added to the current river reach, or added to a new river reach.

To import survey cross section data, enter RMS_ImportXYZ at the command line. The software will display the Import Coordinate File dialog box if cross section data is
already contained within the current river reach, allowing you to define how the data file is to be imported.

The following options are available for importing cross sections using coordinate data.

**Create/Update Topographical Map Links**
Causes the cross sections to be drawn on the topographical map, at the XY (or YX) topographical map coordinates specified in the imported file. If this check box is cleared, then only the station-elevation cross section data is imported into the drawing file. By default, this check box is selected.

**Import into Current River Reach**
Imports cross sections into the current river reach. If any of the imported cross sections have a cross section ID that is duplicated in the current river reach, this imported cross section data replaces the existing cross section data for the duplicated cross sections.

**Create a New River Reach**
Imports the cross sections into new river reach. When this option is selected, the software prompts you for a new river reach ID for the cross sections to be imported into.

**Create/Update Topographical Map Links Only**
Imports only the XY (or YX) topographical map coordinates for pre-existing cross sections, thereby linking these existing cross sections to the topographical map. For example, if cross sections already exist in the model and their specified ground geometry is adequate, then this option will only update the cross section locations on the topographical map. The cross section stationing and elevation data will remain the same. Cross sections contained in this file that have no equivalent in the drawing file will be ignored.

This option is especially useful when linking a previously imported HEC-2 model to the topographical map. In this situation, the cross section geometry from the original HEC-2 model is maintained, but the cross sections are then linked to the topographical map.

This option can be used in with recutting the cross section ground geometry from the topographical map, as described in the section titled *Recutting a Cross Section* on page 2-30. This allows you to create a 2D cut line file that the software is to use in cutting cross sections from the topographical map.

After specifying how the data is to be imported, the software displays a file selection dialog box for importing the cross section coordinate data file.

If there are no cross sections defined for the current river reach, rather than displaying the Import Coordinate File dialog box, the software displays the Create Topographical Map Links dialog box, where you specify whether to create topographical map links.

**Multiple Cross Section Data File Format**

For the software to be able to identify that the file being imported is a multiple cross section XYZ or YXZ (Northing-Easting) coordinate data file, the file must be formatted properly.
Follow these guidelines when developing a coordinate data file:

1. The first line in the multiple cross section data file must contain the keyword XYZ (or YXZ) by itself.

2. The second and third lines in the file denote the unit base of the data contained in the file. These lines can have the keyword Imperial or Metric. The second line in the file denotes the XY coordinate unit base. The third line denotes the elevation (Z) coordinate unit base. If the unit base for either the XY or Z data is different than that of the drawing file unit base (see the section titled Configure Elevation Precision on page 2-88), then the imported data is converted to the drawing file unit base.

3. The fourth line in the file defines the starting horizontal station value for all of the cross sections being imported. The starting horizontal station value cannot be negative. If this line is left blank, a starting horizontal station of 0.0 is assumed.

4. The fifth line in the file is used to define an elevation datum adjustment value for all of the cross sections being imported. This adjustment value allows you to adjust the elevation of the coordinate data. If this line is left blank, an elevation adjustment of 0.0 is assumed.

5. The sixth line defines the ID of the first cross section contained in the file. This line should start with XS, followed by a space, and then the cross section ID number. The cross section ID number should not be longer than 6 characters, including the decimal point if one is defined.

6. The remaining lines in the file correspond to the X, Y, and Z coordinates (or Y, X, and Z coordinates) of a single 3D ground point for the cross section. Spaces, commas, and/or tabs can be used to delimit the coordinate values of each point. Negative or positive coordinate values are allowed.

7. To mark the start of another cross section, a blank line must be inserted which is then followed by a cross section ID line (as described previously).

The software uses the Pythagorean Theorem to determine the absolute distance between adjacent ground point stations using the specified X and Y coordinate values. This distance is accumulated, being added to the specified starting horizontal station value to determine each ground point's resultant stationing value. The following figure illustrates that the surveyed ground points do not need to reside along a straight line. However, these surveyed points should form a line perpendicular to the stream flow. Each ground point's Z coordinate value is added to the specified elevation datum adjustment value to determine the resulting elevation.
2.8.6 Data Entry Checking

Data entry checking is performed by a model checker that is integrated into the software. Data checking is performed both during actual data input and during preparation of the intermediary input data file used during the analysis. Many common data entry errors are discovered immediately. Additional error checking is performed during the analysis.

If an error is detected during data entry within a dialog box, the software describes the error in a dialog box, enabling you to correct the faulty data. Note that for some dialog box entries, the message displayed is only a warning or suggestion. The model checker allows you to use the value, as opposed to errors, which must be corrected before you click OK.

2.9 Model Analysis

Once you have defined a HEC-RAS water surface profile model, you are ready to perform an analysis. The following sections describe how to perform an analysis.

2.9.1 Defining Analysis Options

The Analysis Options dialog box provides a number of options to control how the analysis is to be performed.

To specify the analysis options, click River tab > Analysis panel > Analysis Options.
2.9.2 Performing a HEC-RAS Analysis

After the HEC-RAS model has been defined, click River tab > Analysis panel > Compute Analysis.

The software checks the model for data entry errors, builds the intermediary input data file for the HEC-RAS analysis engine to run, and then executes the HEC-RAS analysis engine. If a problem is detected in the defined model data, the software displays a message detailing the error.

2.9.3 Model Checking

When the software generates the intermediary input data file from the defined input model, it reports its status at the command line. Modeling errors and warnings are displayed, allowing you to correct the input data.

**Errors and Warnings**

If an error is reported during the creation of the intermediary input data file, you must correct the model before the analysis can be performed. If a warning is reported, the analysis can be performed. The software reports a warning when it has determined that there may be difficulty in performing a water surface profile analysis with the defined model.

**Missing Input Data**

While generating the intermediary input data file, if the software determines that some input data is missing, it displays an Alert dialog box that describes the omission and identifies which command should be issued to insert the missing input data.

2.9.4 Exporting a HEC-RAS Project

The software can import and export HEC-RAS project data files (i.e., project, geometry, flow, and plan files) using the standard US Army Corp file format.

To export the current river model to a HEC-RAS project data file,

1. Click River tab > Create Reach Data panel > Export HEC-RAS Project.

2. In the Export HEC-RAS Project dialog box, specify a name and location for the HEC-RAS project file.

The software exports the standard HEC-RAS project data files with the filename extensions of PRJ (project file), G01 (geometry file), F01 (flow file), and P01 (plan file).

2.10 Displaying Analysis Results

After running the water surface profile analysis for the current river reach, the software can display the analysis results. The software can display a summary of the analysis results, as well as displaying the graphical results on the cross section grids, profile
grids, and surface. The following sections describe in detail how to display these results.

2.10.1 River Scenario Analyzer

Autodesk River and Flood Analysis Module provides a powerful River Scenario Analyzer that allows you to view HEC-RAS output results. These results can be viewed in a cross section table view, profile table view, and a profile plot view. In addition, results from different models can be compared.

2.10.1.1 Profile Summary Plot

To display a profile summary plot, click River tab > Output panel > Results Viewer drop-down > Profile Summary Plot.

The software opens the River Scenario Analyzer, which displays the water surface elevation profile plot.

You can customize what is displayed using the property sheet immediately to the left of the profile plot.

2.10.1.2 General Profile Plot

The River Scenario Analyzer can plot a generalized profile plot, allowing you to view numerous variables along the river profile.

To display the general profile plot:

1. Click River tab > Output panel > Results Viewer drop-down > Profile Summary Plot.
2. In the River Scenario Analyzer, click on the General Profile Plot icon from the Scenario Analyzer toolbar.

You can change the displayed variables using the Std. Plots menu in the River Scenario Analyzer.

Any input or output variable can be selected for plotting. From the property sheet, click the browse [...] button adjacent to the Y Variable(s) entry. The Y-Axis Variables dialog box is displayed, allowing you to select the appropriate variables to plot.

2.10.1.3 Rating Curve Plot

The Scenario Analyzer can plot a rating curve, allowing you to view numerous variables at a cross section.

To plot the rating curve:

1. Click River tab > Output panel > Results Viewer drop-down > Profile Summary Plot.
2. In the River Scenario Analyzer, click on the Rating Curve Plot icon.
You can change the variables displayed on the rating curve. From the property sheet, click the browse [...] button adjacent to Y Variable(s) entry. The Y-Axis Variables dialog box is displayed, allowing you to select the appropriate variables to plot.

### 2.10.1.4 Profile Tables

To display a profile table, click River tab > Output panel > Results Viewer > Profile Tables. The software starts up the River Scenario Analyzer and displays the water surface profile results table.

Several different pre-defined profile tables are available. The Std. Tables menu in the River Scenario Analyzer lists the available profile tables.

### 2.10.1.5 Custom Profile Tables

You can generate custom profile tables containing any input or output variable.

In the River Scenario Analyzer, select User Tables > Define Table. The Define Table dialog box is displayed, allowing you to select the variables to be included in the current table. Decimal precision and other options are available, on a variable by variable basis.

#### Saving and Managing Custom Tables

Once a custom profile table has been created, its definition can be saved for later reuse. From the River Scenario Analyzer, select User Tables > Save Table. The Save Table dialog box is displayed, allowing you to define the table name and corresponding table description for later reuse.

Once the custom profile table has been defined, it is listed at the bottom of the User Tables menu.

To rename or remove a previously defined custom profile table, select User Tables > Manage Tables. The Manage Tables dialog box is displayed, allowing you to make necessary table name change or to delete a table.

If a custom profile table is deleted, it is removed from the User Tables menu.

### 2.10.1.6 Cross Section Tables

To display a cross section table, click River tab > Output panel > Results Viewer > Cross Section Tables. The software starts up the River Scenario Analyzer and displays the cross section results table for the current cross section.

Several different pre-defined cross section tables are available. The Tables menu in the River Scenario Analyzer lists the available cross section tables. Note that cross section tables that are not available are grayed out in the menu.
2.10.1.7 **Switching Summary Views**

The River Scenario Analyzer allows you to switch between various summary views (i.e., profile summary plot, profile table, and cross section table).

Use the View menu to switch between the summary views. Alternatively, on the left navigation panel, you can click on the view to be displayed.

2.10.1.8 **Outputting Summary Results**

To output the results displayed in the Scenario Analyzer to a printer, select File > Print. To copy the results to the clipboard for pasting into another Windows application (e.g., Microsoft Excel, Microsoft Word, etc.), select either Edit > Copy Selected Cell(s) or Edit > Copy Table.

2.10.1.9 **Switching Units**

To switch units bases, use the Options menu. The River Scenario Analyzer can display results in both English and metric (SI) units.

2.10.1.10 **Reloading the Analysis Results**

The River Scenario Analyzer can continue to run while you make modifications to the model and re-run the analysis. Then, to reload the new analysis results into the River Scenario Analyzer, either select File > Reload Data or press Ctrl+R.

2.10.2 **Displaying Cross Section Results**

The software can quickly plot the analysis results on the cross section views in the Autodesk AutoCAD Civil 3D drawing. Various options are provided to meet various reporting requirements.

To display the graphical results on the current river reach cross section grids, click River tab > Output panel > Section Results drop-down > Add Section Results.

The Cross Section Results dialog box allows you to specify exactly which results will be displayed on the cross section views. If the appropriate check boxes are selected, the following results will be displayed on the cross section grids for the current river reach:

- Flow discharge
- Known water surface
- Computed water surface
- Critical water surface
- Energy grade line

The results are added to the cross sections views on a profile-by-profile basis. If more than one profile's results are to be displayed, you must select more than one profile in the profile list box.
In addition, each of these cross section graphical results has a corresponding Options button, allowing you to specify the color, linetype, and legend text for the results. These options apply only to the currently highlighted profile in the list box. Different display options can be set for each profile.

### Removing the Cross Section Results

Click Erase to remove all plotted graphical results from the cross section views.

### 2.10.3 Displaying Profile Results

The software can quickly generate profile plots along the river. Various options are provided, to meet various reporting requirements.

The profile grid displays the natural channel invert, special bridge/culvert/roadway symbols, left and right overbanks, computed water surface, critical water surface, energy grade line, and known water surface elevation. See the section titled *Displaying Profile Results on page 2-51* for information on how to specify how the analysis results are to be displayed on the profile grids.

#### 2.10.3.1 Profile Views

Once the cross section geometry has been defined for a model, you can define profile views for the software to use in displaying the water surface profile results. Profile views can be added to the drawing either before or after the analysis has been performed. However, water surface profile results can only be displayed on the defined profile grids if a water surface profile analysis has been performed. The profile view horizontal axis denotes the river stationing (in feet or meters) of the defined cross sections. The cross section river stationing is determined by adding together the channel reach lengths defined for each cross section. The accumulated channel reach lengths are used as river stationing values for the profile view horizontal axis.

For small models, a single profile view can be used to display the entire water surface profile. However, for larger models, where the reach of river being studied is longer than the typical length of a profile view, multiple profile grids may be specified to display the water surface profile results in manageably sized portions.

#### 2.10.3.2 Displaying Profile Results

To display the graphical results on the current river reach profile views, click River tab > Output panel > Profile Views > Add Profile Results.

The Add Profile Results dialog box provides numerous options for plotting the profile results.

Profile views must exist before any graphical results can be displayed. Profile views can be added to the drawing either before or after the analysis has been performed. For information on how to create profile views, see the section titled *Creating Multiple Profile Views*. 
The Add Profile Results dialog box allows you to specify which results to display on the profile views. If the appropriate check boxes are selected, the following results will be displayed on the profile views for the current river reach:

- Computed water surface
- Critical water surface
- Energy grade line

You can select profile results to plot, on a profile-by-profile basis, by checking the profiles of interest in the selection list. For each selected profile, you can control which results to be plotted.

In addition, each of these profile view graphical results has an Options button, allowing you to specify the color, linetype, legend text, and data point symbol for the results. Note that these options apply only to the currently highlighted profile in the list box. Different display options can be set for each profile.

**Removing the Profile Results**

Click Erase to remove all plotted graphical results from the profile views.

### 2.10.3.3 Creating Multiple Profile Views

To create multiple profile views for the current river reach, click River tab > Output panel > Profile Views > Create Profile Views.

In the Create Profile Views dialog box, specify the following parameters:

**Number of Grids (optional)**

Specifies how many profile views will be generated. If left blank, enough profile views will be created to display data for the entire river reach length, which is determined by adding the reach lengths of all cross sections. Grid generation will stop when this channel reach length is attained, even if a larger number of views has been specified in this entry.

**Starting Grid ID**

Specifies the unique ID of the first profile view to be generated. This value defaults to the number following the last existing profile view’s ID.

**Grid ID Increment**

Specifies the increment to be added to the starting grid ID to determine the IDs of the second and subsequent profile views generated. For each new grid, if any profile view with the same ID already exists in the current river reach, the increment will be added again until a unique ID is found.

**Starting Station**

Defines the starting river station (in feet or meters) of the first profile view’s horizontal axis. This entry must be positive, and cannot be left blank.
**Axis Length**
Defines the length (in feet or meters) of each profile view’s horizontal stationing axis. This entry must be positive. This length will be added to the starting (downstream) station to determine the ending (upstream) station of each profile view’s horizontal axis. For the second and subsequent profile views, each view’s starting station will equal the previous view’s ending station.

If the Number of Grids entry is left blank, a longer axis length will generate fewer, but larger, profile views, and a shorter length will produce more, smaller, profile views.

**Starting Elevation (optional)**
Defines the starting (lowest) elevation (in feet or meters) for each generated profile view’s vertical axis. This entry can be positive or negative.

If this entry is left blank, the software determines this elevation for each profile view by finding the minimum elevation of all data to be displayed on the profile view.

**Axis Height (optional)**
Defines the height (in feet or meters) of each profile view’s vertical elevation axis. This entry must be positive in value. This height will be added to the starting elevation to determine the ending (highest) elevation of the profile view vertical axis.

If this entry is left blank, the software determines this height for each profile view by finding the height of all data to be displayed on the profile view.

**Downstream XS Station (optional)**
Defines the river station at which the most downstream cross section is located. This value defaults to 0.0, but you may start the profile reach at any station. This entry may not be changed after a profile view has been added to the current river reach.

**Profile Geometry Data**
This section allows you to select which profile data will be displayed on the profile views. By default, all non-computed data is displayed. Computed results, such as the hydraulic grade line, must be displayed using the Profile Results dialog box after the water surface profile analysis is run. See the section titled *Displaying Profile Results* on page 2-51 for more information.

If the appropriate check boxes are selected, the following data will be displayed on the profile view(s) being added or edited:

- Natural channel invert
- Left and right overbanks
- Bridge and culvert invert, low chord, and roadway elevations
- Cross section IDs

Each profile grid cross section data item has a corresponding Options button, allowing you to specify the color, linetype, legend text, and data point symbol to be used.
2.10.3.4 Deleting Profile Views

To delete one or more profile views, click River tab > Output panel > Profile Views > Delete Profile Views.

Manual Erasing

The AutoCAD Erase command can be used to delete any of the Autodesk River and Flood Analysis Module entity data.

2.10.3.5 Editing a Profile View

The Edit Profile View dialog box allows you to edit an existing profile view’s attributes.

To edit a profile view, enter RMS_ProfEdit on the command line.

The Edit Profile View dialog box is often used to manually edit an existing profile view to turn on and off profile related data (such as ground geometry, roadway geometry, and water surface profile elevations).

2.10.3.6 Refreshing Profile View Data

After modifying geometry data to cross sections, such as adding a bridge or culvert structure, you might want to display this modified data on existing profile views. (Profile views are not automatically updated.)

To refresh profile view, click River tab > Output panel > Profile Views > Update Profile View Data.

2.10.3.7 Panning and Zooming to a Profile View

The Zoom to Profile View dialog box allows you to select and view a profile view.

To zoom to a profile view, click River tab > Navigate panel > Zoom to Profile View.

Select a profile view from the Zoom to Profile View dialog box to display a profile view.

Navigating Among Profile Views

To zoom to previous or next profile views, enter either RMS_ProfPrev or RMS_ProfNext on the command line.

2.10.3.8 Resizing Profile Views

The software can automatically resize the grid to the extents of the profile view’s data.

To resize profile views, click River tab > Output panel > Profile Views > Resize Profile Views.
The Configure Profile Views dialog box (see the section titled Configure Profile Views on page 2-84) provides configuration settings controlling how grid axes are to be resized.

### 2.10.4 Displaying Floodplain Map Results

The software can quickly generate detailed floodplain maps from the computed model results. Various options are provided, to meet various floodplain mapping requirements.

#### 2.10.4.1 Floodplain Mapping Options

To create a floodplain map on the topographical map, click River tab > Output panel > Flood Map drop-down > Add Floodplain Map.

This displays the Floodplain Map Results dialog box, which allows you to display the water surface profile on the surface on a profile-by-profile basis. If more than one water surface profile is to be displayed, you must select more than one profile in the profile list box. If no profiles were selected when you click OK, nothing will be plotted on the surface.

The following results may be generated for the currently selected profile. These results have individual settings for each profile, so selecting them for one profile does not select it in any other profile. Selecting another profile in the list box displays the current settings for that profile only.

**Intersected Edge of Water**

Causes an interpolated edge of water to be drawn on the surface. The software will interpolate the edge of water between cross sections by building a digital terrain model (DTM) of the ground topography and of the computed water surface elevation, and then intersecting these two surfaces with each other to determine a precise edge of water.

Click Options to display the Intersected Edge of Water Options dialog box, which presents various options for drawing the intersected edge of water. See the section titled Intersected Edge of Water Option on page 2-58 for more information on this floodplain mapping option.

**Straight Line Edge of Water**

Causes a straight line edge of water to be drawn on the surface between cross sections. The edge of water will be drawn using straight line segments between cross sections (i.e., the edge of water is not interpolated between cross sections) using the reported left and right edge of water from the simulation results.

Click Options to display the Straight Line Edge of Water Options dialog box, which presents various options for drawing the straight line edge of water. See the section titled Straight Line Edge of Water Option on page 2-59 for more information on this floodplain mapping option.

**Shallow Flooded Areas**

This option is used when plotting the intersected edge of water floodplain map, and causes the software to draw where the flood depth is less than that of the specified shallow depth value.
Click Options to display the Shallow Flooded Areas Options dialog box, which presents various options for drawing the shallow flooded areas as well as what the shallow depth value should be.

**Depth**
Specifies the depth, in feet or meters, for which shallow flooding is displayed. For example, a value of 1 shows all areas of the water surface where the depth is less than or equal to 1 foot (or meter). A negative depth value shows all areas outside the water surface that would be flooded should the current computed water surface rise by that amount.

**Flood Elevation Contours (BFE)**
This option is used when plotting the intersected edge of water floodplain map, and causes the software to draw base flood elevation (BFE) contours.

Click Options to display the Flood Elevation Contours Options dialog box, which presents various options for drawing the BFE contours as well as to specify the BFE contour interval.

**Contour Interval**
Specifies the interval at which contours of elevation are generated. For example, a value of 1 generates 1 foot (or meter) contours.

**Flood Depth Contours**
This option is used when plotting the intersected edge of water floodplain map, and causes the software to draw on the topographical map the flood depth contours, representing the depth of the flood.

Click Options to display the Flood Depth Contours Options dialog box, which presents various options for drawing the depth contours as well as to specify the depth contour interval.

**Depth Interval**
Specifies the interval at which contours of flow depth are generated. For example, a value of 1 generates 1 foot (or meter) contours.

**Flood Uncertainty Band**
This option is used when plotting the intersected edge of water floodplain map, and causes the software to draw the amount of uncertainty in the flood results based upon the amount of uncertainty in the ground terrain elevation data.

Click Options to display the Flood Uncertainty Band Options dialog box, which presents various options for drawing the uncertainty band as well as to specify the uncertainty in the ground terrain elevation data.

**Terrain Error**
Specifies the amount of error to be plotted on the floodplain map in either elevation or percent error. For example, specifying an elevation value of 0.3 shows two uncertainty lines—corresponding to ± 0.3 ft (or m).

**Topographical Map Ground Surface**
This data is used when plotting the intersected edge of water floodplain map.
Click Configure Layers to display the Configure Elevation Layers dialog box, which allows you to specify the AutoCAD layers and/or Autodesk AutoCAD Civil 3D surfaces that contain elevation data.

If ground geometry information has not been defined, the software will not be able to generate the interpolated edge of water results.

For additional information, see the section titled Configure Elevation Sources on page 2-84.

**Clipping Polygon**
This option is used when plotting the intersected edge of water floodplain map, and allows you to select the type of clipping polygon to use. This option is used to limit the extent of the drawing to be considered when performing the terrain surface intersection with the computed water surface results—thereby speeding up the floodplain mapping process. See the section titled Floodplain Mapping Problems on page 2-60 for more information on this option.

**Legend**
Specifies if a legend will be displayed on the surface. The legend identifies the floodplain map results plotted on the topographical map. The legend position on the topographical map is specified by the X, Y coordinate entries. Click Pick to pick the legend position directly from the surface. To specify a text height for the legend, enter a value in the Text Height field. If this entry is left blank, the software will use the text height specified in the Configure Topographical Map dialog box (see the section titled Configure Topographical Map on page 2-87).

Even if this option is selected, individual legends may be turned off by clearing the legend option within each Options dialog box.

**Erase Previous Results**
Causes any previously plotted results to be deleted from the surface when plotting the new floodplain map results.

**Regenerate Ground Surface**
This option is used when plotting the intersected edge of water floodplain map, and causes the software to regenerate the ground surface DTM (Digital Terrain Model) when the floodplain map is plotted. By default, this check box is cleared, since the ground surface rarely changes, in order to speed up generation of the ground surface DTM. However, if the ground terrain does change—such as when enabling a different set of drawing layers that represent post development ground terrain—then this check box should be selected.

**Restrict Mapping to Model Results**
This option is used when plotting the intersected edge of water floodplain map, and causes the software to make certain that any flooded areas contained outside of the main channel area are hydraulically connected. Therefore, depressions (or ponded areas) outside of the river’s flooded area will not be filled-in by the software when the floodplain is plotted—unless the outer flooded area is somehow connected with the river’s flooded area.
Generate 3D Grid of Ground Surface
This option is used when plotting the intersected edge of water floodplain map, and causes the software to construct a 3D grid of the ground terrain from the specified elevation data. This is useful in troubleshooting a floodplain map that does not appear correct. By examining the constructed ground terrain 3D grid, you can then determine what elevation data is causing problems.

Generate 3D Results
This option is used when plotting the intersected edge of water floodplain map, and causes the software to construct 3D polylines for the edge of water polyline that follows the terrain surface where it intersects. This allows the topographical map view to be rotated and the edge of water boundary polyline will shown to intersect with the terrain.

Note that by default, this option is disabled and a 2D polyline will be generated at an elevation of 0.0 since it takes longer to compute an intersecting 3D polyline.

Generate GIS Coverages
Causes the software to generate shapefiles of the floodplain map results, as well as of the defined input data. These shapefiles are stored in a subdirectory that is created in the directory that contains the drawing file, with the same name as the drawing file.

Click Define to display the Define GIS Coverages dialog box, which allows you to define specifically what input and output data should be written to GIS coverage shapefiles.

2.10.4.2 Intersected Edge of Water Option
The Intersected Edge of Water option on the Floodplain Map Results dialog box causes an interpolated line representing the edge of water to be drawn on the surface. The software interpolates the edge of water between cross sections by building a digital terrain model (DTM) of the ground topography and of the computed water surface elevation, and then intersecting these two surfaces with each other to determine a precise edge of water.

The intersected edge of water may be drawn in one of several ways using the settings in the Intersected Edge of Water Options dialog box. To display the dialog box, click the Options button adjacent to the Intersected Edge of Water option on the Floodplain Map Results dialog box.

The following options are available for drawing the intersected edge of water on the surface.

Fill Type
An interpolated edge of water is generated by one of the following methods:

None
An interpolated edge of water is displayed using an unfilled boundary polyline. This is the fastest method for generating the intersected edge of water.
Temporary File
The interpolated edge of water boundary polyline is filled with the polyline color. This fill is temporary, and will be erased the next time the viewport is redrawn. However, this area may be filled at any later time by entering RMS_FPMTopoFill on the command line.

Hatch
The interpolated edge of water boundary polyline is filled with a hatch pattern, which is not erased when the viewport is redrawn. Depending on the hatch options selected, generating the hatch may take excessive amounts of time and drawing space. If this turns out to be the case, press Esc to halt the hatch generation.

Hatch Options
Displays the AutoCAD Hatch and Gradient dialog box, allowing selection of a hatch pattern, scale, and rotation angle.

Intersection Step Size
Specifies the detail, in drawing units, at which all water surface intersection results will be generated. For example, to calculate the edge of water every foot (or meter), set this entry to 1.

Small step sizes (1 or less) will generate very complex contours, which can take excessive amounts of time and drawing space. On most surfaces, a step size of 10 or 20 drawing units will provide sufficient detail without compromising computing time or storage space.

Line Options
This section allows you to specify color, legend, and linetype options for the simple water surface. These options apply only to the current profile.

Global Width
Specifies line thickness for the drawn edge of water polyline.

2.10.4.3 Straight Line Edge of Water Option
The Straight Line Edge of Water option from the Floodplain Map Results dialog box causes a straight line representing the edge of water to be drawn on the surface. The edge of water will be drawn using straight line segments between cross sections (i.e., the edge of water is not interpolated between cross sections) using the reported left and right edge of water from the simulation results.

The edge of water may be drawn in one of several ways using the settings provided in the Straight Line Edge of Water Options dialog box. To display this dialog box, click the Options button adjacent to the Straight Line Edge of Water option from on the Floodplain Map Results dialog box.
The following options are available for drawing the straight line edge of water on the surface.

**Type**
This list defines the type of straight line edge of water to be plotted.

- **2D Polyline**
  A 2D polyline is drawn around the profile's water surface edges between each cross section in the specified color and linetype.

- **3D Polyline**
  A 3D polyline is drawn around the profile's water surface edges between each cross section in the specified color.

- **3D Mesh**
  A 3D polyface mesh is drawn using the specified segment size and color.

- **Shaded Mesh**
  The 3D mesh is shaded using the AutoCAD SHADE command. The specified segment size and color are used.

**Segment Size**
Specifies the surface distance between segments of the 3D polyface mesh generated using the 3D or shaded mesh options above. The smaller the size, the more detailed the mesh (and the longer it takes to generate). If this entry is left blank, or is greater than the distance from one cross section to the next, only one mesh segment will be generated between each cross section.

**Line Options**
This section allows you to specify color, legend, and linetype options for the simple water surface. Note that these options apply only to the current profile.

**Global Width**
Specifies line thickness for the drawn edge of water polyline. This option is only available for the 2D Polyline edge of water option.

---

### 2.10.4.4 Floodplain Mapping Problems

When the intersected edge of water option is used to create the water floodplain map, the software will limit the area that will be used to extract ground terrain data from the specified elevation layers when it builds its digital terrain model (DTM). This is done to limit the amount of time required to develop a DTM for the area being modeled. Otherwise, the software would extract all of the data from the specified elevation layers—thereby taking a great deal of time while it developed the DTM.

To limit the area to be used to extract ground terrain data, the software creates a bounding (or clipping) polygon corresponding to the defined river cross sections. Any ground terrain data outside of this bounding polygon is ignored and not included in developing the DTM.
The boundary polygon is constructed by connecting the leftmost edge of all cross sections with a polyline, the rightmost edge of all cross sections with a polyline, and then capping these two polylines with each other using a straight line. Any ground terrain data outside of this boundary polygon is ignored and not included in developing the DTM. This is done to limit the amount of time required to develop a DTM for the area being modeled. Otherwise, the software would extract all of the data from the specified elevation layers—thereby taking a great deal of time while it developed the DTM.

Flooded areas that extend beyond this bounding polygon will be cut off, and will appear truncated with a stair-step edge. This stair-step edge will correspond the specified step size. Note that this may cause problems when generating the interpolated edge of water at sharp bends in the river where the bounding polygon does not extend out far enough to include the area where the water surface intersects the terrain model. In these situations, additional cross sections may need to be inserted and/or the existing cross sections extended.

**False Dams and Insufficient Terrain Data Problems**

If the floodplain mapping skips parts of the river channel (see the following figure) or is disjointed (breaks in the flooding), this is generally due to a false dam being created when the digital terrain model (DTM) is created from the provided ground terrain data. Generally this occurs with a sparse TIN point data set, where there is not enough data points within the channel to accurately depict the channel geometry. Inserting additional user-interpreted TIN data points can quickly correct this problem.
A false dam occurs during the floodplain delineation tinning process when a TIN edge (one side of the TIN triangle) straddles the natural channel, forming a dam across the channel. A TIN is constructed by triangulating the vertices that define the ground terrain. This vertex data is extracted from whatever 3D data (contours, polylines, points, existing TIN vertices, etc.) are defined as layer information within the Configure Elevation Layer dialog box (section titled Configure Elevation Sources on page 2-84).

The software connects the vertices with a series of edges to form a network of triangles to represent the terrain. The resulting triangulation satisfies the Delauney criterion. The Delauney criterion ensures that no vertices lie within the interior of any circumcircles of the TIN triangles (see the following figure).

**Figure 2.10.4.4.2** A “false dam” can cause the floodplain map to skip parts of the river channel

**Figure 2.10.4.4.3** Two adjacent TIN triangles which (a) violate and (b) satisfies the Delauney criterion
As the tinning triangulation process proceeds, adjacent triangles are compared to see if they satisfy the Delauney criterion. If necessary, the adjacent edge of the two triangles is swapped (the diagonal of the quadrilateral defined by the two triangles is changed to the other two vertices) in order to satisfy the Delauney criterion. If the Delauney criterion is satisfied everywhere on the TIN, the minimum interior angle of all the triangles is maximized. The result is that long thin triangles are avoided as much as possible.

If there is not enough 3D data contained within the channel bottom, a false dam can be created by the software by using the Delauney criteria. If this occurs, inserting additional points where these problems occur can quickly resolve these issues. However, after adding additional ground terrain data, turn on the Regenerate Ground Terrain option in the Floodplain Map Results dialog box (page 2-57) to regenerate the ground surface DTM.

2.10.4.5 Removing the Floodplain Mapping Results

To remove all floodplain map results from the surface, click Erase on the Floodplain Map Results dialog box.

2.10.5 Tracking Elevations and Depths

Water surface elevations, depths, and ground terrain elevations may be tracked by clicking River tab > Output panel > Flood Map drop-down > Track Flood Surface. This command displays the Track Flood Surface dialog box, from which you may select the specific 3D surface to track. After selecting a 3D surface, moving the cursor over the topographical map area will display the selected depth or elevation on the AutoCAD command line.

Surfaces are only available for tracking after their corresponding results have been generated and displayed on the surface. Available surfaces include:

- The natural ground surface elevation, read from data on configured topographical map elevation layers.
- The water surface elevation for a particular profile.
- The water depth for a particular profile. Negative depths indicate areas outside the edge of water, above the computed water surface (commonly called freeboard).

2.11 Bridge Scour

Bridge scour is the removal of sediment such as sand and rocks from around bridge abutments or piers. Scour, caused by swiftly moving water, can scoop out scour holes, compromising the integrity of the bridge.

Bridge scour is one of the three main causes of bridge failure. It has been estimated that 60% of all bridge failures result from it. It is the most common cause of highway bridge failure in the United States, where 46 of 86 major bridge failures resulted from scour near piers from 1961 to 1976.
Water normally flows faster around bridge piers and abutments, making them susceptible to local scour effects. At bridge openings, contraction scour can occur when water accelerates as it flows through an opening that is narrower than the channel upstream from the bridge. Degradation scour occurs both upstream and downstream from a bridge over large areas. Over long periods of time, this can result in lowering of the stream bed.

Stream channel instability resulting in river erosion and changing angles-of-attack can contribute to bridge scour. Debris can also have a substantial impact on bridge scour in several ways. A build-up of material can reduce the size of the waterway under a bridge causing contraction scour in the channel. A build-up of debris on the abutment can increase the obstruction area and increase local scour. Debris can deflect the water flow, changing the angle of attack, increasing local scour. Debris might also shift the entire channel around the bridge causing increased water flow and scour in another location.

During a flooding event, although the foundations of a bridge might not suffer damage, the fill behind abutments may scour. This type of damage typically occurs with single-span bridges with vertical wall abutments.

**Autodesk River and Flood Analysis Module Bridge Scour Capabilities**

The software analyzes a bridge opening for scour and creates a “ready-to-submit” FHWA-accepted bridge scour engineering report in just minutes. The scour report includes all input data, equations, variables, intermediate results, final analysis results, and analysis narrative—along with placing the computed scour results directly on the bridge within the AutoCAD drawing.
The scour analysis can account for:

- Bridge skew
- Pier skew
- Pier shape
- Sloping and skewed abutments
- Soil bed material
- Armoring of bridge abutments
- Armoring of bridge piers
- Contraction, pier, and abutment scour effects

### General Modeling Guidelines

The computation of scour at bridges within the software is based upon the methods outlined in Federal Highway Administration's Hydraulic Engineering Circular No. 18 (FHWA, 2001). Before performing a bridge scour analysis with the software, you should thoroughly review the procedures outlined in the Hydraulic Engineering Circular No. 18 (HEC 18) report.

To perform a bridge scour analysis, you must first develop a hydraulic model of the river reach containing the bridge to be analyzed. This model should include several cross sections downstream from the bridge, such that any user-defined downstream boundary condition does not affect the hydraulic results inside and just upstream of the bridge. The model should also include several cross sections upstream of the bridge, in order to evaluate the long term effects of the bridge on the water surface profile upstream.

The hydraulic modeling of the bridge should be based on standard, accepted bridge modeling procedures. If observed data are available, the model should be calibrated to the fullest extent possible. Once the hydraulic model has been calibrated (if possible), you can enter the design events to be used for the scour analysis. In general, the design event for a scour analysis is usually the 100 year (1 percent chance) event. In addition to this event, it is recommended that a 500 year (0.2 percent chance) event also be used in order to evaluate the bridge foundation under a major flood.

In addition to properly defining the bridge model, a flow distribution of the channel and overbanks is required in order that additional analysis results are available for the scour computations. The flow distribution analysis provides additional results for each flow slice:

- Percentage of flow
- Flow area
- Wetted perimeter
- Conveyance
- Hydraulic depth
- Average velocity
You can control the flow distribution and the number of flow slices at a cross section. The number of flow slices for the left overbank, main channel, and right overbank can be specified, with a maximum number of 45 flow slices defined at a cross section.

A flow distribution must be defined for these cross sections when performing a bridge scour analysis:

- Bridge opening downstream face cross section
- Bridge opening upstream face cross section
- Approach cross section (i.e., the next cross section upstream of the bridge, located at a distance such that the flow lines are assumed parallel and the flow has not yet begun to contract due to the bridge constriction)

Flow distributions can be specified at additional cross sections, but only the above cross sections’ flow distributions will be used by the bridge scour computations. These flow distributions provide detailed estimates of the depth and velocity within the cross section, which are required for the scour computations. Once the flow distributions have been specified, a HEC-RAS analysis must be performed in order for the flow distribution results to be available for the scour computations.

After performing the HEC-RAS water surface profile computations for the design events (and computing the flow distribution output), the bridge scour can then be evaluated. The total scour at a bridge opening roadway crossing is comprised of these components:

- Long-term aggradation and degradation
- Contraction scour
- Localized scour at piers
- Localized scour at abutments

The scour computations provided by the software allow you to compute contraction scour and local scour at piers and abutments. The software does not compute long-term aggradation and degradation. Long term aggradation and degradation should be evaluated prior to performing the bridge opening scour analysis. Procedures for performing long-term aggradation and degradation analyses are outlined in the HEC 18 report.

### Analyzing Multiple Opening Roadway Crossings

The software analyzes a single opening bridge for scour. However, if a multiple opening roadway crossing needs to be analyzed for scour, you must break the multiple opening model into separate models, so that scour can be computed for each opening separately. The amount of flow through each bridge opening can be determined, and then each bridge opening can be analyzed separately for the contributing flow.

#### 2.11.1 Bridge Scour Calculator

Bridge opening scour is computed by using the Bridge Scour Calculator
Click River tab > Analysis panel > Bridge Scour Calculator to display the Bridge Scour Calculator dialog box. This dialog box allows you to select the river reach, corresponding bridge opening cross section, and profile to analyze for scour. You can restrict the types of scour analyses to perform, if required.

To enter data into the Bridge Scour Calculator, select the appropriate tabs at the top of the dialog box. Each tab provides additional data fields to define the input data necessary to perform a scour analysis of the bridge opening. Most of the input data fields are already populated with the results from HEC-RAS. After you enter the scour data, select the Analysis Results tab to view the results of the scour analysis.

### 2.11.2 Contraction Scour

Contraction scour occurs when the flow area of a stream is reduced by a natural contraction or a bridge constricting the flow. At a bridge crossing, many factors can contribute to the occurrence of contraction scour. These factors may include:

- The main channel naturally contracts as it approaches the bridge opening
- The road embankments at the approach to the bridge cause all or a portion of the overbank flow to be forced into the main channel
- The bridge abutments are projecting into the main channel; the bridge piers are blocking a significant portion of the flow area
- A drop in the downstream tailwater which causes increased velocities inside the bridge

There are two forms of contraction scour that can occur depending on how much bed material is already being transported upstream of the bridge contraction reach—defined as *live-bed contraction scour* and *clear-water contraction scour*. Live-bed contraction scour occurs when bed material is already being transported into the contracted bridge section from upstream of the approach section (before the contraction reach). Clear-water contraction scour occurs when the bed material sediment transport in the uncontracted approach section is negligible or less than the carrying capacity of the flow.
Contraction Scour Conditions

Four conditions (cases) of contraction scour are commonly encountered:

**Case 1**
Involves overbank flow on a floodplain being forced back to the main channel by the approaches to the bridge. Case 1 conditions include:

- The river channel width becomes narrower either due to the bridge abutments projecting into the channel or the bridge being located at a narrowing reach of the river.
- No contraction of the main channel, but the overbank flow area is completely obstructed by the road embankments.
- Abutments are set back away from the main channel.

**Case 2**
Flow is confined to the main channel (i.e., there is no overbank flow). The normal river channel width becomes narrower due to the bridge itself or the bridge site is located at a narrowing reach of the river.

**Case 3**
A relief bridge in the overbank area with little or no bed material transport in the overbank area (i.e., clear-water scour).

**Case 4**
A relief bridge over a secondary stream in the overbank area with bed material transport (similar to Case 1, above).

Contraction Scour Type Determination

To determine if the flow upstream is transporting bed material (i.e., live-bed contraction scour), the software calculates the critical velocity for beginning of motion \( V_c \) (for the \( D_{50} \) size of bed material) and compares it with the mean velocity \( V \) of the flow in the main channel or overbank area upstream of the bridge at the approach section. If the critical velocity of the bed material is greater than the mean velocity at the approach section \( (V_c > V) \), then clear-water contraction scour is assumed. If the critical velocity of the bed material is less than the mean velocity at the approach section \( (V_c < V) \), then live-bed contraction scour is assumed. You have the option of forcing the software to calculate contraction scour by the live-bed or clear-water contraction scour equation, regardless of the results from the comparison.

Entering Contraction Scour Data

You enter contraction scour data on the Contraction tab of the Bridge Scour Calculator dialog box. All of the input variables, except \( D_{50} \) and \( K1 \) are obtained automatically from the HEC-RAS output results. You can change any input variable to whatever value is thought to be appropriate. To compute contraction scour, you are only required to enter the \( D_{50} \) (mean size fraction of the bed material) and an assumed water temperature (to compute the \( K1 \) factor).
The input data for the Contraction tab is detailed below. Note that contraction scour is computed separately for the left overbank, main channel, and right overbank. Therefore, there are three columns of data for defining the necessary input. However, if there is not any left or right overbank flow in the model results, then the corresponding dialog box fields will be accordingly empty.

**Approach Cross Section**
This list is used to select the cross section that is assumed to act as the approach cross section to the bridge opening. The approach cross section should be located at a point upstream of the bridge just before the flow begins to contract due to the constriction of the bridge opening.

The software assumes that the approach cross section is the next upstream cross section from the bridge's upstream face cross section. If this is not the case, you can select a different cross section to be used as the approach cross section.

![Figure 2.11.2.2 Location of approach cross section](image)

**Scour Equation**
You have the option to allow the software to decide whether to use the live-bed or clear-water contraction scour equations, or to select a specific equation. If you select the Default option (software selects which equation is most appropriate), the software must compute $V_c$ (the critical velocity that will transport bed material finer than D50). If the average velocity at the approach cross section is greater than $V_c$, the software uses the live-bed contraction scour equation. Otherwise, the clear-water contraction scour equation will be used.

$Y_1$
The average depth (hydraulic depth) in the left overbank, main channel, and the right overbank, at the approach cross-section. This computed value can be overridden.
V1
The average velocity of flow in the left overbank, main channel, and right overbank, at the approach section. This computed value can be overridden.

Y0
The average depth in the left overbank, main channel, and right overbank, at the interior cross section at the upstream side of the bridge. This computed value can be overridden.

Q2
The flow in the left overbank, main channel, and right overbank, at the interior cross section at the upstream side of the bridge. This computed value can be overridden.

W2
The top width of the active flow area (not including ineffective flow area), taken at the interior cross section at the upstream side of the bridge. This computed value can be overridden.

D50 Particle Size
The bed material particle size of which 50% are smaller, for the left overbank, main channel, and the right overbank. These particle sizes must be specified.

K1
An exponent for the live-bed contraction scour equation that accounts for the mode of bed material transport. The software can compute a value for K1 or you can specify one. K1 is a function of the energy slope (S1) at the approach section, the shear velocity (V*) at the approach section, water temperature, and the fall velocity (w) of the D50 bed material. To have the software compute a K1 value, click Compute.

Q1
The flow in the left overbank, main channel, and right overbank at the approach cross section. This computed value can be overridden.

W1
The top width of the active flow area (not including ineffective flow area), taken at the approach cross section. This computed value can be overridden.

Energy Slope (S1)
Computed energy slope at the approach cross section, in ft/ft (or m/m). This computed value can be overridden.

Water Temperature
Assumed water temperature, in degrees Fahrenheit.

Shear Velocity (V*)
Computed shear velocity at the approach cross section, in ft/sec. This field is read-only.

Fall Velocity (w)
Computed fall velocity of the specified D50 bed material, in ft/sec. This field is read-only.
Contraction Scour Observations

The following observations should be considered when analyzing a bridge opening for potential contraction scour.

• Significant contraction scour can occur if overbank flows (the portion of the high-flow above and outside of the banks of the main channel) are captured by roadway approach embankments and forced through the bridge opening.

• Flow through relief bridges or over approaching roadway embankments can reduce the flow and contraction scour in the main channel bridge opening.

• Deep contraction scour is possible at relief bridges located in the overbank.

• If there is no overbank flow, only a change in the effective main channel width (including bridge piers in the flow) will influence live-bed contraction scour.

• Large substructure elements (i.e., piers, pile caps, pile groups) can increase contraction scour significantly.

• Submergence of the bridge superstructure causes pressure flow (vertical contraction scour), which can increase scour dramatically.

2.11.3 Pier Scour

Pier scour occurs due to the acceleration of flow around the pier and the formation of flow vortices (known as the horseshoe vortex). The horseshoe vortex removes material from the base of the pier, creating a scour hole. As the depth of scour increases, the magnitude of the horseshoe vortex decreases, thereby reducing the rate at which material is removed from the scour hole. Eventually an equilibrium between bed material inflow and outflow is reached, and the scour hole ceases to grow.

Figure 2.11.3.1 Illustration of pier scour mechanics
The factors that affect the depth of local scour at a pier are:

- Velocity of the flow just upstream of the pier
- Flow depth
- Pier width
- Length of the pier (if skewed to the flow)
- Size and gradation of bed material
- Angle of attack of approach flow
- Shape of the pier
- Bed configuration
- Formation of ice jams and debris

The HEC 18 report recommends the use of the Colorado State University (CSU) equation (Richardson, 1990) for the computation of pier scour under both live-bed and clear-water conditions. The CSU equation is the default pier scour equation. In addition to the CSU equation, an equation developed by Dr. David Froehlich (1991) has also been added as an alternative pier scour equation. The Froehlich equation is not recommended in the HEC 18 report, but has been shown to compare well with observed data.

**Entering Pier Scour Data**

Enter pier scour data on the Pier tab of the Bridge Scour Calculator dialog box. All of the input variables, except the pier nose shape (K1), the angle of attack for flow hitting the piers, the condition of the bed (K3), and a D95 size fraction for the bed material are obtained automatically from the HEC-RAS output results. You can change any input variable to whatever value is thought to be appropriate.

The input data for the Pier tab is described below.

**Scour Equation**

Pier scour can be computed by either the Colorado State University (CSU) equation (Richardson, et al, 1990) or the Froehlich (1988) equation (the Froehlich equation is not included in the HEC 18 report). The CSU equation is the default.

**Velocity & Depth**

This list provides the option to use the maximum velocity and depth in the main channel, or the local velocity and depth at each pier for the calculation of the pier scour.

In general, the maximum velocity and depth are used to account for the potential of the main channel thalweg to migrate back and forth within the bridge opening. The migration of the main channel thalweg could cause the maximum potential scour to occur at any one of the bridge piers.
**Maximum V1 Y1**
If you select this option, the software finds the maximum velocity and depth located in the cross section just upstream and outside of the bridge. The software uses the flow distribution output to obtain these values. The maximum velocity (V1) and depth (Y1) will then be used for all of the piers. This is the default option.

**Local V1 Y1**
If you select this option, the software finds the velocity (V1) and depth (Y1) at the cross section just upstream and outside of the bridge that corresponds to the centerline stationing of each of the piers.

**Pier #**
This list specifies how the data can be entered. When Apply to All Piers is selected, the pier data entered will be applied to all of the piers. You do not have to enter all of the data in this mode, only the portion of the data that should be applied to all of the piers.

Optionally, you can select a specific pier from this drop down list. When a specific pier is selected, any data that has already been entered, or is applicable to that pier, will be displayed in each of the data fields. You can then enter any missing information for that pier, or change any data that was already set.

**Pier Shape**
This list specifies the pier nose (upstream end) shape. You can select between the following pier shapes:

- Square nose
- Round nose
- Circular cylinder
- Group of cylinders
- Sharp nose (triangular)

When you select a shape, the K1 factor for the CSU equation and the Phi factor for the Froehlich equation are automatically set. You can set the pier nose shape for all piers, or a different shape can be entered for each pier.

**Pier Width (a)**
This field is used to enter the width of the pier (measured perpendicular to the flow direction). The software automatically puts a value in this field based on the bridge input data. You can change this value.

**D50 Particle Size**
Median diameter of the bed material of which 50 percent are smaller. This value is automatically filled-in for each pier, based on what was entered for the left overbank, main channel, and right overbank on the Contraction scour tab. You can change the value for all piers or any individual pier.

**Froude Number (Fr1)**
Froude Number directly upstream of the pier. This is taken from the flow distribution output for the cross section just upstream from the bridge. This field is read-only.
**Y1**  
This field displays the depth of water just upstream of each pier. The value is taken from the flow distribution output at the cross section just upstream and outside of the bridge. If you have specified Maximum V1 Y1 as the Velocity & Depth, then this field will show the maximum depth of water in the cross section for each pier. You can change this value directly for each or all piers.

**V1**  
This field displays the average velocity just upstream of each individual pier. The value is taken from the flow distribution output at the cross section just upstream and outside of the bridge. If you have specified Maximum V1 Y1 as the Velocity & Depth, then this field will show the maximum velocity of water in the cross section for all piers. You can change this value directly for each or all piers.

**Pier Length (L)**  
This field represents the length of the pier through the bridge. The field is automatically set by the software to equal the width of the bridge. You can change the length for all piers or each individual pier. This length is used in determining the magnitude of the K2 factor.

**Pier Skew Angle**  
This field is used to enter the angle of attack of the flow approaching the pier. If the flow direction upstream of the pier is perpendicular to the pier nose, then the angle would be entered as zero. If the flow is approaching the pier nose at an angle, then that angle should be entered as a positive value in degrees. When an angle is entered, the software automatically sets a value for the K2 coefficient. When the angle is > 5 degrees, K1 is set to 1.0.

**D95 Particle Size**  
The median size of the bed material of which 95 percent is finer. The D95 size fraction is used in the computation of the K4 factor, and must be defined.

**K1**  
Correction factor for pier nose shape, used in the CSU equation. This factor is automatically set when you select a pier nose shape. You can override the selected value.

**K2**  
Correction factor for angle of attack of the flow on the pier, used in the CSU equation. This factor is automatically calculated once you enter the pier width, the pier length, and the angle of attack. You can override the calculated value.

**K3**  
Correction factor for bed condition, used in the CSU equation. You can select from the following bed conditions:

- Clear-water scour
- Plane bed and antidune flow
- Small dunes
- Medium dunes
- Large dunes
K4
This factor is used to decrease scour depths in order to account for armoring of the scour hole. This factor is only applied when the D50 of the bed material is greater than 0.006 feet (0.002 m) and the D95 is greater than 0.06 feet (0.02 m). This factor is automatically calculated by the software, and is a function of D50; D95; pier width; and the depth of water just upstream of the pier. The K4 factor is used in the CSU equation.

Projected Width (a’)
The projected pier width with respect to the direction of the flow. This factor should be manually calculated and is based on the pier width, shape, angle, and length. This factor is specific to Froehlich's equation.

Phi Correction
Correction factor for pier nose shape, used in the Froehlich equation. This factor is automatically set when you select a pier nose shape. You can override the selected value.
Pier Scour Observations

The following observations should be considered when analyzing a bridge opening for potential pier scour.

- Width of pier has a direct effect on the depth of scour; wider piers produce deeper scour than narrow piers under the same conditions.
- Maximum expected pier scour depth ranges from 2.4 to 3 times the pier width for circular or round-nosed piers aligned with the flow.
- Length of the pier has no appreciable effect on scour depth if the pier is aligned with the flow; however, an angle of attack of the flow to the pier has a large effect on local scour.
- Velocity of the approaching flow increases the scour depth (faster flow produces deeper scour).
- Fine streambed sediments (silt and clay) will have scour depths as deep as sand-bed streams, even if bonded by cohesion.
  - The effect of cohesion is to increase the time it takes to reach the ultimate scour depth.
- In sand-bed channels, the maximum depth of scour is measured in hours.
- With cohesive streambed materials (silt, clay, sandstone, rock, etc.) it may take days, months, or even years to reach the maximum scour depth.
- Shape of the pier has an effect on scour:
  - A streamlined upstream end reduces the strength of the horseshoe vortex reducing scour depth.
  - A streamlined downstream end reduces the strength of the wake vortices.
- Square-nose pier will have a maximum scour depth about 20 percent larger than a sharp-nose pier and 10 percent larger than a cylinder or round-nose pier.
- Shape of the pier nose has no effect on the magnitude of the scour when the angle of the attack is greater than about 5 degrees.
- Ice and debris can increase the width of the piers, change the shape of piers, and cause the flow to plunge downward against the streambed and increase pier scour.

2.11.4 Abutment Scour

Local scour occurs at bridge abutments when the abutment obstructs the flow. The obstruction of the flow forms a horizontal vortex starting at the upstream end of the abutment and running along the toe of the abutment, and forms a vertical wake vortex at the downstream end of the abutment.
Figure 2.11.4.1  Illustration of abutment scour mechanics

The HEC 18 report recommends two equations for the computation of live-bed abutment scour. When the wetted embankment length (L) divided by the approach flow depth (Y1) is greater than 25, the HEC 18 report suggests using the HIRE equation (Richardson, 1990). When the wetted embankment length divided by the approach depth is less than or equal to 25, the HEC 18 report suggests using an equation by Froehlich (Froehlich, 1989).

**Entering Abutment Scour Data**

Enter abutment scour data on the Abutment tab of the Bridge Scour Calculator dialog box. All of the input variables, except abutment type are obtained automatically from the HEC-RAS output results. You can change any input variable to whatever value is thought to be appropriate.

The input data for the Abutment tab is described below. Abutment scour is computed separately for the left and right abutments.

**Scour Equation**

Abutment scour can be computed by either the HIRE equation (Richardson, 1990) or Froehlich's equation (Froehlich, 1989). This list allows you to select from the following equations:

- Default mode
- HIRE equation
- Froehlich equation

When the Default mode is selected, the software chooses the equation that is the most applicable to the situation. The selection is based on computing a factor of the embankment length divided by the approach depth. If this factor is greater than 25, the software automatically uses the HIRE equation. If the factor is equal to or less than 25, the software automatically uses the Froehlich equation.
Toe Station at Bridge XS
This field is used to define the stationing in the bridge upstream internal cross section, where the toe of the abutment intersects the natural ground. The software automatically selects a value for this stationing at the point where the road embankment and/or abutment data intersects the natural ground cross-section data. The location for the abutment toe stationing can be changed directly in this field.

The location of the toe of the abutment is based on where the roadway embankment intersects the natural ground. This stationing is very important because the hydraulic variables used in the abutment scour computations will be obtained from the flow distribution output at this cross section stationing. If you do not like the stationing that the model picks, you can override it by entering your own value.

Toe Station at Approach XS
This field is used to define the stationing in the approach cross section, based on projecting the abutment toe station onto the approach cross section. The location for this stationing can be changed directly in this field.

Abutment Length
Length of the abutment and road embankment that is obstructing the flow. The software automatically computes this value for both the left and right embankments. The left embankment length is computed as the stationing of the left abutment toe (projected up to the approach cross section) minus the station of the left extent of the active water surface in the approach cross section. The right embankment length is computed as the stationing of the right extent of the active water surface minus the stationing of the toe of the right abutment (projected up to the approach cross section), at the approach cross section. These lengths can be changed directly.

Abutment Flow Angle
This field is used to enter the angle of attack of the flow against the abutment. A value of 90 degrees should be entered for abutments that are perpendicular to the flow (i.e., normal situation). A value less than 90 degrees should be entered if the abutment is pointing in the downstream direction. A value greater than 90 degrees should be entered if the abutments are pointing in the upstream direction. This skew angle is used in computing the K2 factor.

Depth of Water at Toe (Y1)
This value is the computed depth of water at the station of the toe of the embankment, at the cross section just upstream of the bridge. The value is computed by the software as the elevation of the water surface minus the elevation of the ground at the abutment toe stationing. This value can also be changed. This value is used in the HIRE equation.

Abutment Shape (K1)
This value represents a correction factor accounting for abutment shape. You can choose among the following abutment shapes:

- Vertical abutments
- Vertical abutments with wing walls
- Spill-through abutments
Skew Correction Factor (K2)
Correction factor for angle of attack of the flow on the abutments. This factor is automatically computed by the software. As the skew angle becomes greater than 90 degrees, this factor increases from a value of one. As the skew angle becomes less than 90 degrees, this value becomes less than one. This field is read-only.

Abutment Projected Length (L')
The length of the abutment (embankment) projected normal to the flow (projected up to the approach cross section). This value is automatically computed by the software once you enter an abutment length and a skew angle. This value can be overridden.

Abutment Average Flow Depth (Ya)
The average depth of flow (hydraulic depth) that is blocked by the embankment at the approach cross section. This value is computed by projecting the stationing of the abutment toe up to the approach cross section. From the flow distribution output, the software calculates the area and top width left of the left abutment toe and right of the right abutment toe. This value is then computed as the area divided by the top width. This value can be overridden.

Abutment Flow Area (Ae)
The flow area that is obstructed by the abutment and embankment at the approach cross section. This value is computed by projecting the stationing of the abutment toe onto the approach cross-section. From the flow distribution output, the software calculates the area left of the left abutment toe and right of the right abutment toe. These values can be overridden.

Abutment Flow (Qe)
The flow obstructed by the abutment and embankment at the approach cross section. This value is computed by projecting the stationing of the abutment toe onto the approach cross-section. From the flow distribution output, the software calculates the percentage of flow left of the left abutment toe and right of the right abutment toe. These percentages are multiplied by the total flow to obtain the discharge blocked by each embankment. These values can be overridden.

Abutment Toe Velocity (V1)
The velocity at the toe of the abutment, taken from the cross section just upstream and outside of the bridge. This velocity is obtained by finding the velocity in the flow distribution output at the corresponding cross section stationing of the abutment toe. These values can be overridden.
**Abutment Scour Observations**

The following observations should be considered when analyzing a bridge opening for potential abutment scour.

- Potential for lateral channel migration, long-term degradation, and contraction scour should be considered when monitoring for abutment scour.
- Riprap and guide banks may protect an abutment from failure.
- Abutment scour will be most severe where the approach roadway embankment leading to the abutment obstructs a significant amount of overbank flow.
- Scour can occur along the upstream portion of the abutment due to the horizontal vortex and at the downstream end of the abutment as the flow expands through the bridge opening.
- Abutment scour will increase if the abutment (embankment) is skewed in an upstream direction (into the flow).
- Abutment scour will decrease if the abutment (embankment) is skewed in a downstream direction (away from the flow).
- Vertical wall abutment without wingwalls can have twice the scour depth as a spill-through (sloping) abutment.

### 2.11.5 Scour Analysis Results

Once the scour input data has been defined, select the Analysis Results tab. This tab displays the scour analysis results for the defined data.

If changes are made to the scour input data, click Recompute and the Bridge Scour Calculator will recompute the analysis results. To automatically generate a report within Microsoft Word, click Report. To export the report to an RTF (Rich Text Format) cross-platform document interchange file, click Export. To place the scour results on the cross section containing the bridge structure, click Place. To erase previously placed scour results from the bridge cross section, click Erase.

### Total Scour Computations

The total depth of scour is a combination of long-term bed elevation changes, contraction scour, and local scour at each individual pier and abutment.

The software plots both contraction scour and total local scour. The contraction scour is plotted as a separate line below the existing conditions cross section data. The local pier and abutment scour are then added to the contraction scour, and then plotted as total scour depths. The top width of the local scour hole around a pier is computed as $2.0 y_s$ to each side of the pier ($y_s$ is the scour depth). Therefore, the total top width of the scour hole at a pier is plotted as $(4.0 y_s + a)$. The top width of the local scour hole at abutments is plotted as $2.0 y_s$ around each side of the abutment toe. Therefore, the total top width of the scour hole at abutments is plotted as $4.0 y_s$. 
2.11.6 Bridge Scour Prevention

Riprap remains the most common countermeasure used to prevent scour at bridge abutments. A number of physical additions to the abutments of bridges can help prevent scour, such as the installation of gabions and stone pitching upstream from the foundation. The addition of sheet piles or interlocking prefabricated concrete blocks can also offer protection.

Trapezoidal-shaped channels through a bridge can significantly decrease local scour depths compared to vertical wall abutments, as they provide a smoother transition through a bridge opening. This eliminates abrupt corners that cause turbulent areas.

Spur dikes, barbs, groynes, and vanes are river training structures that change stream hydraulics to mitigate undesirable erosion or deposits. They are usually used on unstable stream channels to help redirect stream flow to more desirable locations through the bridge. The insertion of piles or deeper footings is also used to help strengthen bridges.

2.12 Program Configuration

Most of the software's non-drawing specific (general) configurations are stored in a configuration file called River.CFG, which is contained in the user directory. If this file is deleted or if you receive a newer version of software, the software reverts to its default values. Drawing specific configurations are stored in the drawing itself.

The software's configuration settings are described in the following sections.

2.12.1 Configure Cross Section Views

To access the Configure Section Views dialog box, click River tab > Input panel > Section Geometry drop-down > Configure Section Views.

The XS Grids tab of the Configure Section Views dialog box is used to specify how new cross section views are drawn. The following paragraphs describe the options on the XS Grids tab.

**Cross Section ID: Increment**

Specifies the increment for the automatically generated cross section ID number.

**Grid Axes**

These entries define how the cross section view station and elevation axes are to be sized and scaled when a new cross section view is added, or how an existing cross section view is resized. Changing any of these values causes all cross section views in the drawing to be regenerated.

**Station: Scale**

Defines how many feet per inch (or meters per meter) are to be represented by the scaled cross section view horizontal station axis.
Station: Tick Interval
Defines the interval (in feet or meters) at which tick marks and grid lines is
drawn perpendicular to the cross section view horizontal station axis. For
example, a station tick interval of 50 means that a tick mark and grid line is
drawn every 50 feet (or meters) along the station axis.

The software automatically labels as many of the station tick marks as possible,
but labels whose text would appear on top of a neighboring label are skipped.

Station: Round Off
This data entry is used when generate new grid is selected as the grid generation
method. This entry is used to determine at what station values a newly created
cross section view will start and end. For example, if this round off value is 100,
a grid station axis with a specified starting station of 140 and a station axis
length of 200 would is generated from station 100 to station 400, to include the
length from stations 140 to 340.

Elevation: Scale
Defines how many feet per inch (or meters per meter) are to be represented by
the scaled cross section view vertical elevation axis.

Elevation: Tick Interval
Defines the interval (in feet or meters) at which tick marks and grid lines will
be drawn perpendicular to the cross section view vertical elevation axis. For
example, an elevation tick interval of 10 means that a tick mark and grid line is
drawn every 10 feet (or meters) along the elevation axis.

Elevation: Round Off
This data entry is used when generate new grid is selected as the grid generation
method. This entry is used to determine at what elevation values a newly created
cross section view will start and end.

Resize Options
Specifies how cross section view is resized when you click River tab > Input
panel > Section Geometry drop-down > Resize Section Views. By default, both
station and elevation axes are resized.

Grid Array Pattern
These entries define the location and the array pattern used to lay out the cross section
views. The cross section views are laid out in an evenly spaced array.

Depending on the size of the largest cross section view and the total number of cross
section views, this array could occupy a large amount of drawing space. Therefore, it
is recommended that you locate the cross section grid array in an area on the drawing
that is unlikely to be used. However, locating the cross section grid array too far away
from the topographical map may cause excessive regenerations to occur when
zooming between a surface and a cross section view. Therefore, care should be
exercised when locating the grid array on the AutoCAD drawing.
If you find that the cross section grid array layout pattern needs to be adjusted or relocated, simply re-specify the array layout pattern and location. The software will then regenerate the cross section grid array.

X Layout Point
Y Layout Point
Specify the X and Y coordinates of the lower left corner of the cross section grid array. If the cross section grid array is placed too close to the profile grid array or topographical map, some of these grid arrays could overlap.

Click < to select the array layout point from the AutoCAD drawing screen.

X Grid Spacing
Y Grid Spacing
Specify for the grid array, the number of drawing units between each row and column for the cross section view insert locations. If the cross section views are spaced too closely, neighboring views may overlap.

Click Compute to automatically calculate grid spacing values to prevent currently existing cross section views from overlapping. If Compute on Import is selected, these spacing values will be automatically calculated during importation of a HEC-RAS or HEC-2 data input file, preventing cross section view overlap.

Columns
Specifies the number of columns to use in the generated grid array. When a row in the array contains this many cross section grids, a new row is started.

Text and Symbol Sizes
This section is used to define the sizes of the text and symbols used on the cross section views. Click Defaults to set these entries back to their default values.

ID Text
Defines the cross section ID text size (in drawing units) displayed under the cross section view.

Description Text
Defines the cross section description text size (in drawing units) displayed under the cross section view.

Overbank Symbol
Defines the overbank symbol size (in drawing units) displayed on the cross section view.

Tick Mark Text
Defines the tick mark text size (in drawing units) displayed on the cross section view.

Manning’s Roughness Text
Defines the Manning’s roughness text size (in drawing units) displayed on the cross section view.
2.12.2 Configure Elevation Sources

When entering cross section ground geometry using the 3D or 2D Map methods, the software will search for any elevation data on the topographical map which intersect the cross section line entered. Any points, lines, polylines, 3D faces, 3D polyfaces, or Civil 3D surfaces intersected will be examined for possible elevation data, but only for layers or surfaces that have been configured as valid elevation sources. If an entity is found on a layer or surface whose status has not previously been defined, you will be prompted to configure the layer or surface status.

To configure the elevation data sources, click River tab > Input panel > Create Section drop-down > Section Elevation Data Source.

The Section Elevation Data Source dialog box lists all layers and surfaces defined for the current drawing (except layers used by the software), as well as each layer's known elevation status, which can be one of the three following types:

- **Verify**
  - The layer or surface is not yet configured. If a possible ground geometry information is found on this layer or surface, you will be prompted to configure the status.

- **Use**
  - The layer or surface contains ground geometry information. Any points, lines, polylines, faces, or polyfaces found on this layer or surface will be read for 2D or 3D elevations when entering ground geometry.

- **Ignore**
  - The layer or surface does not contain ground geometry information. Any entities found on this layer or surface will be ignored when entering ground geometry.

### Interpolated Edge of Water

The software will use the layers or surfaces identified as Use for computing the interpolated edge of water. Any points, lines, polylines, faces, and polyfaces found on these layers or surfaces will be used in building a 3D terrain model for computing the water surface intersection.

2.12.3 Configure Profile Views

To configure profile views, click River tab > Output panel > Profile Views drop-down > Configure Profile Views.

The Configure Profile Views dialog box is used to specify how a new profile view is drawn. The following paragraphs describe the options on the Configure Profile Views dialog box.

### Grid Axes

The following entries are used to specify how the profile grid station and elevation axes are sized and scaled when a new profile View is added, or how an existing profile
view is resized. Changing any of these values causes all profile views in the drawing to be regenerated.

**Station: Scale**
Defines how many feet per inch (or meters per meter) are to be represented by the scaled profile view horizontal axis.

**Station: Tick Interval**
Defines the interval (in feet or meters) at which tick marks and grid lines will be drawn perpendicular to the profile view horizontal axis. For example, a station tick interval of 200 means that a tick mark and grid line is drawn every 200 feet (or meters) along the river station axis.

The software automatically labels as many of the station tick marks as possible, but labels whose text would appear on top of a neighboring label are skipped.

**Station: Roundoff**
Determines at what station values a newly created profile view will start and end. For example, if the roundoff value were 100, a grid with a specified starting station of 140 and a station axis length of 200 would be generated from station 100 to station 400, to include the length from stations 140 to 340.

**Elevation: Scale**
Defines how many feet per inch (or meters per meter) are to be represented by the scaled profile view vertical axis.

**Elevation: Tick Interval**
Defines the interval (in feet or meters) at which tick marks and grid lines will be drawn perpendicular to the profile view vertical axis. For example, an elevation tick interval of 10 means that a tick mark and grid line will be drawn every 10 feet (or meters) along the elevation axis.

**Elevation: Roundoff**
Determines at what elevation values a newly created profile view will start and end.

**Grid Array Pattern**
These entries define the location and the pattern used to layout the profile views. The profile views are laid out in an evenly spaced array.

Depending on the size of the largest profile view and the total number of profile views, this array could occupy a large amount of drawing space. Therefore, it is recommended that you locate the profile grid array in an area on the drawing that is unlikely to be used.
If you find that the profile grid array layout pattern needs to be adjusted or relocated, simply re-specify the array layout pattern and location. The software regenerates the profile grid array.

**X: Layout Point**  
**Y: Layout Point**  
Specify the X and Y coordinates of the lower left corner of the profile grid array. If the profile grid array is placed too close to the cross section grid array, or topographical map, some of these grid arrays could overlap.

Click Pick to select the array layout from the AutoCAD drawing screen.

**X: Grid Spacing**  
**Y: Grid Spacing**  
Specify the number of drawing units between each row and column for the profile grid insert locations. If the profile views are spaced too closely, neighboring views may overlap.

Click Compute to automatically calculate grid spacing values to prevent currently existing profile views from overlapping.

**Columns**  
Specifies the number of columns to use in the generated grid array. When a row in the array contains this many profile views, a new row is started.

### Text and Symbol Sizes

This section is used to define the size of the text and symbols used on the profile views. Click Defaults to set these entries back to their default values.

**ID Text**  
Defines the profile ID text size (in drawing units) displayed under the profile view.

**Description Text**  
Defines the profile description text size (in drawing units) displayed under the profile view.

**Tick Mark Text**  
Defines the tick mark text size (in drawing units) displayed on the profile view.

**Profile ID Text**  
Defines the profile ID text size (in drawing units) displayed on the profile view.

**Bridge/Culvert/Roadway Scale**  
Adjusts the horizontal size of the symbols used to draw the bridge opening invert, low chord, roadway deck symbols. A value of 1.0 causes no adjustment to be made. A value of 0.5 makes these symbols 50% shorter, horizontally.

**Line Symbol Scale**  
Adjusts the size of the symbols drawn on the computed water surface, energy grade line, and other lines displayed on the profile grid. A value of 1.0 causes no adjustment to be made. A value of 0.5 makes these symbols 50% smaller.
Resizes Options

Specifies how a profile grid is resized when you click River tab > Output panel > Profile Views drop-down > Resize Profile Views. By default, only the Elevation axis is resized.

2.12.4 Configure Topographical Map

Configure the software for digitizing cross sections from on-screen 3D and 2D topographical maps and from paper topographical maps.

To configure the topographical map, click River tab > Input panel > Section Geometry drop-down > Configure Section Views. On the Configure Section Views dialog box, click the General tab.

The following paragraphs describe the Topographical Map configuration options. These options need to be completed only when first setting up a drawing that uses a topographical map.

2D/3D Map Scale

Specifies the X and Y coordinate scaling factor when using an on-screen 2D or 3D topographical map. This scaling factor defaults to 1 foot (or meter) per drawing unit, and should be changed if the topographical map is drawn at a different scaling factor. This entry is ignored when digitizing from a paper topographical map.

3D Elevation Scale

Specifies the elevation scaling factor to use when digitizing cross sections from an on-screen 3D topographical map. This scaling factor defaults to 1 foot (or meter) per drawing unit, and it should be changed if the topographical map's elevation scaling factor is different. This entry does not apply when digitizing from an on-screen 2D topographical map or paper topographical map.

Contour Interval

Specifies the initial elevation contour interval to use when digitizing a cross section from an on-screen 2D topographical map or paper topographical map. This entry should match the contour elevation step represented in the topographical map being used. Once digitizing has started, this elevation contour interval can be adjusted using the Page Up and Page Down keys. This entry is ignored when digitizing from an on-screen 3D topographical map.

Map Text Height

Specifies the text height size (in drawing units) of the cross section ID labels that are placed, along with the digitized cross section, on the on-screen 3D and 2D topographical maps. This entry is ignored when digitizing from a paper topographical map.

Converting Between Metric and English Units

There are times when you may run into map data that has different unit bases for X-Y data and elevation data. For example, USGS DEM files have their X-Y coordinate data...
in UTM (Universal Transverse Mercator) units (which are metric coordinates), whereas the elevation component of the DEM data is often in feet.

The 2D/3D Map Scale and 3D Elevation Scale configuration entries can be used to specify unit conversion factors so that the cross section geometry that is cut from topographical map is in the same unit base for both X-Y and elevation data.

To convert meters to feet, a scale factor of 3.28084 should be used. To convert feet to meters, a scale factor of 0.3048 should be used. Therefore, to create cross sections in feet from a USGS DEM contour map, a scale factor of 3.28084 should be specified for the 2D/3D Map Scale entry. Similarly, to create cross sections in meters, a scale factor of 0.3048 should be specified for the 3D Elevation Scale entry.

### 2.12.5 Configure Elevation Precision

To configure the precision of Autodesk River and Flood Analysis Module elevation units, click River tab > Input panel > Section Geometry drop-down > Configure Section Views. On the Configure Section Views dialog box, click the General tab.

**Elevation Decimal Input Precision**

Specifies the desired decimal precision to be used for all data digitized from the screen or tablet. This precision is also used in displaying any of these data values in dialog boxes.

---

**Note**

Once data is entered in a particular unit of measurement, switching to a different unit of measurement simply changes the data prompts to reference this new unit base. It does not convert the data.

**Changing a Drawing’s Precision**

Click Update to update the station and elevation precision for the entire drawing. Decreasing a drawing’s precision truncates decimal digits from the station and elevation data values—it does not round the values.

### 2.12.6 Saving Configuration Settings

The software stores many settings along with the AutoCAD drawing that are specific to the model being analyzed. Therefore, saving the drawing automatically saves these settings as well.

However, there are many general settings that are not saved with the drawing, but instead are saved in the software’s configuration file, which is also automatically saved when the drawing is saved.
CHAPTER 3

Input Descriptions

This chapter provides complete descriptions of the HEC-RAS data input commands.

3.1 Flow Information

The Flows dialog box allows you to specify up to fifteen different flow profiles for which the software provides solutions.

To access the Flows dialog box, click River tab > Create Reach Data panel > Flows.

In the Flows dialog box, specify the following parameters:

Reach
Specify the reach number that you want to analyze.

Profiles
Select the profiles that you want to analyze.

Profile Type
Specify whether the model is to compute either Subcritical, Supercritical, or Mixed profiles. Generally, Subcritical should be selected. When both subcritical and supercritical conditions exist in a model, then Mixed should be selected.

You can switch between subcritical, supercritical, and mixed starting profile conditions, without losing any previously defined data.

In a subcritical flow regime, boundary conditions are only specified at the downstream end of the river. If a supercritical flow regime is to be calculated, boundary conditions are only specified at the upstream end of the river. If a mixed flow regime calculation is to be performed, then boundary conditions must be specified at both the downstream and upstream ends of the river.

Downstream Condition
Upstream Condition
Specify the computation method to be used downstream and upstream.

When the Water Surface Elevation condition is selected, the profile computations start at a known water surface elevation. This water surface elevation must be specified.

When the Critical Depth condition is selected, the profile computations start at critical depth.

When the Normal Depth condition is selected, the profile computations start at a calculated normal depth.
When the Rating Curve condition is selected, the profile computations are based on a user-defined rating curve.

**User Selection of Profile Analyses**

Autodesk® River and Flood Analysis Module allows you to specify up to 15 separate profiles in the Flows dialog box and then analyze only selected profiles.

**Floodplain Encroachment Studies**

If floodplain encroachments are specified, HEC-RAS first computes the water surface profile for the natural channel (without any encroachments) using the first specified discharge and then computes profiles using the specified encroachment for all subsequent discharges. Therefore, encroachment analyses require that at least two profiles be specified. The first profile will be the natural (unencroached) profile, and all subsequent profiles will then be encroached.

**Selection of Profile Type**

When initially defining a HEC-RAS water surface profile model, you must select a profile type (i.e., subcritical, supercritical, or mixed). Usually a subcritical profile type should be selected. However, in steep reach regions, a subcritical profile computations may completely or partially fail for the entire reach of river being modeled. This will cause HEC-RAS to assume critical depth at locations where the water surface profile analysis failed.

Generally, channel bed slopes with greater than a 1% grade (i.e., a 1 ft rise in a 100 ft run) will be supercritical and bed slopes with less than a 1% grade will be subcritical. This can be used to aid in selecting the appropriate profile type when initially defining a HEC-RAS model. However, when in doubt, a mixed profile type can be selected and water surface profile will always be computed correctly.

When a subcritical profile is specified, computations originate at the downstream cross section of the channel and then proceed upstream. When a supercritical profile is specified, computations start at the upstream cross section of the channel and proceed downstream. When a mixed profile is specified, computations are run in both directions and the appropriate (correct) water surface elevation is automatically selected.

**Switching Between Profile Types**

You can define different starting profile conditions for subcritical, supercritical, and mixed profiles. Selecting Subcritical, Supercritical, or Mixed for the Profile Type allows you to define completely different starting profile conditions, each containing different specified values for the displayed data entries. Switching between profile types will not lose previously defined data.
The Hydraulic Calculator allows you to compute the normal depth elevation corresponding to a specified discharge at the currently selected cross section. You can use the calculator to compute the normal depth elevation at the most downstream cross section (if computing a subcritical profile) or most upstream cross section (if computing a supercritical profile). This value can then be entered as the starting water surface elevation in the Flows dialog box. The Hydraulic Calculator is available from the River tab > Analysis panel.

### 3.2 Analysis Options

The Analysis Options dialog box allows you to specify the computational job parameters for the software.

To access the Analysis Options dialog box, click River tab > Analysis panel > Analysis Options.

The Analysis Options dialog box data entries can generally be left blank. The software uses pre-defined default values for these entries.

In the Analysis Options dialog box, specify the following parameters:

**Water Surface Calculation Tolerance**

Specifies the calculation convergence tolerance to be used in comparing against the difference between the computed and assumed water surface elevations. When the computed difference is less than the specified tolerance, the software assumes that it has a valid numerical solution.

**Critical Depth Calculation Tolerance**

Specifies the convergence tolerance used in computing the critical depth.

**Maximum Number of Iterations**

Specifies the maximum number of iterations the software makes when attempting to balance the water surface calculations.

**Maximum Difference Tolerance**

Specifies the convergence tolerance used during the balance of the energy equation. As the software attempts to balance the energy equation, the solution with the minimum error (assumed minus computed water surface) is saved. If the software goes to the maximum number of iterations without meeting the specified calculation tolerance, the minimum error solution is checked against the maximum difference tolerance. If the solution at minimum error is less than this value, then the software uses the minimum error solution as the answer, issues a warning, and then proceeds with the calculations. If the solution at minimum error is greater than the maximum difference tolerance, then the software issues a warning and defaults the solution to critical depth. The computations then proceed from there.
Flow Tolerance Factor
This factor is only used in the bridge and culvert computations. The flow tolerance factor is used when the software is attempting to balance between weir flow and flow through the structure. This factor is multiplied by the total flow. The resultant is then used as a flow tolerance for the balance of weir flow and flow through the structure.

Maximum Number of Iterations in Split Flow
Specifies the maximum number of iterations the software makes when attempting to balance the water surface calculations at a split flow location.

Flow Tolerance Factor in Weir Split Flow
This factor is only used in the bridge and culvert computations. The flow tolerance factor is used when the software is attempting to balance between weir flow and flow through the structure. This factor is multiplied by the total flow. The resultant is then used as a flow tolerance for the balance of weir flow and flow through the structure.

Maximum Difference in Junction Split Flow
Specifies the convergence tolerance used during the balance of the energy equation. As the software attempts to balance the energy equation, the solution with the minimum error (assumed minus computed water surface) is saved. If the software goes to the maximum number of iterations without meeting the specified calculation tolerance, the minimum error solution is checked against the maximum difference in junction split flow tolerance. If the solution at minimum error is less than this value, then the software uses the minimum error solution as the answer, issues a warning, and then proceeds with the calculations. If the solution at minimum error is greater than the maximum difference in junction split flow tolerance, then the software issues a warning and defaults the solution to critical depth. The computations then proceed from there.

Friction Loss Computation Method
Specifies the computation method to be used in computing friction losses.

Available friction loss computation methods include:

- Average Conveyance Equation
- Average of Friction Slope
- Geometric Mean of Friction Slope
- Harmonic Mean of Friction Slope
- Automatic Selection

The Average Conveyance Equation option is recommended for general applications, and it is the default selection.

If the Automatic Selection option is specified, the software selects, on a step-by-step basis, one of the four computation methods. This selection is based upon flow conditions. Sometimes, when the computation process cannot find a balance between the assumed and computed water surface elevation, this option provides a solution balance.
**Conveyance Computation Method**

Specifies how conveyance is computed in the overbanks.

If the At Breaks in Roughness Manning’s Only option is selected, the software sums the wetted perimeter and the flow area between breaks in roughness n values, and then calculates the conveyance for this subarea. The conveyance subareas are then summed to get the total overbank conveyance. This method is the default method, and is regarded as being more accurate.

If the Between All Ground Points option is selected, the software calculates the wetted perimeter, flow area, and conveyance between every coordinate point in the overbanks. The conveyance values are then summed to get the total left overbank and right overbank conveyance. This method was the only method available in HEC-2.

These two methods can provide different answers for conveyance, and therefore different water surface profiles.

**Critical Depth Computation Method**

Specifies the method of computing critical depth.

The Parabolic Search method uses a parabolic searching technique to find the minimum specific energy. This method is very fast, but is only capable of finding a single minimum on the energy curve.

The Multiple Depth Search method is capable of finding up to three minimums on the energy curve. If more than one minimum is found, the software selects the answer with the lowest energy. Very often the software finds minimum energies at levee breaks and breaks due to specified ineffective flow areas. When this occurs, the software does not select these answers as valid critical depth solutions unless there is no other answer available. This search method takes a lot of computation time. Since critical depth is calculated often, using this method slows down computations. This method should only be used when you feel the software is finding an incorrect answer for critical depth.

**Always Compute Critical Depth**

Specifies that critical depth is always computed at every cross section.

**Warning**

The Calculation Tolerances entries allow you to override the default settings for the calculation tolerances. These tolerances are used in the solution of the energy equation. Increasing the calculation tolerance above the default values could result in computational errors in the water surface profile.

**Metric Tolerances**

If metric (SI) units of measure are used, some minor differences in results can occur in the analysis. Tolerances used in the decision logic of the software are normally in feet. When metric units of measure are used, these tolerances become meters, approximately 3 times larger in magnitude. Adjustments should be made to these tolerances to obtain the desired accuracy in the analysis results.
3.3 Cross Section Data

After defining a cross section view and its corresponding ground geometry, other data describing the cross section can be specified. The following sections describe how to define other data properties for a cross section, such as contraction and expansion loss coefficients, bank stations, roughness, and flow lengths.

3.3.1 Cross Section Description

The Section Description dialog box allows you to specify overbank locations, channel and floodplain roughness, reach lengths, loss coefficients and other information about the current cross section.

To access the Section Description dialog box, click River tab > Input panel > Section Description.

In the Section Description dialog box, specify the following parameters:

Reach
Specify the river reach to which the cross sections belong.

Cross Section
Specify the cross section that you want to modify.

Cross Section ID
This data entry is used to specify the ID which uniquely identifies the cross section. No two cross sections within the same river reach may have the same cross section ID. Note that this ID was assigned when the cross section view was first created.

This data entry must be positive in value and be no more than six characters long. Note that cross section IDs must be ascending in value, from downstream to upstream. This is how Autodesk River and Flood Analysis Module is able to maintain the numerical placement of the current cross section relative to all the other specified cross sections.

Description (optional)
Specify a description of the current cross section. Up to 5 lines of 72 characters each can be entered.

Overbank Station: Left
Specifies the left floodplain overbank station (looking downstream) that defines the cross section flow region that corresponds to the left floodplain flow length (see Figure 3.3.1.1). This entry must correspond to one of the entered cross section geometry stations. The software will ensure this by automatically snapping to the closest ground station when picking the overbank station from the cross section plot or topographical map.

To select the station from the cross section plot or topographical map (if it's visible on-screen) click <.
**Flow Slices: Left**
Specifies the number of flow slices to construct in the left overbank for computing a flow distribution at the cross section. The computed flow distribution can then be used for determining additional hydraulic properties, such as computing a velocity distribution or for performing bridge scour calculations.

A maximum of 45 flow slices can be defined at a cross section (adding together all of the flow slices defined for the left overbank, channel, and right overbank).

**Manning's n: Left**
Specifies the Manning's roughness coefficient corresponding to the left floodplain (looking downstream).

If this entry is left blank, then the last value entered for the adjacent downstream cross section (when performing a subcritical profile analysis) or adjacent upstream cross section (when performing a supercritical profile analysis) is used.

This entry is required for the furthest downstream cross section (when performing a subcritical profile analysis), or for the furthest upstream cross section (when performing a supercritical profile analysis) when horizontal Manning's roughness busareas are not specified.

A Manning's coefficient of 0.0 is not permitted.

**Flow Length: Left**
Specifies the left floodplain flow length (looking downstream) between the current cross section and the adjacent downstream cross section that the left overbank flow uses.

To automatically measure the distance off of the topographical map (if it's visible on-screen), click <. The software will allow you to define the flow length by pointing out the flow path on the topographical map.

If this entry is left blank, the left floodplain flow length is set equal to the channel flow length. This entry will be ignored for the furthest downstream cross section. The model uses this distance in computing flow conveyance. This entry must be specified if the cross section locations do not correspond to river stationing.

**Flow Slices: Channel**
Specifies the number of flow slices to construct in the channel for computing a flow distribution at the cross section. The computed flow distribution can then be used for determining additional hydraulic properties, such as computing a velocity distribution or for performing bridge scour calculations.

A maximum of 45 flow slices can be defined at a cross section (adding together all of the flow slices defined for the left overbank, channel, and right overbank).

**Manning's n: Channel**
Specifies the Manning's roughness coefficient corresponding to the channel.
If this entry is left blank, then the last value entered for the adjacent downstream cross section (when performing a subcritical profile analysis) or adjacent upstream cross section (when performing a supercritical profile analysis) will be used.

This entry is required for the furthest downstream cross section (when performing a subcritical profile analysis), or for the furthest upstream cross section (when performing a supercritical profile analysis) when horizontal Manning’s roughness busareas are not specified.

A Manning's coefficient of 0.0 is not permitted.

**Flow Length: Channel**

This entry specifies the channel flow length between the current cross section and the adjacent downstream cross section.

To automatically measured off of the topographical map (if it's visible on-screen), click <. The software will allow you to define the flow length by pointing out the flow path on the topographical map.

If this entry is left blank, the channel flow length will be set equal to the computed flow length between the adjacent downstream cross section location and the current cross section location. This entry will be ignored for the furthest downstream cross section. The model uses this distance in computing flow conveyance. This entry must be specified if the cross section locations do not correspond to river stationing.

**Overbank Station: Right**

Specifies the right floodplain overbank station (looking downstream) that defines the cross section flow region that corresponds to the right floodplain flow length. This entry must correspond to one of the entered cross section geometry stations. The software ensures this by automatically snapping to the closest ground station when picking the overbank station from the cross section plot or topographical map.

To select this station from the cross section plot or topographical map (if it's visible on-screen), click <.

**Flow Slices: Right**

This entry specifies the number of flow slices to construct in the right overbank for computing a flow distribution at the cross section. The computed flow distribution can then be used for determining additional hydraulic properties, such as computing a velocity distribution or for performing bridge scour calculations.

A maximum of 45 flow slices can be defined at a cross section (adding together all of the flow slices defined for the left overbank, channel, and right overbank).

**Manning’s n: Right**

Specifies the Manning's roughness coefficient corresponding to the right floodplain (looking downstream).
If this entry is left blank, then the last value entered for the adjacent downstream cross section (when performing a subcritical profile analysis) or adjacent upstream cross section (when performing a supercritical profile analysis) will be used.

This entry is required for the furthest downstream cross section (when performing a subcritical profile analysis), or for the furthest upstream cross section (when performing a supercritical profile analysis) when horizontal Manning’s roughness busareas are not specified.

A Manning’s coefficient of 0.0 is not permitted.

**Flow Length: Right**

Specifies the right floodplain flow length (looking downstream) between the current cross section and the adjacent downstream cross section that the right overbank flow uses.

To automatically measured this distance off of the topographical map (if it's visible on-screen), click <. The software will allow you to define the flow length by pointing out the flow path on the topographical map.

If this entry is left blank, the right floodplain flow length will be set equal to the channel flow length. This entry will be ignored for the furthest downstream cross section. The model uses this distance in computing flow conveyance. This entry must be specified if the cross section locations do not correspond to river stationing.

**Contraction Loss**

**Expansion Loss**

These coefficients are used to compute the contraction and expansion loss components of the energy equation. The default loss coefficients for contraction and expansion is 0.0, or the last values entered for the adjacent downstream cross section (when performing a subcritical profile analysis) or adjacent upstream cross section (when performing a supercritical profile analysis).

Both contraction and expansion coefficients are specified at a cross section. However, generally only one value is used at a particular cross section reach. The software propagates these coefficients from cross section to cross section so they can be defined only once (unless the values change). The software automatically uses the appropriate coefficient, based upon whether it encounters a contracting reach or expanding reach.
The following contraction loss coefficients can be used:

No transition loss computed  0.0  
Gradual transition       0.1  
Bridges (or culverts with wingwalls)  0.3  
Abrupt transitions (and most culverts)  0.6  

The maximum value for the expansion loss coefficient is 1.0. The following expansion loss coefficients can be used:

No transition loss computed  0.0  
Gradual transition       0.3  
Bridges (or culverts with wingwalls)  0.5  
Abrupt transitions (and most culverts)  0.8  

Figure 3.3.1.1  Flow lengths between cross sections

Channel Overbank Station Locations

If the floodplain overbank station locations to be defined correspond to ground stations that were not entered when the cross section geometry was originally input, the overbank station and elevation must be defined in the ground geometry data. This is done manually using the Edit Geometry dialog box. Once the stations and elevations have been entered, the software inserts these points into the cross section view’s ground geometry and on the cross section shown in the topographical map (if available). The floodplain overbank station locations can then be defined from either the cross section view or the topographical map.

Hydraulic Calculator

The Hydraulic Calculator considers the entire cross section geometry as available for flow in its computations. It knows nothing about ineffective flow areas, channel modifications, floodplain encroachments, conveyance obstructions, or levees in which flow has been restricted. Therefore, caution should be exercised when applying the Hydraulic Calculator to these situations.
3.3.2 Ineffective Flow Area Description

The Ineffective Flow Areas dialog box allows you to restrict flow to the effective flow area of the cross section.

To access the Ineffective Flow Areas dialog box, click River tab > Input panel > Ineffective Flow Areas.

In the Ineffective Flow Areas dialog box, specify the following parameters:

Type

Two alternatives are available for defining ineffective flow areas:

- Normal (HEC-2 Method)
- Multiple Blocks

Normal (HEC-2 Method)

The Normal (HEC-2 Method) type allows you to define a left station and elevation and a right station and elevation. Click Pick to select the left and/or right ineffective flow encroachment station and elevation from the cross section view. The area to the left of the left station and to the right of the right station will be assumed completely ineffective at carrying flow. An example of this type of ineffective flow area is shown in Figure 3.3.2.1. This type of ineffective flow area method is the same as is used in HEC-2.

Multiple Blocks

Multiple Blocks type allows you to define up to 20 individual ineffective flow areas. With this option, you enter a left station, a right station, and an elevation for each ineffective flow area.

Click Draw to draw the ineffective flow area. The software requires that three points be selected when drawing the ineffective flow area.

An example of this type of ineffective flow area is shown in Figure 3.3.2.2.

To change an ineffective flow area in the list box, select the appropriate entry from the list box, and then make the appropriate changes.
Effective flow areas are active only for the current cross section. They are not propagated upstream or downstream. Therefore, to define the ineffective flow area for a reach of river, more than one cross section must be used to define the ineffective flow region.

**Note**

The Hydraulic Calculator considers the entire cross section geometry as available for flow in its computations. It knows nothing about ineffective flow areas, channel modifications, floodplain encroachments, conveyance obstructions, or levees in which flow has been restricted. Therefore, caution should be exercised when applying the Hydraulic Calculator to these situations.
3.3.3 Conveyance Obstruction Description

The Conveyance Obstructions dialog box allows you to define areas of the cross section that will be permanently blocked out. Blocked obstructions not only decrease flow area, but unlike ineffective flow areas, add wetted perimeter when the water comes in contact with the obstruction. A blocked obstruction does not prevent water from going outside of the obstruction.

To access the Conveyance Obstructions dialog box, click River tab > Input panel > Conveyance Obstructions.

In the Conveyance Obstructions dialog box, specify the following parameters.

**Type**

Two alternatives are available for defining conveyance obstructions:

- Normal
- Multiple Blocks

**Normal**

The Normal type allows you to define a left station and elevation and a right station and elevation. Click Pick to select the left and/or right blocked obstruction station and elevation from the cross section view. The area to the left of the left station and to the right of the right station will be completely blocked out. An example of this type of blocked obstruction is shown in Figure 3.3.3.1.

**Multiple Blocks**

The Multiple Blocks type allows you to define up to 20 individual blocked obstructions. With this option, you enter a left station, a right station, and an elevation for each blocked obstruction.

An example of this type of blocked obstruction is shown in Figure 3.3.3.2.

![Figure 3.3.3.1 Example of a cross section with normal blocked obstructions](image)
3.3.3.2 Example of a cross section with multiple blocked obstructions

**Note**

Blocked obstructions are active only for the current cross section. They are not propagated upstream or downstream. Therefore, to define a blocked obstruction for a reach of river, more than once cross section must be used to define the blocked obstruction.

**Hydraulic Calculator**

The Hydraulic Calculator considers the entire cross section geometry as available for flow in its computations. It knows nothing about ineffective flow areas, channel modifications, floodplain encroachments, conveyance obstructions, or levees. Therefore, caution should be exercised when applying the Hydraulic Calculator to these situations.

### 3.3.4 Levee Description

The Levees dialog box allows you to define a left and/or right levee station and elevation for the cross section. When levees are established, no water can go to the left of the left levee station or to the right of the right levee station until either of the levee elevations are exceeded. Levee stations must be defined explicitly or the software assumes that water can go anywhere within the cross section.

To access the Levees dialog box, click River tab > Input panel > Levees.

In the Levees dialog box, enter the following parameters:

**Left Levee Station**

**Left Levee Elevation**

When the water surface elevation is less than the left levee elevation, water is not allowed to exceed the specified left levee station (see Figure 3.3.4.1). Click Pick to select the left levee station and elevation from the cross section view.
Selecting the Use Left Bank option automatically causes HEC-RAS to maintain the flow within the left bank until the left bank becomes overtopped.

**Right Levee Station**

**Right Levee Elevation**

When the water surface elevation is less than the right levee elevation, water is not allowed to exceed the specified right levee station (see Figure 3.3.4.1). Click Pick to select the right levee station and elevation from the cross section view.

Selecting the Use Right Bank option automatically causes HEC-RAS to maintain the flow within the right bank until the right bank becomes overtopped.

![Figure 3.3.4.1 Example of the levee option](image)

**Note**

The user may want to define levees in a model to see what effect a levee will have on the water surface elevation. A simple way to do this is to set a levee station and elevation that is above the existing ground. If a levee elevation is placed above the existing geometry of the cross section, then a vertical wall is placed at that station up to the established levee height. Additional wetted perimeter is included when the water comes into contact with the levee wall.

**Problems with Imported HEC-2 Data**

The standard US Army Corps of Engineers HEC-RAS software does not account for the HEC-2 X3-IEARA data field, which specifies whether flow should be contained between the channel banks until the banks are overtopped. Therefore, when a HEC-2 model that contains X3-IEARA data is imported into HEC-RAS, the model water surface profile results can differ greatly. Therefore, to maintain consistency between HEC-RAS’ import behavior, Autodesk River and Flood Analysis Module also ignores the X3-IEARA data field when importing the data into HEC-RAS. However, the
software warns of this potential problem to the end user in the HEC-2 import log file it generates.

To maintain the same characteristics for HEC-RAS as with HEC-2, select the Use Left Bank and Use Right Bank options at those cross sections that Autodesk River and Flood Analysis Module warns the user of.

**Hydraulic Calculator**

The Hydraulic Calculator considers the entire cross section geometry as available for flow in its computations. It knows nothing about ineffective flow areas, channel modifications, floodplain encroachments, conveyance obstructions, or levees. Therefore, caution should be exercised when applying the Hydraulic Calculator to these situations.

### 3.3.5 Profile Adjustments Description

The Profile Adjustments dialog box allows you, on a profile basis, a different discharge and an optional known water surface elevation, water surface elevation increment, energy change, or additional energy losses for the current cross section.

To access the Profile Adjustments dialog box, click River tab > Input panel > Profile Adjustments.

In the Profile Adjustments dialog box, enter the following parameters.

Note that this dialog box is generally left blank. However, when a lateral inflow occurs along the stream being modeled, the Flow Discharge dialog box is used to account for the loss of flow upstream of the confluence junction.

**Reach**

Specify the reach to which the cross sections and profiles belong.

**Cross Section**

Specify the cross section to which the profiles belong.

**Discharge**

Specify a known discharge for each profile. This entry is used to account for change in discharge due to river inflow and outflow, as occurs in a tributary stream network.

**Adjustment Type**

Specifies the adjustment type for each profile:

- Known water surface elevation
- Change in water surface
- Change in energy grade
- Additional energy grade
- K loss

If a water surface is known to occur for a particular profile at this cross section, then specifying Known WS will allow you to specify this elevation.
If a water surface elevation increment is to be added to the water surface elevation of the adjacent downstream cross section to obtain the water surface elevation at this cross section for a particular profile, then specifying Change in WS allows you to specify this elevation increment.

If a specific energy change is to occur between the adjacent downstream cross section and the current cross section in order to obtain the energy gradeline elevation at the current cross section for a particular profile, then specifying Change in EG allows you to specify this change in energy. The software will then use this to compute a water surface elevation from the specified change in energy.

Selecting Additional EG allows you to enter an additional energy loss between the adjacent downstream cross section and the current cross section for a particular profile. This energy loss gets added to the computed energy losses that occur during the balancing of the energy equation.

### Changing Entries

To add or change any values in the list box, select the appropriate profile entry from the list box, enter a new value in the data entry, and choose Apply. The software updates the value contained in the list box.

### Linkage with Specified Profiles

The list box values specified in the Profile Adjustments dialog box correspond to specific starting conditions defined for profiles contained in the Profile Description dialog box.

### Caution

The Profile Adjustments dialog box should not be used to define profile adjustments for either the most downstream or most upstream cross section.

### 3.3.6 Rating Curve Description

The Rating Curve dialog box allows you to specify a discharge versus elevation rating curve for the current cross section. This is generally done when accurate field observations have been collected. These values will then be used in the analysis, instead of being computed.

To access the Rating Curve dialog box, click River tab > Input panel > Rating Curve.

In the Rating Curve dialog box, specify the following parameters:

Note that this dialog box is generally left blank.

**Discharge**

Specifies the corresponding measured discharge. A maximum of 100 rating curve values can be specified.
Water Surface Elevation

Specifies the water surface elevation for which a known discharge has been measured.

To add a rating curve point to the list, select an empty entry from the list, and then enter the point's discharge and water surface elevation values. The software automatically inserts the rating curve point into the list in sorted order according to water surface elevation.

**Note**

The software linearly interpolates between given rating curve values and extrapolates for values outside the specified rating curve range. If accurate discharge versus elevation data is not known for the cross section, then these data entries should be left blank.

### 3.3.7 Horizontal Roughness Description

The software's Edit Geometry dialog box allows you to specify horizontal roughness subareas for the current cross section view's ground geometry.

To access the Edit Geometry dialog box, click River tab > Input panel > Horizontal Roughness.

The Section Geometry Editor dialog box allows you to define horizontal Manning's $n$ roughness coefficients for subareas of the current cross section. A Manning's coefficient of 0.0 is not permitted.

When specified, these coefficients replace any Manning's $n$ coefficients specified in the Cross Section Description dialog box. These horizontal subarea roughness coefficients need to be specified only when the generalized Manning's roughness coefficients (i.e., left overbank, channel, and right overbank) cannot adequately define the cross section roughness. Horizontal subarea roughness coefficients should not be specified if channel modifications have been specified for the cross section.

Roughness coefficients remain in effect until changed at a subsequent cross section. They should be redefined for each cross section that has different ground geometry stationing defined.

Roughness coefficients are entered such that they define the subarea to the left (looking downstream) of the corresponding horizontal station (see Figure 3.3.7.1). Each roughness subarea must end at a previously defined ground geometry point.

To add a new roughness subarea, specify the ending (rightmost) ground station either by entering the station directly into the data entry, or select the ground station from the cross section view or topographical map by clicking Pick from the Horizontal Station and Ground Elevation data entries. After selecting an ending station, enter the corresponding Manning's $n$ roughness coefficient in the data entry.

Double-clicking on a row of data shown in the list box immediately moves the data entry cursor to the ground elevation data entry, thereby allowing you to quickly alter the elevation for an existing ground station.
To delete a row of data from the list box, select the data row from the list. Right-click the row, and click Delete Row(s).

![Figure 3.3.7.1 Manning’s roughness coefficient subareas](image)

### 3.4 Defining Bridge and Culvert Openings

When defining bridge or culvert flow structures, the flow structure must be declared at the cross section corresponding to the downstream face of the structure. The flow structure is declared using the Bridge & Culvert Openings dialog box.

To access the Bridge & Culvert Openings dialog box, click River tab > Input panel > Bridges & Culverts drop-down > Bridge & Culvert Openings.

The Bridge & Culvert Openings dialog box defines all of the components that make up the selected flow structure. After selecting the appropriate Cross Section Type, additional buttons become available to define the type of flow structure and its components.

In the Bridge & Culvert Openings dialog box, specify the following parameters:

**Cross Section Type**

Define the downstream face as a Bridge or Culvert. If a flow structure is not declared at this cross section, then this entry must be set to No Opening.

If a Bridge or Culvert structure is specified as the current Cross Section Type, specifying No Opening causes the software to not include the flow structure in the analysis. This allows you to quickly alter a model, without having to change or delete the data used to define the structure. For example, you could remove a flow structure to analyze the unconstricted natural water surface profile at a location. Or, you might want to perform a water surface profile comparative analysis between a bridge and a culvert at the same location.
The bridge and/or culvert structure is declared only at the cross section that corresponds to the downstream face of the structure. For all other related bridge and/or culvert cross sections, this data entry must be set to No Opening.

If specifying a bridge flow structure, then this must be set to Bridge at the cross section corresponding to the downstream face of the bridge structure. Selecting this entry will make additional data entry buttons available, allowing the bridge flow structure components to be defined. All other cross sections at this bridge structure must be set to No Opening.

If specifying a culvert flow structure or a group of culverts, then this must be set to Culvert at the cross section corresponding to the downstream face of the culvert structure. Selecting this entry will make additional data entry buttons available, allowing the culvert flow structure components to be defined. All other cross sections at this culvert structure must be set to No Opening.

**Maximum Number of Flow Structures**

A maximum number of 7 flow structures, of any combination (i.e., bridge, culvert, and/or conveyance flow area), can be defined at a cross section. However, within a culvert flow structure (also called a culvert group—which counts as a single flow structure), up to 25 culvert barrels can be defined.

**Stagnation Points**

Stagnation points are the locations at which flow separates (on the upstream side) from one opening to the next adjacent opening.

![Multiple opening cross section](image)

*Figure 3.4.1 Multiple opening cross section*

The cross section ground geometry starting and ending stations must correspond with that of the starting flow structure’s leftmost station and the ending flow structure’s rightmost station. Also, there cannot be any gap in stationing between flow structures, and in fact stationing between bridges and/or culverts can be allowed to overlap. As shown in the previous image, the right station of the culvert group overlaps with the left station of the bridge opening. When overlapping stationing is defined, HEC-RAS automatically calculates the location of the stagnation point within the defined stationing overlap. This allows the stagnation point to vary from one profile to the next.
However, the interior stationing for a conveyance flow area must be defined to match the adjacent flow structure’s stationing—no overlap is allowed.

### 3.5 Defining the Bridge Low Chord Geometry

The bridge flow structure is specified using the Bridge & Culvert Openings dialog box. The low chord geometry and roadway geometry of a bridge are used to define the bridge flow characteristics. This data must be specified at both the downstream and upstream face bridge cross sections.

To access the Bridge & Culvert Openings dialog box, click River tab > Input panel > Bridges & Culverts > Bridge & Culvert Openings. On the Bridge & Culvert Openings dialog box, select Bridge.

The Bridge & Culvert Openings dialog box allows you to select an input method for defining the bridge low chord geometry. These input methods include the following:

- Entering and editing low chord geometry coordinate points directly in a dialog box
- Drawing the low chord geometry directly on the screen
- Digitizing the low chord geometry from a paper cross section plot

The following sections describe these methods for defining the bridge low chord geometry. To define the bridge low chord geometry, existing ground geometry must already exist at the cross section. If you try to define the bridge low chord geometry and no ground geometry exists at the cross section, an error message describes the problem.

#### 3.5.1 Direct Editing Input Method

The direct edit method displays the Edit Geometry dialog box, which can be used to insert, edit, and delete individual low chord and roadway geometry points of a bridge.

To enter low chord data directly:

1. Select the downstream face cross section for the defined bridge.
2. click River tab > Input panel > Bridges & Culverts > Bridge & Culvert Openings.
3. On the Bridge & Culvert Openings dialog box, select Bridge.
4. Under either Downstream XS or Upstream XS, click Edit Geometry.
   
   The software will display the applicable cross section view and the Section Geometry Editor dialog box.
5. To add a new low chord and/or roadway geometry point, first specify an existing ground station either by entering the station value directly into the data entry, or by clicking Pick to select the ground station from the cross section view or topographical map.
6. After selecting a ground station, enter the low chord and/or roadway elevation into the appropriate data entry, or click Pick to select the elevation from the cross section view.

7. To edit an existing low chord and/or roadway geometry point, select the point from the list box or click Pick to select it from the cross section view. Then modify the elevation value in the appropriate data entry.

8. Double-clicking on a row of data shown in the list box will immediately move the data entry cursor to the ground elevation data entry, thereby allowing you to quickly alter the elevation for an existing ground station.

9. To delete a row of data from the list box, select the data row from the list and click Delete.

3.5.2 Screen Cross Section Input Method

The screen cross section input method allows you to define new low chord geometry on-screen for the currently active cross section view.

To enter low chord geometry on screen:

1. Select the downstream face cross section for the defined bridge.

2. Click River tab > Input panel > Bridges & Culverts > Bridge & Culvert Openings.

3. On the Bridge & Culvert Openings dialog box, select Bridge.

4. Under either Downstream XS or Upstream XS, click Draw Low Chord.

The software displays the applicable cross section view, allowing you to enter new low chord geometry points by clicking anywhere on the grid or by typing in station and elevation coordinates (such as 100,1320, with no spaces).

As you define the bridge low chord geometry using this method, the software makes certain that each low chord station matches an existing ground station. If not, the low chord station value will be updated to match the nearest ground station.

For more precision, you may wish to zoom in, and then pan to move about; you will have greater precision in defining the low chord geometry.

3.5.3 Graphical Adjustment of Low Chord Geometry

You can perform bridge low chord geometry adjustments graphically using grips.

Pick the line representing the bridge low chord with the cursor to move an individual low chord geometry point shown on the cross section view. Pick the point you want to move and drag it to its new location.
**Low Chord Geometry Station Alignment**

It is important to make certain that a moved low chord geometry station matches an existing ground point station. This is because HEC-RAS computes the conveyance for a bridge opening using a series of trapezoids whose vertical sides correspond to the defined low chord and ground geometry stationing.

Autodesk River and Flood Analysis Module, when it generates the data transfer file, automatically checks that the bridge low chord stationing corresponds to the specified cross section ground stationing. If not, a warning message is displayed.

### 3.6 Defining Culverts

A single or group of culvert flow structures is declared using the Bridge & Culvert Openings dialog box. The culvert parameters and roadway geometry define the culvert flow characteristics. The roadway geometry must be specified at both the upstream and downstream face culvert cross sections.

To define culverts:

1. Select the downstream face cross section for the culvert.
2. Click River tab > Input panel > Bridges & Culverts > Bridge & Culvert Openings.
3. On the Bridge & Culvert Openings dialog box, select Culvert.
4. Under either Downstream XS or Upstream XS, click Define.
5. In the Define Culverts dialog box, specify the following parameters:

**Shape**

Specifies a culvert shape, including:

- Circular
- Box (or rectangular)
- Pipe Arch
- Pipe arch
- Ellipse
- Semi-Circle
- Low arch
- High arch
- Conspan Arch

The size of the culvert is defined by entering a rise and span. The rise refers to the maximum inside height of the culvert, while the span represents the maximum inside width. Both circular and semi-circular culverts are defined by entering a diameter.
The inside height (rise) of a culvert opening is important not only in determining the total flow area of the culvert, but also in determining whether the headwater and tailwater elevations are adequate to submerge the inlet or outlet of the culvert.

**Chart Number**

**Scale Number**

Specify the FHWA chart number and FHWA scale number, respectively. The FHWA chart number and scale number refer to a series of nomographs published in 1965 by the Bureau of Public Roads (now called the Federal Highway Administration). These nomographs allowed the inlet control headwater to be computed for different types of culverts operating under a wide range of flow conditions. These nomographs, and others constructed using the original methods, were republished in 1985 (FHWA, 1985).

Table 3.6.1 lists the FHWA chart and scale numbers for pipe culverts.
Table 3.6.2 lists the FHWA chart and scale numbers for box culverts.
Table 3.6.3 lists the FHWA chart and scale numbers for additional culverts.

**Table 3.6.1 FHWA Chart and Scale Numbers for Pipe Culverts (FHWA, 1985)**

<table>
<thead>
<tr>
<th>Description</th>
<th>Chart Number</th>
<th>Scale Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Concrete Pipe Culvert</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Square edge entrance with headwall (see Figure 3.6.3)</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Groove end entrance with headwall (see Figure 3.6.3)</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Groove end entrance, pipe projecting from fill (see Figure 3.6.5)</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td><strong>Corrugated Metal Pipe Culvert</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Headwall (see Figure 3.6.3)</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Mitered to conform to slope (see Figure 3.6.4)</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Pipe projecting from fill (see Figure 3.6.5)</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td><strong>Concrete Pipe Culvert, Beveled Ring Entrance</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Small bevel (see Figure 3.6.6)</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>(b/D = 0.042)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(a/D = 0.063)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(c/D = 0.042)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(d/D = 0.083)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Large bevel (see Figure 3.6.6)</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>(b/D = 0.083)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(a/D = 0.125)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(c/D = 0.042)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(d/D = 0.125)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Chart Number</td>
<td>Scale Number</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td><strong>Box Culvert with Flared Wingalls</strong> (see Figure 3.6.7)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wingwalls flared 30° to 75°</td>
<td>8</td>
<td>1</td>
</tr>
<tr>
<td>Wingwalls flared 90° or 15°</td>
<td>8</td>
<td>2</td>
</tr>
<tr>
<td>Wingwalls not flared (sides extended straight)</td>
<td>8</td>
<td>3</td>
</tr>
<tr>
<td><strong>Box Culvert with Flared Wingwalls and Inlet Top Edge Bevel</strong> (see Figure 3.6.7 and Figure 3.6.8)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wingwall flared 45°, inlet top edge bevel = 0.43D</td>
<td>9</td>
<td>1</td>
</tr>
<tr>
<td>Wingwall flared 18° to 33.7°, inlet top edge bevel = 0.083D</td>
<td>9</td>
<td>2</td>
</tr>
<tr>
<td><strong>Box Culvert, 90° Headwall, Chamfered or Beveled Inlet Edges</strong> (see Figure 3.6.9)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inlet edges chamfered 3/4 inch</td>
<td>10</td>
<td>1</td>
</tr>
<tr>
<td>Inlet edges beveled 1/2 in/ft at 45° (1:1)</td>
<td>10</td>
<td>2</td>
</tr>
<tr>
<td>Inlet edges beveled 1 in/ft at 33.7° (1:1.5)</td>
<td>10</td>
<td>2</td>
</tr>
<tr>
<td><strong>Box Culvert, Skewed Headwall, Chamfered or Beveled Inlet Edges</strong> (see Figure 3.6.10)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Headwall skewed 45°, inlet edges chamfered 3/4 inch</td>
<td>11</td>
<td>1</td>
</tr>
<tr>
<td>Headwall skewed 30°, inlet edges chamfered 3/4 inch</td>
<td>11</td>
<td>2</td>
</tr>
<tr>
<td>Headwall skewed 15°, inlet edges chamfered 3/4 inch</td>
<td>11</td>
<td>3</td>
</tr>
<tr>
<td>Headwall skewed 15° to 45°, inlet edges beveled</td>
<td>11</td>
<td>4</td>
</tr>
<tr>
<td><strong>Box Culvert, Non-Offset Flared Wingwalls, 3/4 inch Chamfer at Top of Inlet</strong> (see Figure 3.6.11)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wingwalls flared 45° (1:1), inlet not skewed</td>
<td>12</td>
<td>1</td>
</tr>
<tr>
<td>Wingwalls flared 18.4° (3:1), inlet not skewed</td>
<td>12</td>
<td>2</td>
</tr>
<tr>
<td>Wingwalls flared 18.4° (3:1), inlet skewed 30°</td>
<td>12</td>
<td>3</td>
</tr>
<tr>
<td><strong>Box Culvert, Offset Flared Wingwalls, Beveled Edge at Top of Inlet</strong> (see Figure 3.6.12)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wingwalls flared 45° (1:1), inlet top edge bevel = 0.042D</td>
<td>13</td>
<td>1</td>
</tr>
<tr>
<td>Wingwalls flared 33.7° (1.5:1), inlet top edge bevel = 0.083D</td>
<td>13</td>
<td>3</td>
</tr>
<tr>
<td>Wingwalls flared 18.4° (3:1), inlet top edge bevel = 0.083D</td>
<td>13</td>
<td>4</td>
</tr>
<tr>
<td><strong>Corrugated Metal Box Culvert</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90° headwall</td>
<td>16 - 19</td>
<td>1</td>
</tr>
<tr>
<td>Thick wall projecting</td>
<td>16 - 19</td>
<td>2</td>
</tr>
<tr>
<td>Thin wall projecting</td>
<td>16 - 19</td>
<td>3</td>
</tr>
<tr>
<td>Description</td>
<td>Chart Number</td>
<td>Scale Number</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------</td>
<td>--------------</td>
<td>--------------</td>
</tr>
<tr>
<td><strong>Horizontal Ellipse; Concrete</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Square with headwall</td>
<td>29</td>
<td>1</td>
</tr>
<tr>
<td>Grooved end with headwall</td>
<td>29</td>
<td>2</td>
</tr>
<tr>
<td>Grooved end projecting</td>
<td>29</td>
<td>3</td>
</tr>
<tr>
<td><strong>Vertical Ellipse; Concrete</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Square edge with headwall</td>
<td>30</td>
<td>1</td>
</tr>
<tr>
<td>Grooved end with headwall</td>
<td>30</td>
<td>2</td>
</tr>
<tr>
<td>Grooved end projecting</td>
<td>30</td>
<td>3</td>
</tr>
<tr>
<td><strong>Pipe Arch; 18° Corner Radius; Corrugated Metal</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90° headwall</td>
<td>34</td>
<td>1</td>
</tr>
<tr>
<td>Mitered to slope</td>
<td>34</td>
<td>2</td>
</tr>
<tr>
<td>Projecting</td>
<td>34</td>
<td>3</td>
</tr>
<tr>
<td><strong>Pipe Arch; 18° Corner Radius; Corrugated Metal</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Projecting</td>
<td>35</td>
<td>1</td>
</tr>
<tr>
<td>No bevels</td>
<td>35</td>
<td>2</td>
</tr>
<tr>
<td>33.7° bevels</td>
<td>35</td>
<td>3</td>
</tr>
<tr>
<td><strong>Pipe Arch; 31° Corner Radius; Corrugated Metal</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Projecting</td>
<td>36</td>
<td>1</td>
</tr>
<tr>
<td>No bevels</td>
<td>36</td>
<td>2</td>
</tr>
<tr>
<td>33.7° bevels</td>
<td>36</td>
<td>3</td>
</tr>
<tr>
<td><strong>Arch; Corrugated Metal</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90 headwall</td>
<td>41 - 43</td>
<td>1</td>
</tr>
<tr>
<td>Mitered to slope</td>
<td>41 - 43</td>
<td>2</td>
</tr>
<tr>
<td>Thin wall projecting</td>
<td>41 - 43</td>
<td>3</td>
</tr>
<tr>
<td><strong>Circular Culvert</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smooth tapered inlet throat</td>
<td>55</td>
<td>1</td>
</tr>
<tr>
<td>Rough tapered inlet throat</td>
<td>55</td>
<td>2</td>
</tr>
<tr>
<td><strong>Elliptical Inlet Face</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tapered inlet; Beveled edges</td>
<td>56</td>
<td>1</td>
</tr>
<tr>
<td>Tapered inlet; Square edges</td>
<td>56</td>
<td>2</td>
</tr>
<tr>
<td>Tapered inlet; Thin edge projecting</td>
<td>56</td>
<td>3</td>
</tr>
<tr>
<td><strong>Rectangular</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tapered inlet throat</td>
<td>57</td>
<td>1</td>
</tr>
<tr>
<td><strong>Rectangular Concrete</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Side tapered; Less favorable edges</td>
<td>58</td>
<td>1</td>
</tr>
<tr>
<td>Side tapered; More favorable edges</td>
<td>58</td>
<td>2</td>
</tr>
<tr>
<td><strong>Rectangular Concrete</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slope tapered; Less favorable edges</td>
<td>59</td>
<td>1</td>
</tr>
<tr>
<td>Slope tapered; More favorable edges</td>
<td>59</td>
<td>2</td>
</tr>
</tbody>
</table>
Figure 3.6.1 Pipe culvert cross section

Figure 3.6.2 Box culvert cross section

Figure 3.6.3 Culvert inlet with headwall and wingwalls (FHWA Chart 1 and Chart 2)
**Figure 3.6.4** Culvert inlet mitered to conform to slope (FHWA Chart 2)

**Figure 3.6.5** Culvert inlet projecting from fill (FHWA Chart 1 and Chart 2)

**Figure 3.6.6** Culvert inlet with beveled ring entrance (FHWA Chart 3)
Figure 3.6.7 Flared wingwalls (FHWA Chart 8 and Chart 9)

Figure 3.6.8 Inlet top edge bevel (FHWA Chart 9)

Figure 3.6.9 Inlet side and top edge bevel with 90° headwall (FHWA Chart 10)
Figure 3.6.10 Inlet side and top edge bevel with skewed headwall (FHWA Chart 11)

Figure 3.6.11 Non-offset flared wingwalls (FHWA Chart 12)
Solution Criteria
Specifies which culvert solution to use when computing the flow through a culvert. It is recommended that the default Highest Upstream Energy Elevation be selected.

The analysis of flow in culverts is quite complicated. It is common to use the concept of inlet control and outlet control to simplify the analysis. Inlet control flow occurs when the flow capacity of the culvert entrance is less than the flow capacity of the culvert barrel. The control section of a culvert operating under inlet control is located just inside of the culvert entrance. The water surface passes through critical depth at or near this location and the flow regime immediately downstream is supercritical. Outlet control flow occurs when the culvert flow capacity is limited by downstream conditions (e.g., high tailwater) or by the flow carrying capacity of the culvert barrel. HEC-RAS computes the upstream energy required to produce a given flow rate through the culvert for both inlet and outlet control conditions. By selecting the Highest Upstream Energy Elevation, the higher upstream energy gradeline elevation controls and thereby determines the type of culvert flow for a given flow rate and tailwater condition.

Centerline Stationing
Defines multiple culverts, each with a different centerline station. Each culvert can have a different downstream and upstream station value. However, these culverts must have identical shape, size, invert elevations, and loss coefficients. Multiple culverts defined this way are called a culvert group.

To add a new culvert to the Culvert Details list, enter the corresponding downstream and upstream centerline stations into the data entries and click Add. To change a culvert stationing entry, select the appropriate entry from the Culvert Details list, and then enter the new values. To delete a culvert, select the appropriate entry from the Culvert Details list and click Delete. To copy a specified centerline station, select the appropriate entry from the Culvert Details list and click Copy.
**Diameter or Height**

Specify the inside diameter of a pipe culvert or the inside height of a box culvert (see Figure 3.6.1 and Figure 3.6.2).

The inside height (or diameter) of the culvert opening is important not only in determining the total flow area of the culvert, but also in determining whether the headwater and tailwater elevations are adequate to submerge the inlet or outlet of the culvert.

Click Pick to graphically measure the culvert diameter or height.

**Width or Span**

Specifies the inside width of the box culvert. If multiple box culverts exist, enter the width of only a single box culvert, not the accumulated width of all the culverts. If analyzing a pipe culvert, leave this entry blank.

Most box culverts have chamfered corners on the inside. These chamfers are ignored by HEC-RAS in computing the cross sectional area of the culvert opening. Some manufacturers’ literature contains the true cross sectional area of each size box culvert, considering the reduction in area caused by the chamfered corners. If you wish to consider the loss in area due to the chamfers, you should reduce the box culvert opening width. You should not reduce the box culvert height, because the software uses the culvert height to determine the submergence of the culvert inlet and outlet.

Click Pick to graphically measure the culvert opening width.

**Distance to Upstream XS**

Specify the distance to the cross section immediately upstream.

Click Pick to graphically measure the distance.

**Culvert Downstream Invert**

Specifies the culvert opening downstream invert elevation (see Figure 3.6.1 and Figure 3.6.2).

Click Pick to graphically select the culvert opening downstream invert elevation from the cross section view.

The software uses this value to compute the culvert slope. This slope is then used to compute the normal depth of flow in the culvert under inlet control conditions.

HEC-RAS cannot analyze culverts with adverse (negative) slopes. Therefore, the downstream invert elevation must be equal to or less than the upstream invert elevation so that some flow velocity can be maintained in the culvert, even under low flow conditions. A sufficient slope to maintain a minimum flow velocity of three feet per second (or one meter per second) is often required.

**Culvert Length**

Specifies the culvert length. The culvert length is measured along the centerline of the culvert. The culvert length is used to determine the friction loss in the culvert barrel and the slope of the culvert.
Click Pick to graphically measure the length of the culvert.

**Downstream Invert**

Specifies the culvert opening downstream invert elevation (see Figure 3.6.1 and Figure 3.6.2).

Click Pick to graphically select the culvert opening downstream invert elevation from the cross section view.

The software uses this value to compute the culvert slope. This slope is then used to compute the normal depth of flow in the culvert under inlet control conditions.

HEC-RAS cannot analyze culverts with adverse (negative) slopes. Therefore, the downstream invert elevation must be equal to, or greater than, the upstream invert elevation so that some flow velocity can be maintained in the culvert, even under low flow conditions. A sufficient slope to maintain a minimum flow velocity of three feet per second (or one meter per second) is often required.

**Upstream Invert**

Specifies the culvert opening upstream invert elevation (see Figure 3.6.1 and Figure 3.6.2).

Click Pick to graphically select the culvert opening upstream invert elevation from the cross section view.

The software uses this value to compute the culvert slope. This slope is then used to compute the normal depth of flow in the culvert under inlet control conditions.

HEC-RAS cannot analyze culverts with adverse (negative) slopes. Therefore, the upstream invert elevation must be equal to, or greater than, the upstream invert elevation so that some flow velocity can be maintained in the culvert, even under low flow conditions. A sufficient slope to maintain a minimum flow velocity of three feet per second (or one meter per second) is often required.

**Entrance Loss Coefficient**

Specifies the culvert entrance loss coefficient to be used in computing the head loss at the culvert entrance.

The coefficient entered in this data entry will be multiplied by the change in velocity head inside the culvert at the upstream end. This value represents the amount of energy loss that occurs as flow enters the culvert.

Table 3.6.4 and Table 3.6.5 list some suggested values for culvert entrance loss coefficients.
Table 3.6.4 Entrance Loss Coefficients, $k_e$, for Reinforced Concrete Box Culverts (Bureau of Public Roads, 1958)

<table>
<thead>
<tr>
<th>Type of Culvert and Design of Entrance</th>
<th>$k_e$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box Culvert (headwall parallel to embankment — no wingwalls)</td>
<td></td>
</tr>
<tr>
<td>Rounded edges, radius 1/12 of barrel dimension</td>
<td>0.20</td>
</tr>
<tr>
<td>Square edge on three edges</td>
<td>0.50</td>
</tr>
<tr>
<td>Box Culvert (wingwalls at 30° to 75° to barrel)</td>
<td></td>
</tr>
<tr>
<td>Rounded crown edges, radius 1/12 of barrel dimension</td>
<td>0.20</td>
</tr>
<tr>
<td>Square edge crown</td>
<td>0.40</td>
</tr>
<tr>
<td>Box Culvert (wingwalls at 10° to 25° to barrel)</td>
<td></td>
</tr>
<tr>
<td>Square edge crown</td>
<td>0.50</td>
</tr>
<tr>
<td>Box Culvert (wingwalls parallel to culvert)</td>
<td></td>
</tr>
<tr>
<td>Side or slope tapered inlet</td>
<td>0.20</td>
</tr>
<tr>
<td>Square edge crown</td>
<td>0.70</td>
</tr>
</tbody>
</table>

Table 3.6.5 Entrance Loss Coefficients, $k_e$, for Pipe Culverts (Bureau of Public Roads, 1958)

<table>
<thead>
<tr>
<th>Type of Culvert and Design of Entrance</th>
<th>$k_e$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reinforced Concrete Pipe Culvert</td>
<td></td>
</tr>
<tr>
<td>Beveled edges, 33.7 to 45 degree bevel</td>
<td>0.20</td>
</tr>
<tr>
<td>Side slope tapered inlet</td>
<td>0.20</td>
</tr>
<tr>
<td>Projecting from fill, socket pipe end</td>
<td>0.20</td>
</tr>
<tr>
<td>Projecting from fill, square cut pipe end</td>
<td>0.50</td>
</tr>
<tr>
<td>End-section conforming to fill slope</td>
<td>0.50</td>
</tr>
<tr>
<td>Mitered to conform to fill slope</td>
<td>0.70</td>
</tr>
<tr>
<td>Concrete Pipe with Headwall or Headwall and Wingwalls</td>
<td></td>
</tr>
<tr>
<td>Socket end of pipe</td>
<td>0.20</td>
</tr>
<tr>
<td>Rounded entrance, radius 1/12 of barrel dimension</td>
<td>0.20</td>
</tr>
<tr>
<td>Square cut end of pipe</td>
<td>0.50</td>
</tr>
<tr>
<td>Corrugated Metal Pipe</td>
<td></td>
</tr>
<tr>
<td>Beveled edges, 33.7 to 45 degree bevel</td>
<td>0.20</td>
</tr>
<tr>
<td>Side slope tapered inlet</td>
<td>0.20</td>
</tr>
<tr>
<td>Headwall, square edge</td>
<td>0.50</td>
</tr>
<tr>
<td>Headwall and wingwalls, square edge</td>
<td>0.50</td>
</tr>
<tr>
<td>End-section conforming to fill slope</td>
<td>0.50</td>
</tr>
<tr>
<td>Mitered to conform to fill slope</td>
<td>0.70</td>
</tr>
<tr>
<td>Projecting from fill (no headwall)</td>
<td>0.90</td>
</tr>
</tbody>
</table>

Exit Loss Coefficient

Specifies the culvert exit loss coefficient to be used in computing the head loss at the culvert outlet.

The coefficient entered in this data entry is multiplied by the change in velocity head from inside the culvert at the downstream end to outside the culvert at the downstream end. This value represents the amount of energy loss that occurs as flow exits the culvert.

In general, exit loss coefficients can vary between 0.3 and 1.0. For a sudden expansion of flow, such as in a typical culvert, the exit loss coefficient is normally set to 1.0. The exit loss coefficient should be reduced as the transition becomes less abrupt.
Manning’s n for Top
Manning’s n for Bottom

Specifies the Manning’s roughness coefficient to be used in the friction loss calculations.

Table 3.6.6 and Table 3.6.7 list some suggested values for culvert Manning's roughness coefficients. The culvert roughness coefficient selected should be adjusted to account for the condition of the culvert.

**Table 3.6.6 Manning’s Roughness Coefficients for Corrugated Metal Pipe (from American Iron and Steel Institute Modern Sewer Design)**

<table>
<thead>
<tr>
<th>Type of Pipe and Diameter</th>
<th>Unpaved</th>
<th>Paved 25%</th>
<th>Paved 100%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helical 1.50 x 1/4 inch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8 inch diameter</td>
<td>0.012</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 inch diameter</td>
<td>0.014</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Annular 2.67 x 1/2 inch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>All diameters</td>
<td>0.024</td>
<td>0.021</td>
<td>0.021</td>
</tr>
<tr>
<td>Helical 2.67 x 1/2 inch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12 inch diameter</td>
<td>0.011</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18 inch diameter</td>
<td>0.014</td>
<td></td>
<td></td>
</tr>
<tr>
<td>24 inch diameter</td>
<td>0.016</td>
<td>0.015</td>
<td>0.012</td>
</tr>
<tr>
<td>36 inch diameter</td>
<td>0.019</td>
<td>0.017</td>
<td>0.012</td>
</tr>
<tr>
<td>48 inch diameter</td>
<td>0.020</td>
<td>0.020</td>
<td>0.012</td>
</tr>
<tr>
<td>60 inch diameter</td>
<td>0.021</td>
<td>0.019</td>
<td>0.012</td>
</tr>
<tr>
<td>Annular 3 x 1 inch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>All diameters</td>
<td>0.027</td>
<td>0.023</td>
<td>0.012</td>
</tr>
<tr>
<td>Helical 3 x 1 inch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48 inch diameter</td>
<td>0.023</td>
<td>0.020</td>
<td>0.012</td>
</tr>
<tr>
<td>54 inch diameter</td>
<td>0.023</td>
<td>0.020</td>
<td>0.012</td>
</tr>
<tr>
<td>60 inch diameter</td>
<td>0.024</td>
<td>0.021</td>
<td>0.012</td>
</tr>
<tr>
<td>66 inch diameter</td>
<td>0.025</td>
<td>0.022</td>
<td>0.012</td>
</tr>
<tr>
<td>72 inch diameter</td>
<td>0.026</td>
<td>0.022</td>
<td>0.012</td>
</tr>
<tr>
<td>78 inch and larger diameter</td>
<td>0.027</td>
<td>0.023</td>
<td>0.012</td>
</tr>
<tr>
<td>Corrugations 6 x 2 inch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60 inch diameter</td>
<td>0.033</td>
<td>0.028</td>
<td></td>
</tr>
<tr>
<td>72 inch diameter</td>
<td>0.032</td>
<td>0.027</td>
<td></td>
</tr>
<tr>
<td>120 inch diameter</td>
<td>0.030</td>
<td>0.026</td>
<td></td>
</tr>
<tr>
<td>180 inch diameter</td>
<td>0.028</td>
<td>0.024</td>
<td></td>
</tr>
<tr>
<td>Type of Channel and Diameter</td>
<td>Minimum</td>
<td>Normal</td>
<td>Maximum</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------</td>
<td>--------</td>
<td>---------</td>
</tr>
<tr>
<td>Brass</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smooth</td>
<td>0.009</td>
<td>0.010</td>
<td>0.013</td>
</tr>
<tr>
<td>Steel</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Locbard and welded</td>
<td>0.010</td>
<td>0.012</td>
<td>0.014</td>
</tr>
<tr>
<td>Riveted and spiral</td>
<td>0.013</td>
<td>0.016</td>
<td>0.017</td>
</tr>
<tr>
<td>Cast Iron</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coated</td>
<td>0.010</td>
<td>0.013</td>
<td>0.014</td>
</tr>
<tr>
<td>Uncoated</td>
<td>0.011</td>
<td>0.014</td>
<td>0.016</td>
</tr>
<tr>
<td>Wrought Iron</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Black</td>
<td>0.012</td>
<td>0.014</td>
<td>0.015</td>
</tr>
<tr>
<td>Galvanized</td>
<td>0.013</td>
<td>0.016</td>
<td>0.017</td>
</tr>
<tr>
<td>Corrugated Metal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subdrain</td>
<td>0.017</td>
<td>0.019</td>
<td>0.021</td>
</tr>
<tr>
<td>Storm Drain</td>
<td>0.021</td>
<td>0.024</td>
<td>0.030</td>
</tr>
<tr>
<td>Lucite</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smooth</td>
<td>0.008</td>
<td>0.009</td>
<td>0.010</td>
</tr>
<tr>
<td>Glass</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smooth</td>
<td>0.009</td>
<td>0.010</td>
<td>0.013</td>
</tr>
<tr>
<td>Cement</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Neat, surface</td>
<td>0.010</td>
<td>0.011</td>
<td>0.013</td>
</tr>
<tr>
<td>Mortar</td>
<td>0.011</td>
<td>0.013</td>
<td>0.015</td>
</tr>
<tr>
<td>Concrete</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Culvert, straight and free of debris</td>
<td>0.010</td>
<td>0.011</td>
<td>0.013</td>
</tr>
<tr>
<td>Culvert with bends, connections, debris</td>
<td>0.011</td>
<td>0.013</td>
<td>0.014</td>
</tr>
<tr>
<td>Finished</td>
<td>0.011</td>
<td>0.012</td>
<td>0.014</td>
</tr>
<tr>
<td>Sewer with manholes, inlet, etc.</td>
<td>0.013</td>
<td>0.015</td>
<td>0.017</td>
</tr>
<tr>
<td>Unfinished, steel form</td>
<td>0.012</td>
<td>0.013</td>
<td>0.014</td>
</tr>
<tr>
<td>Unfinished, smooth wood form</td>
<td>0.012</td>
<td>0.014</td>
<td>0.016</td>
</tr>
<tr>
<td>Unfinished, rough wood form</td>
<td>0.015</td>
<td>0.017</td>
<td>0.020</td>
</tr>
<tr>
<td>Wood</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stave</td>
<td>0.010</td>
<td>0.012</td>
<td>0.014</td>
</tr>
<tr>
<td>Laminated, treated</td>
<td>0.015</td>
<td>0.017</td>
<td>0.020</td>
</tr>
<tr>
<td>Clay</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Common drainage tile</td>
<td>0.011</td>
<td>0.013</td>
<td>0.017</td>
</tr>
<tr>
<td>Vitrified sewer</td>
<td>0.011</td>
<td>0.014</td>
<td>0.017</td>
</tr>
<tr>
<td>Vitrified sewer with manholes, inlet, etc.</td>
<td>0.013</td>
<td>0.015</td>
<td>0.017</td>
</tr>
<tr>
<td>Vitrified subdrain with open joint</td>
<td>0.014</td>
<td>0.016</td>
<td>0.018</td>
</tr>
<tr>
<td>Brickwork</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Glazed</td>
<td>0.011</td>
<td>0.013</td>
<td>0.015</td>
</tr>
<tr>
<td>Lined with cement mortar</td>
<td>0.012</td>
<td>0.015</td>
<td>0.017</td>
</tr>
<tr>
<td>Sanitary sewer with sewage slime, bends, connections, etc.</td>
<td>0.012</td>
<td>0.013</td>
<td>0.016</td>
</tr>
<tr>
<td>Paved invert, sewer, smooth bottom</td>
<td>0.016</td>
<td>0.019</td>
<td>0.020</td>
</tr>
<tr>
<td>Rubble masonry, cemented</td>
<td>0.018</td>
<td>0.025</td>
<td>0.030</td>
</tr>
</tbody>
</table>
3.7 Other Bridge Data

The following sections describe additional data used to define a bridge.

3.7.1 Bridge Computation Methodology

The Bridge Computation Methodology dialog box allows you to specify the computation method to be used in computing Class A low flow conditions and high flow conditions (flow at or above the maximum low chord elevation). The Bridge Computation Methodology dialog box is displayed when you click Methodology on the Bridge & Culvert Openings dialog box when defining a bridge flow structure.

Class A Low Flow Computation Method (optional)
Instrusts the software to use a particular low flow computation method answer when computing Class A low flow conditions. By default, the Highest Energy Answer is used and only the Energy computation method is used. Selecting WSPRO Method and then clicking Define will display the WSPRO Bridge Parameters dialog box (see the following section titled WSPRO Bridge Parameters), which allows you to define data for the WSPRO bridge computational method.

Select any of the appropriate Compute options to enable HEC-RAS to compute any or all of the low flow answers.

Pier Drag Coefficient
If the Momentum computation method is to be used in computing Class A low flows, then you must specify the drag coefficient to be used in calculating pier losses in the momentum equations.

Click [...] to display a table that lists the typical drag coefficients for various pier shapes.

If this entry is left blank and a pier geometry is specified, then the software will use the drag coefficient associated with square piers.

Pier Shape Coefficient
If the Yarnell computation method is to be used in computing Class A low flows, then you must specify the pier shape coefficient.

Click [...] to display a table that lists the typical drag coefficients for various pier shapes.

High Flow Computation Method
Instrusts the software to use a particular high flow computation method when computing high flow conditions (i.e., when the bridge low chord is submerged). By default the Pressure and Weir computation method is selected, since this represents typical roadway overflow situations.

The Energy computation method selection uses only the energy based method (in the same manner as is computed for low flows) to compute the high flows—and is generally only used in severe roadway overtopping situations where weir flow is submerged.
The Pressure and Weir computation method selection uses separate hydraulic equations to compute the flow as pressure and/or weir flow.

**Submerged Inlet Discharge Coefficient (optional)**
Specifies the coefficient of discharge for submerged inlet pressure flow. This discharge coefficient can vary depending upon the depth of water upstream. Values can range from 0.35 to 0.5, with a value of 0.5 commonly used in practice. You can enter a fixed value for this coefficient or the software will compute one based on the amount that the inlet is submerged. This discharge coefficient is not used in the energy based computation method.

**Submerged Inlet and Outlet Discharge Coefficient (optional)**
Specifies the coefficient of discharge for both submerged inlet and outlet pressure flow. When both the upstream and downstream sides of the bridge are submerged, the standard full flowing orifice equation is used. This discharge coefficient can range from 0.7 to 0.9, with a value of 0.8 commonly used in practice. You can enter a fixed value for this coefficient or the software will compute one based on the amount that the inlet is submerged. This discharge coefficient is not used in the energy based computation method.

**Pressure Flow Trigger Elevation (optional)**
Overrides the maximum low chord elevation to be used by the software when checking for the possibility of pressure flow.

The software checks for the possibility of pressure flow when the computed low flow energy gradeline elevation is above the maximum low chord elevation at the upstream side of the bridge. If this energy gradeline elevation is above the maximum low chord elevation, then the pressure flow water surface elevation is computed. Next, the pressure flow water surface elevation is compared to the low flow water surface elevation and the higher of the two elevations is assumed to control. This data entry thereby allows you to specify a higher (or lower) trigger elevation to be used (in place of the maximum low chord elevation) to initiate the pressure flow water surface elevation calculation.

### 3.7.2 WSPRO Bridge Parameters

The WSPRO Bridge Parameters dialog box allows you to define data for the WSPRO bridge computational method.

To access the WSPRO Bridge Parameters dialog box:

1. Click River tab > Input panel > Bridges & Culverts > Bridge & Culvert Openings.
2. On the Bridge and Culvert Openings dialog box, select Bridge. Click Methodology.
3. On the Bridge Computation Methodology dialog box, select WSPRO Method. Click Define.
4. In the WSPRO Bridge Parameters dialog box, enter the following parameters:
Abutment Type
Specifies the bridge abutment type. There are four abutment types available:

- Vertical abutments and embankments with or without wing walls
- Vertical abutments and sloping embankments
- Sloping abutments and sloping embankments
- Vertical abutments and sloping embankments with wing walls

Abutment Slope
Specifies the bridge abutment slope. This slope is taken as the horizontal distance divided by the vertical distance. If the bridge abutments are vertical, then this field is not available. If the left and right bridge abutments do not have the same slope, use the average of the two slopes.

Embankment Top Width
Specifies the top of the road embankment width, in the area of the bridge opening. If the top width of the embankment varies from one end of the bridge opening to the other, use the average of the two widths. Click Pick to measure the embankment top width from the surface.

Centroid Stationing of Projected Bridge Opening at the Approach Cross Section
For the WSPRO computational method, it is necessary to calculate the water surface top width inside of the bridge opening, and then project that width onto the approach cross section. HEC-RAS computes the conveyance within this projected width at the approach cross section. This conveyance is used in calculating a channel contraction ratio, which is an integral part in the calculation of the WSPRO bridge discharge coefficient.

If this field is left blank, the software automatically centers the computed top width, such that the center of the top width will be at the center of conveyance at the approach cross section. You can override this by entering a known centroid stationing value for the approach cross section. Click Pick to define the centroid station graphically.

Left Embankment Top Elevation
Right Embankment Top Elevation
Specify the top of the embankment (i.e., top of road) elevation at the edges of the bridge opening. An elevation must be entered for both the left and right side of the bridge opening. Click Pick to define the embankment top elevation by selecting it from the cross section view.

Left Embankment Toe Elevation
Right Embankment Toe Elevation
Specify the abutment toe (elevation at the station in which the abutment toe intersections with the natural ground inside of the bridge opening) elevation on both the left and right side of the bridge opening. Click Pick to define the embankment toe elevation by selecting it from the cross section view.

Wing Wall Type
Specifies the type of wing walls present at the bridge opening. This list affects the availability of some of the wing wall data entries that are contained in this section.
Wing Wall Angle
Specifies the angle of the wing wall, measured relative to the flow direction.

Wing Wall Length
Specifies the length of the wing wall, measured starting from the bridge abutment. Click to measure the wing wall length from the surface.

Entrance Rounding Radius
Specifies the entrance rounding radius, if the wing wall entrance is rounded. Click Pick to measure the wing wall entrance rounding radius from the surface.

Guide Bank Type
Specifies the type of guide bank present at the bridge opening. This list affects the availability of some of the guide bank data entries that are contained in this section.

Guide Bank Length
Specifies the length of the guide bank, measured starting from the bridge abutment. Click Pick to measure the guide bank length from the surface.

Guide Bank Offset
Specifies the offset of the guide bank, measured relative to the bridge opening. Click Pick to measure the guide bank offset from the cross section view.

Guide Bank Skew Angle
Specifies the skew angle of the guide bank, measured relative to the flow direction.

Optional Contraction and Expansion Losses
These options allow you to specify additional contraction and expansion losses to be computed at locations that are not traditionally in the standard WSPRO bridge methodology. The standard WSPRO bridge method only computes expansion losses in the expansion reach (between the bridge downstream face cross section and the exit cross section). Do not specify these additional losses unless you believe that the standard WSPRO bridge method is not producing enough energy loss through the bridge.

Piers are Continuous for the Width of Bridge
Specifies whether the piers are continuous for the whole way through the bridge. This is selected by default.

Use Geometric Mean as Friction Slope Method
Specifies whether to use the Geometric Mean as the friction slope method. This is selected by default.

3.7.3 Global Bridge Parameters
The Bridge Parameters dialog box allows you to specify additional parameters to be used when computing flow through a bridge. Note that these parameters apply for all bridges defined within the model.

To access the WSPRO Bridge Parameters dialog box:
1. Click River tab > Input panel > Bridges & Culverts > Bridge & Culvert Openings.

2. On the Bridge and Culvert Openings dialog box, select Bridge. Click Parameters.

**Momentum Equation (optional)**
Specify additional loss components to add to the momentum equation when computing Class A low flow. Since the weight component does not generally add much in terms of additional momentum losses, it is not selected by default. However, the friction component is selected by default.

**Critical Depth Location**
Specifies the overridden cross section the critical depth is to be computed for determining whether Class B low flow exists. By default, the critical depth will be computed at the upstream end of the bridge opening.

**Pressure Flow Criteria**
Specifies the overridden cross section when pressure flow calculations are to be initiated.

By default, the software checks for the possibility of pressure flow when the computed low flow energy gradeline elevation is above the maximum low chord elevation at the upstream side of the bridge. If this energy gradeline elevation is above the maximum low chord elevation, the pressure flow water surface elevation is computed. Then, the pressure flow water surface elevation is compared to the low flow water surface elevation and the higher of the two elevations is assumed to control. However, this data entry allows you to specify that the computed water surface elevation should be used in place of the computed energy gradeline elevation for determining when pressure flow calculations are to be initiated.

**Note**
Whenever Class B low flow is found to exist in a model, you should run the model in a mixed flow regime mode. The mixed flow regime mode is capable of calculating a subcritical profile upstream of the bridge and a supercritical profile downstream from the bridge. Also, any hydraulic jumps will be located, if they exist. This option is specified in the Profile Description dialog box.

**3.7.4 Bridge Pier Description**
The Define Piers dialog box allows you to specify centerline locations and dimensions for each individual bridge pier.

The HEC-RAS low flow bridge computations require that the piers be defined separately in order to determine the amount of area under the water surface that is blocked by piers. If the piers are included with ground or low chord geometry, several of HEC-RAS’ low flow computational methods will incorrectly compute the amount of energy loss.

To access the Define Piers dialog box:
1. Click River tab > Input panel > Bridges & Culverts > Bridge & Culvert Openings.

2. On the Bridge and Culvert Openings dialog box, select Bridge. Click Piers.

**Pier Centerline Stationing**
Defines the downstream and upstream centerline station locations for each bridge pier. Each pier has associated with it dimensions, defined in the Pier Obstruction Dimensions table, that define the elevation and corresponding width for both the downstream and upstream ends of the pier. Scrolling through the listed piers, the elevation-width pairs listed in the Pier Obstruction Dimensions table will change.

**Pier Obstruction Dimensions**
Defines the geometry for a single bridge pier. The geometry of the bridge pier is entered as elevation and width paired values for both the downstream and upstream ends of the pier.

### Pier Geometry Considerations
Pier geometry is entered as pier elevation and width valued pairs. The geometry values will automatically be placed in the pier geometry table, sorted based upon elevation. Generally, pier elevations start below the ground level. Any pier area below the ground elevation or above the low chord elevation (but less than the roadway elevation) is clipped off automatically. Pier widths that change at a single elevation (e.g., such as at a pier footing, pier armored protection, or pier cap) are entered by specifying two widths at the same elevation.

If the pier width is to vary uniformly over the elevation range between two pier elevation-width entries, HEC-RAS linearly interpolates the width of the pier between the two elevations.

#### 3.7.5 Bridge Abutment Description
The Define Abutments dialog box allows you to specify bridge abutment geometry whenever bridge abutments protrude out from the defined ground geometry. This allows you to further restrict the channel geometry to accurately represent the available bridge opening flow area.

Generally, a left and right abutment are entered for each bridge opening at both the bridge downstream and upstream cross sections. However, this data is optional, and is only necessary when the cross section channel geometry does not adequately define the bridge opening geometry.

To access the Define Abutments dialog box:

1. Click River tab > Input panel > Bridges & Culverts > Bridge & Culvert Openings.

2. On the Bridge and Culvert Openings dialog box, select Bridge. Click Sloping Abutments.
Abutment Definition
Defines the abutments for the current cross section. Scrolling through the listed abutments, the geometry values listed in the above Abutment Geometry table will change.

Before a bridge abutment geometry can be defined, an abutment must be added to this list.

Abutment Geometry
Defines the station and elevation geometry values for a single abutment. At least two points must be specified to describe an abutment.

To draw the abutment geometry on the cross section view, click Draw. Drawing the abutment geometry deletes all previously defined geometry for the current abutment.

Abutment Geometry Considerations
Abutment geometry is entered as station and elevation valued pairs. The geometry values are automatically placed in the abutment geometry table, sorted based upon station. The area below the abutment station and elevation is filled in and considered part of the ground. In general, it is usually only necessary to enter two points to describe each abutment.

3.8 Defining the Roadway Geometry
The roadway geometry at a bridge or culvert structure is used to define the structure's road overflow characteristics. This data must be specified at the bridge and culvert downstream and upstream cross sections.

To define roadway geometry, click River tab > Input panel > Bridges & Culverts > Bridge & Culvert Openings.

The Opening Definitions dialog box allows you to select an input method for defining the roadway geometry. These input methods include the following:

• Entering and editing roadway geometry coordinate points directly in a dialog box
• Drawing the roadway geometry directly on the screen

The following subsections describe these methods for defining the roadway geometry.

3.8.1 Inputting Roadway Geometry Directly
The Edit Geometry dialog box can be used to insert, edit, and delete individual roadway geometry points for a bridge or culvert.

To enter roadway geometry data directly:

1. Select the downstream face cross section for the defined bridge.
2. Click River tab > Input panel > Bridges & Culverts > Bridge & Culvert Openings.

3. On the Bridge & Culvert Openings dialog box, select Bridge.

4. Under either Downstream XS or Upstream XS, click Edit Geometry.

5. In the Section Geometry Editor dialog box, in the Deck/Roadway Data section, add a new roadway geometry point. You can specify an existing ground station or elevation either by entering the station value directly into the data field, or by entering it graphically by clicking <.

### 3.8.2 Inputting Roadway Geometry Graphically

The screen roadway input method allows you to define new roadway geometry on-screen for the currently active cross section view.

To enter roadway geometry data graphically:

1. Select the downstream face cross section for the defined bridge.

2. Click River tab > Input panel > Bridges & Culverts > Bridge & Culvert Openings.

3. On the Bridge & Culvert Openings dialog box, select Bridge.

4. Under either Downstream XS or Upstream XS, click Draw Road.

   Autodesk River and Flood Analysis Module displays the applicable cross section view, allowing you to enter new roadway geometry points either by clicking anywhere on the grid or by typing in station and elevation coordinates (such as 100,1320, with no spaces).

### 3.8.3 Graphical Adjustment of Roadway Geometry

Autodesk River and Flood Analysis Module allows you to perform roadway geometry adjustments graphically using grips.

### 3.9 Roadway Overflow Parameters

The Roadway Overflow dialog box allows you to define the roadway overflow characteristics for modeling weir flow at a roadway crossing so that HEC-RAS can accurately model the weir flow.

To display the Roadway Overflow dialog box, click River tab > Input panel > Bridges and Culverts drop-down > Roadway Overflow.

**Weir Flow Coefficient**

Specifies the coefficient of discharge for use in the weir flow equation.

Typical values range from 2.5 for a broad-crested rectangular shaped weir to 3.0 for a trapezoidal shaped weir. However, generally a value of between 2.5 and 2.6 should be used for typical roadway crossings.
**Maximum Submergence Ratio**
Specifies the maximum allowable submergence ratio that can occur during weir flow over the bridge deck. If this ratio is exceeded, the software automatically switches to energy based (standard step method) flow calculations, rather than standard pressure and weir flow calculations.

The energy based method performs all flow computations as though they are for open channel flow. Energy losses are based on friction losses and contraction and expansion losses. At the cross sections inside the bridge (internally manufactured by HEC-RAS), the area obstructed by the bridge piers and bridge deck is subtracted from the flow area and additional wetted perimeter is added.

If this entry is left blank, a default maximum submergence ratio of 0.95 (95%) is used.

**Road Elevation**
Defines the minimum elevation at which weir flow begins.

If this data entry is left blank, HEC-RAS scans through the specified roadway geometry to determine the minimum roadway elevation. However, you can use this entry to artificially raise or lower the minimum elevation at which weir flow is considered.

Click Pick to graphically select the roadway crest elevation from the cross section view.

**Bridge Rail to Section Distance**
Specifies the distance from the upstream side of the bridge deck (upstream bridge rail) to the cross section immediately upstream of the bridge (bridge upstream face cross section). Normally this value is 0.0 unless the bridge deck is indented from the upstream face cross section.

Click Pick to graphically measure this distance from the plan view.

**Roadway Width**
Specifies the width of the bridge roadway (measured along the flow direction).

Click Pick to graphically measure this distance from the plan view.

**Upstream Embankment Slope**
Specifies the embankment side slope of the bridge abutment (measured in the direction of flow) on the upstream face of the bridge. This entry represents the number of horizontal units per one vertical unit for the abutment side slope. Leaving this entry blank causes the software to default to an abutment with vertical side slopes.

This entry is only used for the FHWA WSPRO bridge method for low flow, in the computation of the bridge discharge coefficient.
**Downstream Embankment Slope**
Specifies the embankment side slope of the bridge abutment (measured in the direction of flow) on the downstream face of the bridge. This entry represents the number of horizontal units per one vertical unit for the abutment side slope. Leaving this entry blank causes the software to default to an abutment with vertical side slopes.

This entry is only used for the FHWA WSPRO bridge method for low flow, in the computation of the bridge discharge coefficient.

**Submergence Reduction Method**
Specifies which method is to be used in reducing the weir flow coefficient due to the submergence effect when weir flow submergence occurs during roadway overflow. The Broad Crested method is based on work that was done on a trapezoidal shaped broad crested weir (FHWA, 1978), and should generally be selected since it models typical bridge and culvert crossings. The Ogee Method was developed for an ogee spillway shape (COE, 1965), and should be selected for situations where roadway overflow will occur due to a spillway flow structure.

### 3.10 Calculating Bridge Scour
Autodesk River and Flood Analysis Module can estimate the amount of potential scour at a single opening bridge that can occur during a flood event. The software uses the flow distribution feature of HEC-RAS to determine the horizontally distributed flow velocity at the bridge approach cross section and the bridge opening cross section. From this, the software can compute the amount of contraction scour, pier scour, and abutment scour, thereby determining the total amount of bridge scour. The scour results can then be drawn onto the bridge opening cross section view, showing the effect of the bridge scour.

#### 3.10.1 Scour Modeling Guidelines
To perform a scour computation at a bridge, you must first develop a hydraulic model of the river reach containing the bridge to be analyzed. This model should include several cross sections downstream from the bridge, such that any user-defined downstream boundary condition does not affect the hydraulic results inside and just upstream of the bridge. The model should also include several cross sections upstream of the bridge, to evaluate the long-term effects of the bridge on the upstream water surface profile.

The hydraulic modeling of the bridge should be based upon the procedures discussed in this manual. If any observed data is available, the model should be calibrated to the fullest extent possible. Once the hydraulic model has been calibrated, the modeler can define the flood discharges to be used for the scour analysis. In general, the design flood event for a scour analysis is typically the 100 year (1 percent chance) event. In addition to this event, it is recommended that a 500 year (0.2 percent chance) flood event be used to evaluate the bridge foundation under extreme flooding conditions.

The next step is to request that HEC-RAS compute a flow distribution calculation at the bridge downstream face cross section, bridge upstream face cross section, and the bridge approach cross section. Flow distributions can be requested at other additional cross sections, but these are the only cross sections that will be used in the bridge scour
computations. Flow distributions are defined using the Flow Slices data entries in the Section Description dialog box. Flow distributions must be computed in order to get detailed estimates of the depth and velocity at various locations within the cross section.

After performing the water surface profile calculations with the flow distributions defined, the Autodesk River and Flood Analysis Module scour computations can then estimate the amount of scour at a bridge opening. The total scour at a highway crossing is comprised of four components:

- Long-term aggradation and degradation
- Contraction scour
- Localized scour at piers
- Localized scour at abutments

The scour computations allow you to compute contraction scour and localized scour at bridge piers and abutments. Long-term aggradation and degradation is outside the scope of this software, and therefore should be evaluated prior to performing a bridge scour analysis.

### 3.10.2 Defining Scour Data

The first step in computing bridge scour is to perform a successful HEC-RAS analysis, as was described in the section titled *Scour Modeling Guidelines*. Next, make the bridge downstream face cross section current; bridge scour is computed at the bridge downstream cross section.

Finally, to define the required input data for the scour computations, click River tab > Analysis panel > Bridge Scour Calculator.

In the Bridge Scour Calculator dialog box, on the Scour tab, specify the following parameters:

**Report Filename**

Specifies the ASCII text file that the scour report is to be written out to. The software will provide you with a default filename.

**Report Type**

Specifies the type of scour report to be generated. The Detailed Report option provides complete documentation of the scour analysis, showing every step of the scour computation.

**Scour Type**

Specify what type of scour analysis is to be performed.

After selecting the scour type to be computed, click Define to describe the input data for the scour type. The input data specifications required to compute scour are defined in the following sections.
Profile Listing
Lists the water surface profiles that are available for computing a scour analysis. Highlight the water surface profile for which you want the scour analysis computed.

3.10.3 Defining Contraction Scour Data
Contraction scour occurs when the flow area of a stream is reduced by a natural contraction or by a bridge opening constriction.

To define data describing the contraction scour modeling parameters, click River tab > Analysis panel > Bridge Scour Calculator.

In the Bridge Scour Calculator dialog box, on the Contraction tab, specify the following parameters:

All of the data entry variables, except K1 and D50, are obtained automatically from the HEC-RAS computational results. You can change any variable. To compute contraction scour, only the D50 grain size (mean size fraction of the bed material), and a water temperature to compute the K1 factor are required.

Scour Equation (optional)
Contraction scour can be computed by either the Laursen Live-Bed (Laursen, 1960) or Laursen Clear-Water (Laursen, 1963) contraction scour equations. By default, the software automatically selects the controlling scour equation.

This entry allows you to specify which contraction scour equation is to be used, or specify that the software automatically selects which equation is appropriate. If you ask the software to automatically select the scour equation, the software must compute the critical velocity, $V_c$, that will transport bed material finer than D50. If the average velocity at the approach cross section is greater than $V_c$, the software uses the live-bed contraction scour equation. Otherwise, the clear-water scour equation will be used.

Y1 (optional)
Specifies the average depth (hydraulic depth) in the left overbank, main channel, and the right overbank at the approach cross section. The approach cross section is the second cross section upstream of the bridge declaration cross section.

V1 (optional)
Specifies the average flow velocity in the left overbank, main channel, and right overbank at the approach cross section.

Y0 (optional)
Specifies the average depth in the left overbank, main channel, and right overbank at the bridge upstream face cross section.

Q2 (optional)
Specifies the flow in the left overbank, main channel, and right overbank at the bridge upstream face cross section.
**Input Descriptions**

**W2 (optional)**  
Specifies the top width of the active flow area (not including the ineffective flow area) at the bridge upstream face cross section.

**D50 (required)**  
Specifies the bed material grain size of which 50% are smaller, for the left overbank, main channel, and right overbank. These values must be specified by the user.

**Q1 (optional)**  
Specifies the flow in the left overbank, main channel, and right overbank at the approach cross section for the Laursen Live-Bed equation.

**W1 (optional)**  
Specifies the top width of the active flow area (not including the ineffective flow area) at the approach cross section for the Laursen Live-Bed equation.

**K1 (required)**  
Specifies the exponent for the live-bed contraction scour equation that accounts for the mode of bed material transport. The software can compute a value for K1, or you can enter a value. To have the software compute a value, click Compute. The Compute K1 for Contraction Scour dialog box is displayed.

In the Compute K1 for Contraction Scour dialog box, specify the following parameters:

**S1 (optional)**  
Specifies the computed energy slope at the approach cross section.

**V* (no entry required)**  
Specifies the computed shear velocity at the approach cross section.

**Temp (required)**  
Specifies the water temperature. This value must be specified by the user. A default water temperature of 60° Fahrenheit is provided.

**W (no entry required)**  
Specifies the fall velocity of the D50 bed material.

**Note**

The computation of contraction scour is performed separately for the left overbank, main channel, and right overbank. For example, if there is no right overbank flow inside the bridge, then no contraction scour will be computed for the right overbank area.

**3.10.4 Defining Pier Scour Data**

Pier scour occurs due to the acceleration of flow around a bridge pier and the formation of flow vortices, which remove material from the base of the pier thereby creating a scour hole. As the depth of scour increases, the magnitude of the vortex decreases, thereby reducing the rate at which material is removed from the scour hole. Eventually an equilibrium state is reached between bed material inflow and outflow, and the scour hole ceases to grow.
To define data describing the pier scour modeling parameters, click River tab > Analysis panel > Bridge Scour Data.

In the Bridge Scour Calculator dialog box, on the Pier tab, specify the following parameters:

These data entry values are specified on a pier-by-pier basis. The pier selection list is used to select the pier for which to define data. To store the user-defined pier data for the currently selected pier, click Update. To store the user-defined pier data for all piers, click Set All. To remove user-defined pier data for the currently selected pier, click Clear.

You are only required to define the bed condition (K3), and a D90 size fraction for the bed material. All other values are obtained automatically from the HEC-RAS computational results or are computed by the software. However, you can change any variable to whatever value is appropriate.

**Scour Equation (optional)**

Pier scour can be computed by either the Colorado State University (CSU) equation (Richardson, et al, 1990) or the Froehlich (1988) equation (the Froehlich equation is not included in the HEC No. 18 report).

This entry allows you to specify which pier scour equation is to be used. The CSU equation is the default equation, and there is no automatic equation selector since there are application restrictions with the Froehlich equation.

**Velocity and Depth Value (optional)**

Specifies the velocity and depth method to be used in the pier scour calculations. This entry allows you to select either Maximum V1 Y1 or Local V1 Y1.

If Maximum V1 Y1 is selected, the software uses the maximum velocity (V1) and depth (Y1) located in the bridge upstream face cross section. The software uses the computed flow distribution results to obtain these values. The maximum V1 and Y1 is then used for computing scour at all piers.

If Local V1 Y1 is selected, the software uses the velocity and depth at the bridge upstream cross section at the centerline stationing for each pier. The local V1 and Y1 is then used to compute the scour for each pier.

**Shape (optional)**

Specifies the pier nose shape for each pier defined at the bridge opening. You can select a square nose, round nose, circular cylinder, group of cylinders, or sharp nose (triangular) pier shape.

When you specify a pier nose shape, the K1 correction factor for the CSU equation and the Phi correction factor for the Froehlich equation are automatically determined for that pier.

**a (optional)**

Specifies the pier width. The software automatically puts a value in this field based on the bridge input data. If necessary, you can change this value.
D50 (optional)
Specifies the bed material grain size of which 50% are smaller. The software automatically fills in this entry for each pier, based on what is defined for contraction scour for the left overbank, main channel, and right overbank. You can change this value for any individual pier or for all piers.

Y1 (optional)
Specifies the depth of water just upstream of each pier. This value is automatically determined by the software from the flow distribution output at the bridge upstream face cross section. If Maximum V1 Y1 is selected for the pier scour calculations, then this field shows for each pier the maximum depth of water in the cross section. You can change this value for any individual pier or for all piers.

V1 (optional)
Specifies the average velocity of water just upstream of each pier. This value is automatically determined by the software from the flow distribution output at the bridge upstream face cross section. If Maximum V1 Y1 is selected for the pier scour calculations, then this field shows for each pier the maximum velocity of water in the cross section. You can change this value for any individual pier or for all piers.

Angle (optional)
Specifies the angle of attack of the flow approaching the pier.

For example, if the flow direction upstream of the pier is in-line with the pier, then an angle of 0 degrees should be specified. This is the default value for each pier. However, if the flow direction upstream of the pier is perpendicular to the pier, then the angle of 90 degrees should be entered. Therefore, all values should range from 0 to 90, and always be entered as positive values.

When an angle is entered, the software automatically sets a value for the K2 correction factor. Also, when this angle is greater than 5 degrees, the software sets the K2 correction factor to 1.0.

L (optional)
Specifies the pier length through the bridge. This value is automatically determined by the software and is set to the defined bridge width. You can change this value for any individual pier or for all piers. This length is used to determine the magnitude of the K2 correction factor.

K1 (optional)
Specifies the correction factor for pier nose shape, as used in the CSU equation. This correction factor is automatically determined when you select a pier nose shape. You can change this value for any individual pier or for all piers, if desired.

K2 (optional)
Specifies the correction factor for angle of attack of the flow on the pier, as used in the CSU equation. This correction factor is automatically computed by the software once you specify the pier width (a), the pier length (L), and the angle of attack (Angle).
**K3 (required)**
Specifies the correction factor for bed condition, as used in the CSU equation. You can select from clear-water scour, plane bed and antidune flow, small dunes, medium dunes, and large dunes.

**K4 (optional)**
Specifies the factor, as used in the CSU equation, to decrease scour depths to account for armoring of the scour hole. This factor is only applied when the D50 of the bed material is greater than 0.2 feet (0.06 m). This factor is automatically calculated by the software, and is a function of D50, D90 pier width (a), and the depth of water just upstream of the pier.

**D90 (required)**
Specifies the bed material grain size of which 90% are smaller. This entry is used to compute the K4 factor, and must be specified by the user. This value should be defined for each pier in the pier list box. However, if the D90 value has been entered for only the first (leftmost) pier contained in the pier list box, Autodesk River and Flood Analysis Module will propagate this same value for all of the other piers when the Bridge Scour Calculator dialog box is closed.

**a' (optional)**
Specifies the projected pier width with respect to the direction of flow. This value is automatically computed once the pier width (a), flow angle of attack (Angle), and pier length (L) values have been entered. This value is used in the Froehlich pier scour equation.

**Phi (optional)**
Specifies the correction factor to be used in the Froehlich equation based upon pier nose shape. This correction factor is automatically computed when you select a pier nose shape. If necessary, you can change this value.

### 3.10.5 Defining Abutment Scour Data
Localized scour occurs at bridge abutments when the abutment obstructs the stream flow. The obstruction of the flow forms a horizontal vortex starting at the upstream end of the abutment and running along the toe of the abutment, and forms a vertical wake vortex at the downstream end of the abutment.

To define data describing the abutment scour modeling parameters, click River tab > Analysis panel > Bridge Scour Calculator.

In the Bridge Scour Calculator dialog box, on the Abutment tab, specify the following parameters:

Abutment scour is computed separately for the left and right abutment. You are only required to enter the abutment type (spill-through, vertical, vertical with wing walls). The software automatically selects values for all of the other variables based on the hydraulic output and default settings. You can change the value for any variable.

The location of the abutment toe is based on where the roadway embankment intersects the natural ground. This stationing is very important because the hydraulic variables used in the abutment scour computations are obtained from the flow distribution output at this cross section stationing. If you do not like the stationing that the software picks, you can override it by specifying a different station value.
Scour Equation (optional)
Abutment scour can be computed by either the Froehlich or HIRE equations. By default, the software automatically selects the controlling scour equation.

This entry allows you to specify which abutment scour equation is to be used, or specify that the software automatically select which equation is appropriate. The selection is based on computing a factor of the embankment length divided by the approach depth. If this factor is equal to or less than 25, the software automatically uses the Froehlich equation. If the factor is greater than 25, the software automatically uses the HIRE equation.

Station at Toe (optional)
Specifies the stationing along the upstream face bridge cross section where the toe of the abutment intersects the natural ground. The software automatically determines this station value at the point where the roadway embankment and/or abutment data intersects the natural ground cross section data. You can change this value for either the left and/or right abutment.

Length (optional)
Specifies the length of the abutment and roadway embankment that is obstructing the flow. The software automatically computes this value for both the left and right embankments.

The left embankment length is computed as the stationing of the left abutment toe minus the station of the left extent of the water surface at the bridge upstream face cross section (including the ineffective flow area). The right embankment length is computed as the stationing of the right extent of the water surface minus the stationing of the right abutment toe at the bridge upstream face cross section (including the ineffective flow area). You can change this value for either the left and/or right abutment.

Y1 (optional)
Specifies the computed depth of the water at the abutment toe station, for use in the HIRE equation, at the bridge upstream face cross section. This value is computed by the software as the elevation of the water surface minus the ground elevation at the abutment toe stationing. You can change this value for either the left and/or right abutment.

K1 (optional)
Specifies the correction factor used to account for the bridge abutment shape. You can choose between vertical abutments, vertical abutments with wing walls, or spill-through abutments.

Skew (optional)
Specifies the angle of attack of the flow approaching the abutment.

For example, if the flow direction upstream of the abutment is perpendicular to the abutment, then an angle of 90 degrees should be specified.

A value of less than 90 degrees should be entered if the abutment is pointing in the downstream direction. A value greater than 90 degrees should be entered if the abutment is pointing in the upstream direction. This value is used in computing the K2 coefficient.
K2 (optional)
Specifies the correction factor to account for the angle of attack of the flow on the abutment. This factor is automatically computed by the software. As the skew angle becomes greater than 90 degrees, this factor increases from a value of one. As the skew angle becomes less than 90 degrees, this value becomes less than one.

L’ (optional)
Specifies the length of the abutment (embankment) projected normal to the flow. This value is automatically computed by the software once an abutment length and a skew angle are entered. You can change this value for either the left and/or right abutment.

Ya (optional)
Specifies the average depth of flow (hydraulic depth) that is blocked by the embankment at the approach cross section. The approach cross section is the second cross section upstream of the bridge declaration cross section. This value is computed by projecting the abutment toe stationing up to the approach cross section. From the flow distribution output, the software calculates the area and top width left of the left abutment toe and right of the right abutment toe. The hydraulic depth is then computed as the area divided by the top width. You can change this value for either the left and/or right abutment.

Qe (optional)
Specifies the flow obstructed by the abutment and roadway embankment at the approach cross section. This value is computed by projecting the abutment toe stationing onto the approach cross section. From the flow distribution output the software calculates the percentage of flow left of the left abutment toe and right of the right abutment toe. These percentages are multiplied by the total flow to obtain the amount of discharge blocked by each embankment. You can change this value for either the left and/or right abutment.

Ae (optional)
Specifies the flow area that is obstructed by the abutment and roadway embankment at the approach cross section. This value is computed by projecting the abutment toe stationing onto the approach cross section. From the flow distribution output, the software calculates the area left of the left abutment toe and right of the right abutment toe. You can change this value for either the left and/or right abutment.

V1 (optional)
Specifies the velocity at the abutment toe, determined at the bridge upstream face cross section. This velocity is obtained by finding the velocity in the flow distribution output at the corresponding abutment toe stationing. You can change this value for either the left and/or right abutment.

3.11 Inline Weirs and Gated Spillways
HEC-RAS can model inline (across the main stream) weirs and controllable gated spillways. The spillway gate opening height is defined on a profile by profile basis.

For controllable gated spillways, HEC-RAS can model radial gates (often called tainter gates) and vertical lift gates (sluice gates). The spillway crest of the gates can
be modeled as either an ogee or broad crested weir shape. An example of an inline spillway structure is shown in Figure 3.11.1.

![Figure 3.11.1 Example of an inline gated spillway and weir](image)

### 3.11.1 Defining the Spillway Structure

When defining an inline weir and gated spillway structure, the spillway structure must be declared at the cross section corresponding to the downstream face of the structure.

To define an inline spillway structure, click River tab > Input panel > Inline Spillway.

Use the Inline Spillway dialog box to select what data is to be defined for the inline spillway structure. An inline weir is required for the inline spillway structure, but a gated spillway is optional. If a gated spillway is defined, then the gate control—which defines the gate opening height—must be defined for the gated spillway.

The following sections describe the data used to define an inline spillway structure.

### 3.11.2 Defining an Inline Weir Structure

To define an inline spillway structure, click River tab > Input panel > Inline Spillway.

In the Inline Spillway dialog box, specify the following parameters:

**Weir Crest Shape**

Specifies the type of weir to be analyzed. Select the shape that best matches the weir overflow structure. The software uses this to determine how much to reduce the weir coefficient due to submergence at the weir.

**Upstream Distance**

Specifies the distance between the upstream side of the weir structure and the cross section immediately upstream of the structure.

Click Pick to measure the distance from the plan view.
Width
Specifies the width of the embankment top, measured parallel to the stream flow direction. The distance between the top of the embankment and the current cross section is equal to the channel reach length of the upstream cross section minus the sum of the weir Width and the Upstream Distance between the embankment and the upstream cross section.

Click Pick to measure the width from the plan view.

Weir Coefficient
Specifies the weir coefficient that will be used in the standard weir equation for computing weir flow over the embankment.

For an Ogee-shaped spillway, click Compute to compute the weir coefficient at the specified design energy head. The Spillway Approach Height and Design Energy Head parameters must first be specified for the software to compute the weir coefficient.

During the weir calculations, the weir coefficient will fluctuate based upon the actual head going over the weir.

U.S. Embankment Slope 1
Specifies the slope of the weir embankment on the upstream side of the structure. This value should be entered as the horizontal to vertical distance ratio (i.e., grade) of the embankment slope.

D.S. Embankment Slope 1
Specifies the slope of the road embankment on the downstream side of the structure. This value should be entered as the horizontal to vertical distance ratio (i.e., grade) of the embankment slope.

Min Weir Flow Elevation
Specifies the minimum elevation for which weir flow is to begin. Once the computed upstream energy elevation becomes higher than this elevation, HEC-RAS begins to compute weir flow. However, the weir flow calculations are still based on the actual geometry of the weir and embankment, and are not affected by this elevation. If this parameter is left blank, then HEC-RAS will use the lowest defined elevation of the weir geometry coordinates for determining when weir flow starts.

Click Pick to define the elevation by selecting it from the cross section view.

Spillway Approach Height
This parameter is only required when defining data for an Ogee-shaped weir. This parameter is equal to the elevation of the spillway crest, minus the mean ground elevation, just upstream of the spillway.

Click Pick to measure the height from the cross section view.

Design Energy Head
This parameter is only required when defining data for an Ogee-shaped weir. This value is equal to the energy gradeline elevation (at the specified design discharge) minus the spillway crest elevation.
Click Pick to measure the head from the cross section view.

**Weir Geometry: Horizontal Station and Elevation**
To add a new weir geometry point, enter its horizontal station and elevation into the corresponding data fields.

Click New to draw new weir geometry points from the current cross section view. The new weir geometry point station and elevation values will then be automatically inserted in the data fields.

To edit an existing weir geometry point, select the point from the list, or click Pick to select it from the current cross section view.

Double-clicking on a row of data shown in the list will immediately move the data entry cursor to the weir geometry point data entry, allowing you to quickly alter the elevation for an existing station.

To delete a row of data from the list box, right-click the row and click Delete Row(s).

You can also draw the inline weir geometry on the cross section view. For more information, see the section titled *Drawing the Inline Weir Geometry*.

### 3.11.3 Drawing the Inline Weir Geometry

Autodesk River and Flood Analysis Module allows you to draw the inline weir geometry on-screen for the currently active cross section view.

To draw an inline weir structure:

1. Click River tab > Input panel > Inline Spillway.
2. In the Inline Spillway dialog box, select Draw Weir:
3. Enter weir geometry points by clicking anywhere on the section view, or by typing in station and elevation coordinates (such as 100,1320, with no spaces).

### 3.11.4 Defining a Gated Spillway

In order to define a gated spillway, an inline weir must first be defined as described in the section titled *Defining an Inline Weir Structure* on page 3-55.

To define a gated spillway:

1. Click River tab > Input panel > Inline Spillway.
2. In the Inline Spillway dialog box, define the weir geometry.
4. Click Define.
5. In the Define Gated Spillway dialog box, specify the following parameters:
Gate Type
Specifies the type of gated spillway to be analyzed. The software uses this data entry to determine how much to reduce the weir coefficient due to submergence at the weir. Select the shape that best matches the weir overflow structure. Two gate types are available, Sluice (i.e., vertical lift) and Radial (i.e., tainter).

Discharge Coefficient
Specifies the discharge coefficient for the spillway gate opening. This coefficient ranges from 0.5 to 0.7 for sluice (i.e., vertical lift) gates and 0.6 to 0.8 for radial (i.e., tainter) gates.

Trunnion Exponent
Specifies the radial gate trunnion height exponent, which is used in the radial gate discharge equation. A typical value is 0.16.

Opening Exponent
Specifies the gate opening exponent, which is used in the radial gate discharge equation. A typical value for a radial gate is 0.72. If a sluice gate has been defined, then this entry is set to 1.0 and should not be changed.

Head Exponent
Specifies the upstream energy head exponent, which is used in the radial gate discharge equation. A typical value for a radial gate is 0.62. If a sluice gate has been defined, then this entry is set to 0.5 which is a normal value for a sluice gate.

Trunnion Height
Specifies the height from the spillway crest to the trunnion pivot point.

Orifice Coefficient
Specifies the submerged orifice coefficient, which is used for the gate opening when the gate becomes more than 80 percent submerged. A typical submerged orifice coefficient value is 0.8. If the gate opening is between 67 and 80 percent submerged, HEC-RAS uses a transition between the fully submerged orifice equation and the free surface flow gate equations. When the gate opening is less than 67 percent submerged, HEC-RAS uses the free surface flow gate equations.

Gate Station
Specifies the gate opening centerline stationing. A different centerline station should be defined for each gate opening within a gate group. All gate opening data within a gate group are identical, except for differing centerline stationing.

Click < to define the gate centerline station by picking it from the cross section view.

Gate Group
Specifies a set of identical gated spillways. The total number of identical gates within each gate group is displayed in this list box.

Up to 10 different gate groups can be defined at a inline weir structure. Each gate group can have up to 25 identical gated spillway openings.
If all of the gate openings are exactly the same, then only one gate group needs to be defined. If the gated spillway openings are different in shape, size, elevation, or discharge coefficients, then additional Gate Groups must be defined. Similarly, if the gates are identical but you want to be able to control the gate openings separately, then separate gate groups must be defined.

**Weir Crest Shape**
Specifies the type of weir that should be analyzed. Broad Crested and Ogee shaped weirs are available. Select the shape that best matches the weir overflow structure. The software uses this parameter to determine how much to reduce the weir coefficient due to submergence at the weir.

**Weir Coefficient**
Specifies the weir coefficient that is used in the standard weir equation for computing weir flow over the embankment.

For an Ogee-shaped spillway, click Compute to cause Autodesk River and Flood Analysis Module to compute the weir coefficient at the specified design energy head. The Spillway Approach Height and Design Energy Head values must first be specified for the software to compute the weir coefficient.

During the weir calculations, the weir coefficient will fluctuate based upon the actual head going over the weir.

**Spillway Approach Height**
This parameter is only required when defining data for an Ogee-shaped weir. This parameter is equal to the elevation of the spillway crest, minus the mean ground elevation, just upstream of the spillway.

Click Pick to measure the height from the cross section view.

**Design Energy Head**
This data entry is only required when defining data for an Ogee-shaped weir. This value is equal to the energy gradeline elevation (at the specified design discharge) minus the spillway crest elevation.

Click Pick to measure the head from the cross section view.

### Defining the Gate Opening Height

After a spillway gate structure is defined, the defined gates are assumed to be completely closed unless a gate opening height has been defined. Note that HEC-RAS allows you to define the spillway gate opening height separately for each gate group on a profile by profile basis. To do this, see the section titled *Defining a Gated Spillway Gate Opening*.

### 3.11.5 Defining a Gated Spillway Gate Opening

HEC-RAS allows you to control the spillway gate opening height separately for each gate group on a profile by profile basis. After defining a spillway gate structure using the Define Gated Spillway dialog box, the defined spillway gates are assumed to be completely closed unless a gate opening height has been defined.
To define a gated spillway gate opening:

1. Click River tab > Input panel > Inline Spillway.

2. In the Inline Spillway dialog box, define the weir geometry.


4. Click Control.

5. In the Inline Spillway Gate Openings dialog box, specify the following parameters:

   **# Opening**
   
   Specifies the number of openings, within the selected gate group, that the specified spillway gate opening height is to be applied to.

   **Open Height**
   
   Specifies the spillway gate opening height within the selected gate group. This opening height value will be applied to only to the specified number of gate openings.

At the bottom of the Spillway Gate Control dialog box is a list box containing the defined profiles for the HEC-RAS model. The gate group openings are defined separately for each profile. Therefore, it is necessary to first select the profile that the gate opening data is to be defined for, and then select the gate group that the opening height is to be specified for. Then, after specifying data for the # Open and Open Height parameters, click Update to store this data.

### 3.12 Floodplain Encroachments

The software’s floodplain encroachment capability allows the software to analyze encroachments made to the floodplain. Five different methods are available to define floodplain encroachments. Each method is capable of evaluating the effects of encroachments on bridges and culverts.

The software’s floodplain encroachment capability should not be confused with the software’s ineffective flow area capability. The ineffective flow area capability is used to limit the region of active flow at a specific cross section, such as the cross section defining the downstream face of a bridge. The floodplain encroachment capability is used to analyze changes to the water surface profile due to floodway (or floodplain) encroachments, such as floodplain fringe development.

**Note**

The encroachment analysis can only be performed for profiles 2 through 15 (or whatever number of profiles have been defined by the user). Encroachments are not performed for the first profile because most of the encroachment methods rely on having a base profile for comparison.

The Floodplain Encroachment dialog box allows you to define the encroachments for the current cross section.
To access the Floodplain Encroachments dialog box, click River tab > Input panel > Floodplain Encroachments.

The Floodplain Encroachment dialog box allows you to specify any of the five available encroachments methods for any of the profiles listed in the dialog box. As you switch among different encroachment methods, some of the data entry prompts will change based upon the selected encroachment method.

**Overbank Conveyance Reduction Distribution**
Specify the conveyance reduction distribution method to use.

- If Equal Reduction is selected, the conveyance is eliminated equally from each overbank area.
- If Proportional Reduction is selected, the conveyance is reduced in proportion to the conveyance in each overbank area.
  
  This parameter only applies to encroachment methods 3, 4, and 5. With methods 1 and 2, this option has no effect. The default method is to reduce conveyance equally from both overbanks. This specified option is applied globally, and will be applied to every cross section and for every profile which has an applicable encroachment method defined.

**Left Bank Offset**
**Right Bank Offset**
The left and right offsets are used to establish a buffer zone around the main channel for limiting the amount of encroachment. For example, if you establish a left buffer zone limit of 10 feet and a right buffer zone limit of 5 feet, the software limits all encroachments to up to 10 feet outside of the left bank station, and 5 feet outside of the right bank station.

The default is to have no left or right bank buffer zone, which allows the floodplain encroachments to go right up to the main channel bank stations, if necessary. This option is applied globally, and is applied to every cross section and every profile that has an applicable encroachment method defined.

**Set Range of Values**
Specify an encroachment Method, profile, and Target WS for a range of cross sections in a river reach. Select the Reach, Downstream XS and Upstream XS, Method, Profile, and Target WS. When you click Set Values, the values are applied to all the cross sections between the specified Downstream XS and Upstream XS.

**Select Reaches to Display**
Specify the river reaches in the current model to display in the Encroachment Values table.

**All Methods**
**Standard Methods**
Enables or disables selection of the full range of encroachment methods. When the All Methods button is displayed, only Methods 1 and 4 are available. Click All Methods, and Methods 1, 2, 3, 4, and 5 are available.
Specify the floodplain encroachment method to be used for each cross section, or for a range of cross sections. If None is selected, the software ignores any encroachment data specified for the current cross section reach.

Of the five encroachment methods available, encroachment methods 1 and 4 are generally the only methods used. Method 4 is first used to compute the approximate floodplain encroachment station locations. Method 1 is then used to fine-tune the placement of the floodplain encroachment stations.

**Propagating a Floodplain Encroachment**

Note that HEC-RAS does not automatically propagate a defined floodplain encroachment to upstream cross sections. HEC-RAS encroachments must be defined at each cross section where they are to take place. Therefore, problems can potentially exist if you import a HEC-2 model that has encroachments defined, if that model is to be analyzed using HEC-RAS. Check to see what encroachment methods have been defined in the model, and if the encroachments are meant to be propagated, then define these encroachments at each cross section. In that way, the HEC-RAS model will correctly mimic the behavior of the original HEC-2 model.

**Multiple Profiles**

HEC-RAS computes the water surface profile for the natural channel (without any encroachments) using the first specified discharge and then computes profiles using the specified encroachments for subsequent discharges. Therefore, encroachment analyses require that at least two profiles be specified. The first profile will be the natural (unencroached) profile, and all subsequent profiles will then be encroached.

**Slope Area Profile Computation Method**

The slope-area profile computation method of determining the water surface profile cannot be used in conjunction with encroachment methods 3, 4, or 5 at the furthest downstream cross section (when computing a subcritical flow profile) or for the furthest upstream cross section (when computing a supercritical flow profile).

**Hydraulic Calculator**

The Hydraulic Calculator considers the entire cross section geometry as available for flow in its computations. It knows nothing about ineffective flow areas, channel modifications, floodplain encroachments, conveyance obstructions, or levees in which flow has been restricted. Therefore, caution should be exercised when applying the Hydraulic Calculator to these situations.

### 3.12.1 Encroachment Method 1

If floodplain encroachment method 1 is selected, the Left Station and Right Station parameters are available.

**Left Station**

Specify the left station of the floodplain encroachment
Click Pick to graphically select the left encroachment station.

**Right Station**
Specify the right station of the floodplain encroachment.

Click Pick to graphically select the right encroachment station.

![Figure 3.12.1.1 Encroachment method 1](image)

### 3.12.2 Encroachment Method 2

If floodplain encroachment method 2 is selected, the Fixed top parameter is available.

**Fixed Top**
Specify the top width (or distance) between the two floodplain encroachment bank stations for the current cross section. These floodplain encroachment bank stations should not be confused with the main channel bank stations.

Click Pick to graphically measure the encroachment top width to use.

![Figure 3.12.2.1 Encroachment method 2](image)
3.12.3 **Encroachment Method 3**
If floodplain encroachment method 3 is selected, the Target K parameter is available.

**Target K**
Specify the percentage of total conveyance to be eliminated from the overbank, where the total conveyance was computed for natural (un-encroached) conditions. The specified percentage must be a positive value between 1 and 100.

![Diagram of Encroachment Method 3](image)

*Figure 3.12.3.1 Encroachment method 3*

3.12.4 **Encroachment Method 4**
If floodplain encroachment method 4 is selected, the Target WS parameter is available.

**Target WS**
The natural cross section will be encroached based on the specified increase in water surface elevation over that computed for natural (un-encroached) conditions. Thus, a target increase in water surface elevation of 1.2 foot would require an entry of 1.2. The specified increase must be positive in value.
3.12.5 Encroachment Method 5

If floodplain encroachment method 5 is selected, the Target WS and Target EG parameters are available.

Target WS
The natural cross section will be encroached based on the specified increase in water surface elevation over what was computed for natural (un-encroached) conditions. Thus, a target increase in water surface elevation of 1.2 foot would require an entry of 1.2. The specified increase must be positive in value.

Target EG
The natural cross section will be encroached based on the specified increase in water surface elevation, as described in the previous entry, as long as the specified maximum change in energy has not been exceeded. Therefore, if a maximum allowable change of energy of 2.4 feet is being allowed, then an entry of 2.4 should be specified. This entry must be positive in value.